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GİRİŞ
Karakter modelleme ve animasyonu, bir karakteri canlandırarak hayata geçirmeyi içeren ani-

masyon sürecinin özel bir alanıdır. 3D animasyon ve modelleme önceleri sadece video oyunların-
da, sinema - televizyon sektöründe  kullanılırken bugün çok daha geniş dijital ortamlarda kulla-
nılmaktadır. Pazarlama materyallerinden tıbbi görüntülemeye, Metaverse çalışmalarından NFT'ye 
ve 3D baskıya kadar birçok amaca hizmet etmektedir. Dijital karakterleri canlandırmak, ticari ve 
uzun metrajlı projelere dahil edilen, büyüyen bir alandır. Animatörler, karakterleri istenen kişilik-
lere büründürerek, belirli duyguları aktararak hayali yolculuklara çıkarmaktadır.

3D karakter modellerinin animasyon haline getirilme sürecinde Maya günümüzde endüstri 
standardı haline gelmiş popüler bir animasyon ve modelleme yazılımıdır. CGI veya oyun endüstri-
sinin modelleme veya animasyon sektörlerinde rol alabilmek için  çoğu animasyon ve oyun şirketi 
tarafından Maya bilgisi aranmaktadır. 

Günümüz karakterlerine yönelik talepler hızla artmaktadır. Maya sayesinde, bu talepleri karşı-
lamak için bir karakter oluşturma ve canlandırma işi eğlenceli hale gelmiştir. Bu kitap, 3D karakter 
modelleme ve animasyonun öğrenilmesi gereken temel tüm adımlarının içermektedir. 3D karak-
terin modelleme, iskelet sistemi oluşturma, rigleme, kaplamalarını oluşturma, kıyafetini oluşturan 
kumaşın simülasyonunu yaratma ve render alma yöntemleri içerik dahilindedir.

Bu kitapta kullanılan ekran görüntüleri Maya programından yazar tarafından üretilmiştir. Uygu-
lamaya konu olan anlatım ve çizimlerin telif hakkı yazara aittir.  
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ÜNİTE 1 - KULLANICI ARAYÜZÜ

MENÜ
Menü hangi alanda seçiliyse onunla ilgili seçenekler üst bar menüde ortaya çıkar. Rigleme ya 

da Animasyon ile ilgili menüler Modelling seçeneği aktifken görünmezler.

İstenen araç simgesinin üzerine mouse ikonu uzun süre tutularak açıklama metinleri görülebi-
lir.

Sağ üst köşede sağ taraftaki alanda bulunan menüleri aktive eden ikonlar bulunmaktadır.

Bu ikonlar sırasıyla :  1 Modeling tool , 2. Rigging , 3.  Attribute Editor, 4. Tool settings,  
			      5. Channel Box.

Channel Box aktifken menünün sağ tarafından da ilk 4 ikon seçenekleri açılabilir:
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Workspace Ayarlama

  

Bu alandaki seçeneklere basarak çalışma alanı kişiselleştirilebilir.

Aşağıdaki görselde bulunan sağ tarafı üçgenli çizgi şeklindeki ikonlara basarak katlanır menü-
ler açılabilir. Bu simge Bar Menü'de bulunan simgelerin gizlendiğini göstermektedir.

Üst menüden > Wındows > UI Elements menüsünden istenilen alanlar açıp kapatılabilir.

Zaman çizelgesi olarak kullanılan “Timeline” alanı kapalıysa Restore UI Elements seçilerek açı-
labilir.

CTRL+Space çalışma alanını büyütür.

Sadece Space tuşuna hızlıca basıp bırakarak ya da en soldaki bardaki bu butona  basarak 
dörtlü ekran açıp kapatılabilir.

ÇALIŞMA ALANI NAVİGASYONU
Windows > General Editors > Content Browser menüsünden bir obje seçerek sahneye sürük-

leyip koyarak obje etrafında dolaşım yapılabilir. 

“F” tuşu seçili olan objeye zum yapar. 4 pencere açıkken Shift+ F  tuşu ile tüm ekranlarda zum 
yapar.

 

Yukarıdaki menüden çalışma alanındaki objeyi ızgara görünümü, kaplamaları ile birlikte gör-
me, sadece yüzey olarak görme gibi farklı ayarlarla görülebilir.
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Aşağıdaki görseldeki menüler de aynı işlevin simgeleştirilmiş hali görünmektedir.

Obje oluştururken hazırda üzerine standart bir “Lambert” materyal atanmış olarak gelir. Sah-
nede obje seçiliyken çalışma alanının sağ tarafında bulunan Attribute Editor alanından objeye 
atanmış olan materyalin ayarlamaları yapılabilir ve kaplama atanabilir. Texture açma kapama 

özelliğini kullanarak  atanmış olan materyalin kaplaması çalışma alanında model üzerinde   
görülebilir.

Sahne ışık ayarları için light menüsünü kullanılmaktadır. Sahneye üst menü alanından  Create 

> Light > Pointlight ekleyip çalışma alanı ışık ayarı özelliği  test edilebilir.

OBJE OLUŞTURMA
Maya’da temel olarak iki yöntemle model oluşturulur. Nurbs Primitives ve Polygon Primitives.

 

Nurbs alt bar menüde Curves / Surface Objects şeklinde geçmektedir. İkisi de aynı modelleme 
seçeneği olarak kullanılabilir.
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Obje oluşturma menüsünde “Interactive Creation”  seçeneği aktif haldeyse basıp sürükleyerek 
obje oluşturulmaktadır. 

 

Objeyi oluşturduktan sonra sağdaki Channel Box menüsünden Inputs kısmından oluşturulan 
küre ya da cube ile ilgili Polygon sayılarını artırmak gibi detaylı ayarlar  yapılabilir.

 

Inputs yazısının altında bulunan obje adına (polySphere1) tıklayarak ayarlar menüsü açılabilir.

Input kısmından yazıyı seçip yazı seçiliyken çalışma alanına Orta Mouse Butona basılı tutup 
sürükleyerek interaktif şekilde ayarlar değiştirilebilir.

Nurbs Shape ve Polygon objeleri oluşturup alıştırma yapalım.
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SAVE ETME VE DOSYA AÇMA
Üst menü alanında bulunan File sekmesinden > Save Scene: sahneyi kaydeder. Save Scene As: 

olan sahneyi farklı kaydeder.

New Scene ise yeni sahne oluşturur.

İki farklı save dosya şekli vardır: Binary ve ASCII. Binary temel Maya dosya formatıdır. ASCII 
formatı ise eski Maya dosya formatıdır. Çalışmayı eski versiyon Mayalarda açmak için kullanılır.

OBJELERİ VE ALT KOMPONENTLERİ SEÇME
Select Tool obje seçmeye yarayan araçtır. Sahneye pek çok obje koyup seçim yaparak deneme-

ler yapılabilir.

3 adet seçim aracı bulunmaktadır: Sellect oku, Lasso Sellect, Brush Sellect.

Shift tuşuna basılı tutarak çoklu objeler seçilebilir. Seçilen çoklu objelerden istenilen objeden 
seçimi kaldırmak için Ctrl tuşuna basılı tutarak seçimi kaldırır.

Ctrl+ Shift tuşuna basılı tutarak çoklu seçime yeni objeler eklenebilir.

Lasso Sellect aracı basılı tutarak çizilen şekil içerisinde bulunan objelerin seçilmesini sağlar.  
Paint sellect için fırça simgesine çift tıklayarak  fırça ayarları yapılabilir. Paint Sellect aracı seçiliy-
ken brush ayarları için “B” tuşuna basılı tutarak Sol Mouse Butona basılı tutarak da fırça boyutu 
ayarlanabilir.

Tüm simgelere çift tıklayarak araçların ayarları değiştirilebilmektedir.

MOVE ROTATE SCALE ARAÇLARI

 

Move: hareket ettirme, Rotate: Döndürme, Scale: Büyütüp küçültme aracıdır.

Move ile koordinat okları hizasında objeler hareket ettirilebilir. Eğer hareket ettirme oklarının 
orta noktasında bulunan kutucuktan tutulursa obje her koordinat yönüne (xyz) sürüklenebilir.

İkonlara çift tıklayarak ikon özellikleri değiştirilebilir.
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LAYER MANTIĞI İLE ÇALIŞMA
Layers menüsünde bulunan ikonlar ile katman oluşturma ve katmanlar arası obje taşıması ya-

pılabilir.

  

En sağdaki ikon; sahne içerisinde seçili olan objeyle birlikte katman oluşturmaktadır.

Sağdan ikinci ikon ise boş katman oluşturur.

“V” harfine klavyeden basarak (visibility) katman içersinde bulunan objelerin görünürlüğü  
açıp kapatılabilir.

Seçili objeyi katmana eklemek için: Layer'a Mouse ile sağ tıklanarak ve açılan listeden Add 
Selection To Object seçeneği seçilerek obje katmana eklenebilir.

Layer'a çift tıklayarak isim değiştirme vs özellikleri yapılabilir.

Seçili katmandaki objeleri dondurmak için sağdaki boş kutucuğa tıklanarak “T” ikonu aktive 
edilir ve o katmandaki objeler Template olur. Yani katmandaki obje hareket ettirilemez olur ama 
ızgara modunda görünmeye devam eder.

“T” harfine tekrar tıklanırsa ikon harfi “R” yani referans olur. Izgara modundan Solid moda ge-
çer ama yine donmuş olacağından dolayı seçilmez.

“P” harfi ise kapalı olduğu zaman Timeline’da Play tuşuna basınca animasyonda görünmez 
olur.

Layer kutularına renk verilirse Wireframe (ızgara) modunda renkler objenin hangi katmanda 
olduğunu gösterir.
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SOFT SELECTION ve SİMETRİ
Soft Selection seçeneği bir objedeki Vertex Edge Polygon gibi alt modlarda seçili olan parçanın 

etrafındaki alanı ile birlikte etrafındaki parçalarla birlikte etkileşimli olarak seçilmesini sağlar. Bir 
objenin Vertex modundayken herhangi bir Vertex'i seçilir. Move Tool ikonuna çift tıklayarak özel-
likler alanı açılır.

 

Açılan menüdeki “Soft  Selection” sekmesini aktive ederek yumuşak seçim özelliği açılabilir.

Falloff kısmından seçilecek alanın kapsama alanı azaltılıp artırılabilir.

Ayrıca “B” tuşuna basılı tutarken Mouse Sol Düğmesine basılı tutarak da kapsama alanın ayar-
lanabilir.

Çalışma alanındayken Vertex ya da Polygon modu seçiliyken sadece “B” tuşuna basarsak oto-
matik olarak Soft Selection moda geçer.

Simetri Settings açma kapama: Move, Rotate ya da Scale aracı seçilmiş olması fark etmeden 
araç ikonuna çift tıklayarak araçla ilgili menü açılabilir. Açılan Tool Settings menüden symetry se-
çeneği aktive edilerek model üzerinde simetrik çalışma imkanı oluşturulabilir.
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Ayrıca üst bar menüden de Symetry aktive edilebilir.

OBJE GİZLEME ve GÖSTERME
Sahnede bulunan objeleri obje seçiliyken gizlemek için üst menülerden > Display > Hide > 

Hide selection kullanılabilir. Bu seçeneğin kısa yolu CTRL+H dir.

“G” tuşu kısa yolu ise yapılan son işlemi tekrarlar ve hızlı çalışma imkanı sağlar.

Gizlenmiş objeyi göstermek için ise > üst menüden Display > Show seçenekleri kullanılabilir.

Seçili olan objeyi görünür yapıp sahnedeki diğer tüm objeleri gizleyen seçenek ise Isolate Ob-
ject seçeneğidir. Bu özelliğe çalışma alanının hemen üzerinde bulunan ikon menü alanında bulu-

nan  ikonu ile seçili olan obje dışındaki tüm objeler görünmez olur: 

OUTLINER MENÜSÜ
Üst Menü bar > Wındows > Outliner seçeneği ile Outliner menüsü açılır. Bu menüde sahnede-

ki objeler listelenir. Gruplama Parent gibi seçeneklerde ve çoklu seçimlerde kullanılır.

 

Listede koyu gri yazılı olan objeler gizlenmiş demektir. Beyaz renkli yazılardaki objeler ise sah-
nede görünür demektir.

Outliner alanındaki listede obje yazısının yanında "+" ikonu varsa o bir grup demektir ve alt 
sekmelerde o gruba ait diğer objeler de "+” ikonuna basılarak görülebilir.
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PIVOT POINT AYARLARI
Pivot noktası bir 3D objenin odak noktasıdır. Objenin boşluk üzerindeki bulunduğu koordinat-

lar odak noktası üzerinden hesaplanır. Büyütme küçültme, döndürme gibi işlemlerde bu odak 
noktası esas alınarak yapılır. “D” Tuşuna basılı tutarak Pivot noktasının yeri değiştirilebilir.

Ayrıca Transform simgesine çift tıklayıp açılan menüden de Pivot Edit ile yer değiştirilebilir.

Pivot noktasını sıfırlamak için ise üst menü Modıfy >Center Pıvot ya da Center Pivot ikonu (alt 
görsel yuvarlak içindeki simge) ile objeye ortalanabilir.

OBJE GRUPLAMA
Aynı anda birden fazla objeyi hareket ettirmek ya da sınıflandırmak amaçlı gruplandırma işlemi 

yapılabilir. Farklı objeleri sahnede seçip > üste menü Edit > Group seçeneği ile objeler gruplanır. 
Kısa yolu CTRL+G dir. Ungroup seçeneği ise olan grubu bozar.
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Outliner listesinden yeni oluşturulan grup seçilip Rotate ya da Move ile hareket ettirilirse tüm 
objeler senkron olarak hareket eder.

MARKING MENU
Sahnedeki bir objeye mouse sağ butonu ile basılı tutularak Marking Menu açılır. Bu menüden 

Vertex, Face, Object mode gibi modelin alt yapı birimleri seçilebilir. Seçilen alt birimler kullanıla-
rak Polygon modelleme yapılır

Shift+Sağ Mouse Buton ile ise farklı bir menü açılır. Bu menü seçilen objenin cinsine göre de-
ğişir. Buna Content Sensitive Marking Menu denir.

Maya’da menülerle çalışma mantığı şu şekildedir: Sağ mouse butonu ile tıklayıp ulaştığı-
mız menüden Face Mode’u seçelim daha sonra bu moddayken belli Polygon'ları seçelim > seçili 
Polygon'lardayken Shift+Sağ Mouse Düğmesi ile  Content Sensitive Menü açıp Extrude seçeneği 
ile seçili alanlara Extrude verelim. 

	 Extrude edilen alanın Edgelerini Edge Mode ile seçelim > Shift+ Sağ Mouse Düğmesi ile 
yine Content menüsü açıldığında bu sefer Edge ile ilgili özellikler olduğunu görülebilir. Edge Be-
vel vererek köşelere yuvarlaklık verelim.
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Bu çalışmayı sıkça tekrarlayalım. Bu çalışma yöntemi Maya’da en sık kullanılan modelleme yön-
temlerinden biridir.

HOTBOX ve WRAP UP
Hotbox: Space tuşuna basılı tutulduğunda açılan menüdür. File, Materyal, View, Model, Rig, 

ışık, efekt gibi sık kullanılan menülere kısa yoldur.

 

Açılan Hotbox menünün sağına soluna üstüne ve altına mouse okunu götürüp sağ tıklanırsa 
farklı menülerle karşılaşılır (Resim 2).

  

Ortadaki Maya yazısına sağ tıklandığında farklı bir menü çıkar. Buradan farklı açılardan bakış 
ekranına direkt geçiş yapılabilir (King, 2019). 
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ÜNİTE 2 - MODELLEME
PROJE DOSYASI OLUŞTURMA
Mayanın Proje ile gerekli alt klasörleri otomatik olarak oluşturulur. Bu sayede çalışılan maya 

dosyası ile ilgili oluşturulan ek dosyalar otomatik olarak belirlenen klasöre yerleştirilir ve veri kay-
bı oluşmaz.

Üst menü > Fıle > Project Wındow ile menü açılır.

Current project satırında sondaki New butona basarak projeye isim verilir.

Location kısmından projeyi nereye paket olarak kayıt edilecekse o klasör dizini seçilir. > Accept 
buton ile proje dosyaları kaydedilmiş olur.

REFERANS İMAJ EKLEME
Karakter modelleme için modellenecek karakterin önceden çizilmiş önden, arkadan ve tam 

yandan bir referans çizimi olmalıdır. Karakter eğer animasyon haline getirilecekse T pozu dışında 
ekstra olarak  çapraz çizim ve karakterin zıplama, koşma, eğilme gibi hareketlerinin olduğu çi-
zimlerin bulunması modelleyen ve animasyon haline getiren sanatçı açısından avantajdır. Ayrıca 
karakter animasyon haline getirilecekse çizer karakterin hareketli birkaç pozunu da çizmelidir. Bu 
sayede Rigleme yapılırken ona göre bir iskelet sistemi yerleştirilebilir.

 

Referans imajları oluşturulan proje dosyası klasöründeki Source Images klasörüne koyulma-
lıdır.
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4’lü çalışma ekranını aktive ettikten sonra > Front View çalışma alanının kendi üst menüsün-
den > Vıew > Image Plane > Import Image ile önden görünüm resmini çalışma alanına ekleyelim.

  

Side View çalışma alanındayken de yan profilden çizilmiş olan referans görüntüyü yine aynı 
yöntemle ekleyelim. Önden görünüm ekranında  önden görünüm referans çizimi yandan görü-
nüm çalışma alanında ise yandan görünün referans görseli eklenmiş olmalıdır.

Image Plane ekleme kısayoluna görseldeki simgeye  tıklayarak da ulaşılabilir. 

Front ve Side View çalışma alanlarına imaj eklerken zoom in out yapmamakta fayda vardır.  
Bazı durumlarda imajın boyutu değişebilmekte ya da imaj görüntülemede sorun olabilmektedir.

Döküman ayarlarımızı santimetreye çevirmek doğru bir modelleme ve render için önemlidir. 
Bunun için; üst menü > Settıngs > Settıngs Preferences > Preferences kısmından, açılan pencere-
den Settings kısmından > Workıng Unıts alanından Centimeters seçeneği seçilmelidir.

Sahnede bir Cube modeli oluşturalım ve bu Cube uzunluğunu modelimiz ne kadar uzun olacak-
sa referans olması açısından Inputs alanından değer girerek uzatalım. karakter 1,5 metre olacaksa 
Inputs kısmından 150 cm yapalım.

İmage Planelerin hepsini seçip uzattığımız cube boyunca Scale İle Büyütelim.
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*Referans Cube objesini silip  Side View ve Front View panellerini merkezden uzaklaştıralım. 

Karakterin ayakları “0” noktasına değecek şekilde yukarı doğru Move aracı ile çekelim.

Referans imajları perspektif çalışma alanında rahatsızlık vermesin diye;

Image Plane'lerden Front imaj objesi seçiliyken sağdaki menü Attribute Editor kısmından “Lo-
oking Through Camera” sekmesini aktif hale getirelim. Bu sayede imaj sadece Front View pane-
linde görünür perspektif View çalışma alanında görünmez.

Referans imajlar yeni bir Layer’a (katman) konarak sabitlenmeli. Bu sayede yanlışlıkla hareket 
ettirip modelleme işlemini bozulmasına sebebiyet vermez.

Referans imajların ikisini de seçelim ve katman alanının üstünde en sağda bulunan yeni La-
yer'a ekle simge butonu ile Layer oluşturalım. İsim olarak referans diyelim ve Layer Display Type 
ı da “R” harfi ile simgelenen ve katman isminin sol tarafında bulunan üç kutucuktan en sağdaki 
seçenek ile referans katman haline getirelim.
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GÖVDE MODELLEME
Gövde tipine göre hazır geometrik şekil seçilerek modellemeye başlanabilir. İnsan gövdesiyse 

silindir olabilir ya da robot gibi köşeli yüzeylere sahip bir karakter modellenecekse Cube modeli 
üzerinden başlanabilir.

Silindirin dik Edge tabir edilen model konturlarından biri tam sıfır noktasından geçecek şekilde 
Input alanından Segment sayısı ayarlanır. Simetri kullanılacağı için tam sıfır noktasına denk gel-
melidir.

Dik Segmentler duruma göre 5 yapılabilir. Fazla Segment modellemede sıkıntı yapacağından 
kısıtlı sayıda Segment kullanmak modellemeye hakim olma açısından önemlidir.

Vertex moduna gelip yandan görünümden vücut şekline göre Vertexler hizalanabilir.

Modelleme yaparken objenin arkasından referans imajı görmek için > Çalışılan ekranın üst 
menüsündeki Shading kısmından XRAY i aktive ederek model yarı transparan hale gelir. Bu sayede 
arka fondaki referans imajı görerek modelleme yapmak mümkün olur.
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Ön - Yan ve perspektif açılardan kontrol ederek modeli referansa uyacak şekilde Vertexlerden 
çekerek şekillendirelim.

Face Mode’a (İmleç model üzerindeyken Sağ Mouse Butonuna basılı tutarak) geçerek modelin 
sağ ya da sol kısmının Polygon'larının yarısını, üst ve alt Polygon'ların ise tamamını silelim. Mo-
del yarısından kesilmiş bir boru şeklini alacaktır.

 

Modelin alt kısmına bacak uzantısı oluşturmak için ön ve arka kısımlardaki Edgeleri seçip > üst 
menü Edit Mesh > Bridge seçeneği ile birleştirelim. > Birleşirken de Divisıon sayısını 3 yapalım.

 

*Not: Üst menüden Display > Headup Display > Polycount seçeneğini aktif edilirse sahnede 
bulunan modellerdeki Polygon Edge ve Vertex sayısı görülebilir. Bu sayıları görmek modelleri her-
hangi bir oyun programına aktarırken faydalı olacaktır.

Orta kısımda oluşan Polygon alanı ortadan tutup aşağı doğru çekerek kasık kısmını oluşturalım.

  

Önden görünümde ise ortalayıp hizalayalım.

Üst menüden > Mesh Tools > Insert Edge Loop seçeneğini seçerek Edge'ler arası birleştiren 
Connect Edge atabiliriz.

Insert Edge Loop yazısının yanındaki kutuya basarak onunla ilgili özellikler kutusunu açalım > 
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Insert Wıth Edge Flow seçeneğini aktive edelim. Bu sayede Edgeler arası ek Edge atarken aynı 
doğrultuyu kullanır.

 

Kol kısmını oluşturmak için 4 adet face (Polygon) seçip > Shift+Sağ Mouse ile açılan menüden 
Circulatıze Components’i seçerek seçili Polygon'ları ovalleştirelim. Bu sayede kol için uygun alan 
oluşturulmuş olur.

 

Eğer Polygon'lar eğriyse menüdeki Twist  ile düzeltilebilir.

Seçili Polygon'ları > üste menü > Edit Mesh > Extrude ile uzatarak kol uzantısını yapalım.

Önden görünüm ekranında üst kısmı içeri çekerek Extrude ile çıkan alanı omuz çıkıntısı haline 
getirelim.

Üst menüden Mesh Tools > Insert Edge Loop ile kol cıkıntısına ekstra Edge ekleyerek kolun 
çıkacağı alt kısmı 4 Polygon haline getirelim.
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Edgeleri belirli bir yüzey doğrultusunda kaydırmak istersek;  Edge seçiliyken > üste menü > 
Mesh Tools > Slıde Edge > Orta Mouse Butona basılı tutarak Edge’i kaydıralım.

Aynı işlemi Vertex ile için yapmak için > Movetool Settıngs > Axıs Orıentatıon > Normal seçe-
neği kullanılabilir.  Bu sayede Vertexler yüzey boyunca kayar.

Kolun çıkacağı 4 Polygon'a böldüğümüz alandaki Polygon'ları seçelim ve silelim

Gerekli yerlere fazla uzun dikdörtgen Polygon'lara Mesh Tool Settings > Insert Edge Loop ile 
Edge atarak Polygon sayısı çoğaltılabilir. Bu sayede Polygon'lar kare olur ve model daha detaylı 
pürüzsüz hale gelir.
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Sculpt Menu > Relax Tool ile modeldeki Edge'ler yumuşatılabilir. Bu sayede eğiri Edgeler ken-
diliğinden bir düzene girecektir. Bu işlem sırasında modeli fazla deforme etmemeye dikkat etme-
miz gerekmektedir.

MODELE KOL EKLEME
Gövdede kolun çıkış alanı için oluşturduğumuz boşluktaki Edge sayısıyla aynı Edge sayısına 

sahip bir Silindir ekleyip onu kolun hizasına yerleştirelim.

Dik Segment sayısı:8 yatay Segment sayısı: 5 olarak silindir ayarlanabilir.

Kolun dirsekten hafif kırılma açısı > Vertexleri seçip > odak noktasını ayarlanarak > Rotate ile 
döndürülerek oluşturulabilir.

Kolun el ile birleşen yerdeki Vertexleri daraltarak bilek kısmını oluşturalım.

Kol ve gövdeyi Bridge ile birleştirmeden önce:

	 Kol ve Gövdeyi, her iki objeyi de seçelim > üst menü Mesh > Combine ile birleştirelim.

	 Daha sonra hem gövde Edge'leri hem de kolun omuzla birleşecek yerindeki Edge'lerin ta-
mamını seçelim ve Bridge ile birleştirelim.
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Smooth (yumuşatılmış kenarlar) görünüm için model seçiliyken klavyeden “3” tuşuna basarak 
model yumuşatılabilir. “1” ‘e basarsak da Normal Lowpoly moduna geri getirilir. “2”’ye basılarak 
ise yumuşak kenarlı düşük Polygon'lu ön izlemeli modda çalışılabilir.

İlk resimde model Lowpoly modunda. ikinci resimde 2’ye basılmış ve Soften Edges ve Low Poly 
ön izleme modu halinde, üçüncü resimde ise “3”’e basılmış ve tamamen yumuşatılmış haldeki 
model görünmektedir.

Bu seçenekler ön izleme olarak yumuşatırlar. Üst menü Mesh> Smooth gibi değildir modelin 
Polygon sayısını kalıcı olarak artırmazlar.

BACAK EKLEME
 Silindir modeli ile bacak oluşturalım. Önden ve yandan hizalayalım.

Kalçada bacak ile birleşecek Edge sayısı kadar silindirde Segment sayısı olsun.

Input alanından 6 adet Height Segment ekleyelim. Bacağı çizime göre Vertexlerden tutarak 
şekillendirelim.
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Gövde ve bacağı üst menü> Mesh>Combine ile birleştirelim.

Edgeleri seçelim > üst menü> Edit Mesh>Bridge ile birleştirelim.

Gerekli yerlere üst menü > Mesh> Insert Edge Loop ile Edge atarak detay verelim.

Gövde soft, bacak Hard Edge görünüyor ise > Mesh Display > Harden Edges seçelim ve hepsini 
düşük Polygon halinde görelim.

Duplicate Special:

Modelin yarısı bittiğinde ya da diğer yarısı ile birlikte tamamlanmış olarak görmek gerektiğinde 
> kopyalanacak objeyi seçelim > odak noktasını, Snap To Grid seçeneği aktifken,  sıfır noktasına 
taşıyalım > üst menüden > Edit > Duplicate Special’ın yanındaki kutucuğa basıp menüyü açalım > 
kopyasını oluşturacağımız koordinatın değerinin önüne “-” koyalım : -1 değeri modelin kopyasını 
simetrik olarak oluşturmaya yarar.

Instance olarak kopyalanan gövdeinin yarısı tamamlanmış olur ve ekstra olarak diğer yarısında 
yapılan değişiklikler otomatik olarak öteki yarısında da güncellenir (3DS Max programındaki Sym-
metry Modfier’ına benzemektedir.).

EL MODELLEME
Cube modeli oluşturup el boyutunda uzatalım. Bu obje avuç içi olacak kısm olacak şekilde  

oluşturalım.

Diklemesine 4 Segment / Enlemesine 3 Segment atalım.
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Elin avuç kısmına kavis vererek avuç içi oyuğunu oluşturalım. Bilek kısmını daraltalım. Parmak-
ların çıkacağı kısıma da kavis verelim.

Parmakların çıkacağı Polygon yüzeylerini Face moda geçerek seçelim > üst menü > Edit Mesh 
> Extrude ile Extrude ile uzatalım. 

Faceleri uzatırken Extrude seçeneklerinde Keep Faces Together seçeneğini Off yapalım. Bu 
sayede her yüzey ayrı ayrı uzayarak parmakları oluşturacaktır.

Yan taraftan tek Polygon'u seçip başparmak çıkıntısı yapalım.
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Parmakların her birine 2 adet Edge Loop atarak parmak Polygon sayısnı 3 e çıkartalım.

Parmak uçarını daraltalım.

Ortadaki Edge in altına ve üstüne bir Edge daha atalım.

Atılan Edgelerdeki dış Vertexleri tutup içeri doğru çekerek eklemleri oluşturalım.

Eklemin içte kalan kısmını ekleme doğru sokarak parmak ucu gibi yüzeyleri dışa doğru çıkara-
lım.

 

Tüm parmakları Edgeleri ayarladıktan sonra son halini görmek için “3” rakamına basıp Smooth 
ön izlemesi yaparak kontrol edelim.
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El modelinden emin olduktan sonra kol ile  birleştirelim. Birleştirirken el ve kol Edge sayıları eşit 
değilse bilek kısmındaki Vertexleri  Edit Mesh > Merge ile birleştirerek eşitleme yapılabilir.

 

Vücut ve eli Mesh > Combine ile birleştirelim. > Bilek ve kol ucundaki Edge sayısı aynı ise Bridge  
ile birleştirme yapılabilir.

Gövde modelinin odak noktası birleştirme işleminden sonra kaymış olacaktır. Odak noktasını 
sıfır noktasına klavyeden “D” tuşuna basıp Move aracı ile taşıyalım ve tekrar “D” tuşuna basarak 
odak noktasının hareket özelliğini kapatalım.

Gövde modelini Duplicate Special ile simetrik kopyasını oluşturalım.

Gövde modelinin History kısmında biriken gereksiz Histroy bilgisini silmek için; üst menüden > 
Edit > Delete All By Type > History ile geçmişi silelim.
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KAFA MODELLEME
Küre oluşturup eskizdeki göz hizasına yerleştirelim. Kürenin merkez kısmı göz bebeğine baka-

cak şekilde döndürelim.

Göz küresi seçiliyken üst menü > Modify > Make Live seçerek ya da mıknatıs ikonuna tıklaya-
rak, model üzerine Polygon yapışır moda getirelim.

Önden görünümdeyken üst menü > Mesh Tools > Create Polygon diyerek göz üzerine Polygon 
yüzey çizelim. 8 Edge den oluşan Polygon yüzey kafa modelinin başlangıç noktası olacaktır.
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Yüzeye Polygon çizimini bitirmek için seçme okunu seçerek çizimi sonlandıralım.

Çizilen yüzeylerin Edgelerini seçelim ve Extrude ederek göz oyuğunu oluşturalım.

Oluşturulan alanı Face Mode’a geçerek silelim. Sadece konturlar kalmalıdır.

 

Polygon'ların normal yüzeyleri ters olarak oluştuysa ters çevirmek için etmek için > Mesh 
Display > Reverse ile Flip Normal uygulaması yapalım.
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Göz yapısına uygun olacak şekilde çerçeveyi “V” şekli oluşturacak şekilde ayarlayalım.

En dışta kalan Edge’i Extrude ile karakterin kaş hizasına kadar oluşturalım.

Yüz hatlarına uygun olacak ve göz çukurunu oluşturacak şekilde yeni eklenen Polygon'u Ver-
texlerden tutarak ayarlayalım.

Soldan iki Edge’i tutup Extrude ile burun kemiği hizasına çeklim. Yandan görünümden de bu-
run kemiğine hizalamasını yapalım.

Burun kısmındaki iki Edge hariç diğer tüm kontur Edgeleri Extrude ile ekleyip yeni alan oluştu-
ralım.
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Oluşturulan alanı referansa Vertex Mode ile Vertex noktalarını Move aracı ile hareket ettirerek 
hizalayalım.

Klavyeden “3” e basarak Smooth halini  modelin son hali hakkında filir sahibi olmak için kontrol 
edelim.

AGIZ KISMINI MODELLEME
Karşıdan görünümdeyken Mesh Tools > Create Polygon ile ağızın yarısını oluşturalım.

 

Çizim bitince Enter a basarak ve Polygon'un  oluşmasını sağlayalım.

Dudağın odak noktasını “0” noktasına ortalayalım > Dudak Polygon'unu ağız çizimine hizalaya-
lım.
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Edgeleri orta kısımdakiler hariç tutalım ve Extrude ile dudak kalınlığı verelim.

Ortadaki Edge’i silelim. Sadece dudaklar kalsın.

Gerekli durumda Mesh Display > Reverse diyerek normalleri döndürme işlemini yapalım.

Vertexleri tutarak dudağa kavis verme işlemini uygulayalım.

  

İç kısımdaki Edgeleri > Extrude ederek dudağa kalınlık verelim.

Dudağın dışındaki Edgleri yine Extrude ederek burun altı ve yanak kısımlarını oluşturalım.

Edge kısmına bir Polygon katı daha çıkalım.

İki yüzeyi Combine ile birleştirelim. Vertexleri Merge ile birleştirerek iki parçayı birleştirelim.

“G” tuşu son hamleyi tekrarlar.

Seçili Edgeleri Extrude ile çoğaltarak yüzün üst tarafıyla birleştirelim.
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Kafanın üst tarafındaki Edgeleri Extrude ederek kafanın üstünü oluşturalım.

 

Extrude edilen Edgeleri Rotate ile döndürerek kafanın şeklini oluşturalım.

Insert Edge Loop seçeneği ile gerekli yerlere ek Polygon oluşturabiliriz.

Boyun kısmını oluşturmak için Vertexleri Merge ile birleştirelim ve boyun boşluğu oluşturalım.



36

Boyun kısmına eklenecek Edge sayısı kadar Polygon'a sahip olan bir silindir oluşturalım. (Top-
lamda 14 side)

Silindirin yarısı, alt ve üst Polygon'ları silerek yarım boyun modeli oluşturalım.

Kafa ile boyunu üst menüden Combine seçeneği ile birleştirelim. Bridge ile boyun ve kafa Ed-
geleri arasında Polgon oluşturalım.

Sculpt seçeneklerinden Relax ile boyun bölgesindeki Polygon'ları yumuşatabiliriz.

KULAK MODELLEME
Bir Cylinder modeli ya da Pipe modeli oluşturarak kulak oluşturulabilir.

Kulağın ekleneceği yerdeki Edge sayısı kadar Segment'e sahip olan bir Pipe seçilmelidir.

Seçili Edgelere Edge flow atarken şekli bozmandan edge atmak için > Shift + Sağ Mouse > Edit 
Edge Flow ile düzlem doğrultusunda Edge atılabilir.
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Kafanın kulak için ayrılan boşluğundaki Edge sayısı kadar Tube’da Edge ekleyelim ya da azalta-
lım.

Kulağı referans görselindeki yerine hizalayalım. Kafaya yakın yüzeydeki tüm Polygon'ları silelim.

Kulak içinde kalan Edgeleri seçip Extrude ile 3 kere Poly katmanı olarak kulak içi yüzeyini oluş-
turalım.
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 Kulağın kafa tarafına denk gelen Edgeleri Extrude ile uzatalım.

Kulak ve kafa modellerini seç > Mesh > Combine

Editmesh > Bridge ile kulak ve kafa edgelerini birleştirelim.

Birleşmeden sonra Vertexleri kaydırarak meshleri düzenleyelim. Bu aşamada “3”'e basarak 
kulağın Smooth halini kontrol edebiliriz.

BURUN KISMINI MODELLEME
Ağız etrafında oluşan oval topoloji burun kısmını da dahil etmeli. Bu yüzden burun kısmının 

hemen üzerinden Edgeleri geçirmek gerekli.

Vertexleri kullanarak, önden görünüm ekranından burunu kaplayacak bir Polygon yüzey oluş-
turalım.
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Extrude il burun çıkıntısını görseldeki Polygon'a verelim. “0” noktasında Extrude dan dolayı  iç 
kısımlarda bir Polygon fazlalığı oluşabilir. Kontrol edelim ve varsa silelim.

  

Alt kısımda kalan Polygon’u Exture ile içeri doğru > Scale ve Shift ile Exture yapıp daraltarak 
burun deliği alanı oluşturalım. Daha sonra bu küçük Polygon’u burun içne doğru Exturde ile iterek  
burun deliğini oluşturalım.

Tek bir Edge seçiliyken paralellerine doğru bir Edge sırası eklemek için > Tek bir Edge seçiliyken 
> CTRL basılı tut > sağ mouse butonu > Edge Rıng UtılıtıeS > To Edge Ring And Split seçeneği ile 
Edge ekleyebiliriz.

 

Daha sonra yeni eklenen edge serisinin tamamını seçip > Shift>Sağ Mouse But > Edit Edge 
Flow diyerek yüzeydeki kavise uygun şekilde Edgeler ayarlanabilir.

 

Yeni eklenen Edgelerdeki Vertexleri seçip Move  aracı ile burun modelini detaylandırabiliriz.

Burunu kendi içinde de enlemesine Edge ekleyerek Polygon sayısını arttırıp detaylandıralım.
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AĞIZ İÇ KISMINI MODELLEME
Karakterin animasyonda ağız kısmı hareketlenecek ise ağızın iç kısmını da oluşturmak gerek-

mektedir.

Dudakların ağız içinde kalan Edgelerini tutup Scale aracı ile düzlem haline getirelim.

Extrude = Shift + Move Tool ile içeri doğru Polygon'lar ekleyerek ağızın iç kısmını oluşturalım.

6 -7 adet Polygon yüzeyi eklemek yeterli olacaktır. Son kısma gelince Bridge ile birleştirip  Fıll-
hole ile deliği kapatalım.

KAFA POLYGON'LARINI DÜZENLEME
Kafa modelinde bulunan fazla uzun dikdörtgen Polygon'ları bölerek daha ufak kareler haline 

getirelim.

 

Uzun Polygon'ların bulunduğu alandan bir Edge seçelim > CTRL+Sağ Mouse > Edge Rıng Utı-
lıtıes > To Edge Rıng And Splıt seçeneği ile ekstra Edge ekleyerek uzun Polygon'ları kare forma 
sokalım.

Shift > Sağ Mouse But > Edit Edge Flow ile Edgelere kavis verelim.

Sculpting Menüsü’nden Relax seçeneği ile modelin dengesiz Polygon yüzeylerini yumuşatabi-
liriz.

B + Sol Mouse Buton ile yumuşatma aracı fırça kalınlığını ayarlayabiliriz.

    

 Relax seçeneği, modelinizin şeklini bozmandan Polygon Vertexleri arasındaki mesafeleri eşit-
ler.
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Input History’den en son eklenen özelliğe ekleme yapılabilir.

Aşağıdaki örnekte Edge eklendikten sonra Input History’den en üstteki seçeneği açarak içeri-
sindeki > Splıt Type=Multı yapıldığında Edge Sayısı > Dıvısıon’dan arttırılabilir.

Boyun ve gövdenin Bridge ile birleşeceği alandaki Edge sayıları eşit olmalı.

Eşit olmayan Edge sayılarını artırmak için bir taraftaki Edge serisini seçip > Edit Mesh > Bevel 
seçerek Edgeler çoğaltılabilir.

Üçgen yüzeyleri mümkün olduğunca azaltmak ve animasyona uygun 4 kenarlı Polygon'lar 
oluşturmak için; 

Üçgen yüzeylerin Vertexlerini seçip > Edit Mesh > Merge Center ya da Merge seçeneği ile  
birleştirilebilir.

Kafa ve gövdeyi Combine ile birleştirelim. > İki tarafın da Edgelerini seçip Bridge ile birleştire-
lim.

 

Vertexleri düzelterek boyun kısmının topolojisini düzenleyelim.

DİŞ ETLERİ MODELLEME
Üst menüden >Polygon > Pıpe oluşturalım. Pipe geometrisine Platonıc Solıd simgesine > Mou-

se Sağ Buton ile de ulaşılabilir.

  

20 x 1 segmentte, Thicknes 0.2 ölçülerinde bir Pipe oluşturalım > Face Mode’a geçip Pipe’ın 
yarısını silelim.
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Edgeleri diklemesine seçerek Connect ile aralarına ekstra Edge atalım. Bu işlemi Tüm Edge 
alanlarında tekrarlayalım.

Yeni eklenen Edgelerin tamamını seçelim> yukarı yöne doğru çekelim.

Damağın yarısını ve diğer yarısının da üst kısmını facelerini seçip silelim. Daha sonra Symmetry 
ile yarısını kopyalayalım.

 

Diş boşluklarını oluşturacak kısımları diş etinin içine doğru Vertex modundayken çekelim.

Yatay olarak bir Edge atalım ve diş etine biraz dışarı doğru kavis verelim.

Dişeti modeli seçiliyken üst menü > Mesh > Mırror ile diğer yarısını oluşturalım.

 

Klavyeden “3”’e basarak soft model ön izlenimi ile kontrol edelim.
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Diş eti modelini karakterin ağızının iç kısmına yerleştirelim. Kopyasını çıkarıp alt diş eti bölümü-
nü de oluşturalım. Alttaki diş eti modelini ufaltıp biraz daha geriye çekerek modelin ağızına tam 
oturmasını sağlayalım.

Dişlerin çıkacağı Polygon alanlarını bir diş alanı atlayarak seçelim. Extrude ile içeri doğru diş eti 
kalınlığı payı verelim. Bir kere daha Extrude seçeneği ile içeri doğru oyuk açalım.

Extrude ile oyuk açarken koordinat sistemini World olarak ayarlamak için Extrude oklarının ya-
nında bulunan ufak halka işaretine bir kez tıklayalım. Yön oklarının hizalarının değiştiği görülebilir.

İçeri Extrude verdikten sonra atladığımız bölümleri seçip aynı işlemleri tekrarlayalım.
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DİŞLERİ MODELLEME
Diş eti modellerinin oyuk kısımlarındaki Polygon'ları seçerek üst menü > Edit Mesh >  Extract 

seçeneği ile Polygon'ları diş eti modelinden ayıralım.

Ayırdığımız Polygon'ları seçip Extrude ile hacim kazandıralım.

Uç kısımlarını seçerek scale ile tek koordinatta düz olacak şekilde şekillendirelim.

Diş modelini oluşturduktan sonra Diş eti modeli grubundan çıkartmak için; üst menü > Edit >  
Unparent seçelim.

İlk dişi yerleştirdikten sonra diğer dişleri de aynı dişi kopyalayarak ve ölçeklendirerek oyuk 
alanlara denk gelecek şekilde oluşturabiliriz.

 

Dişler ve diş etlerini seçerek > Mirror ile simetrisini oluşturalım.,

Alt dişler için ise üst diş takımını Duplicate ederek alt kısma yerleştirelim. Önde bulunan alt 
dişleri biraz daha ufaltıp düzenleyerek alt dişleri de modellemeyi bitirelim.

DİL KISMINI MODELLEMEK
Bir Cube ekleyerek uzun dikdörtgen form verelim. Ölçülendirme yaparken değer girilecek ala-

nın yazısını seçilip çalışma alanında Mouse orta tekerleğine basılı tutarak sağa sola çekerek ince 
ayar ölçeklendirme yapılabilir.
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Segmentler ekleyerek dil modelini detaylandıralım. En, kalınlık ve boy olarak 4/2/4 Segment 
sayısı yeterli olacaktır.

 Vertex moduna geçerek Soft Selection Mode açıkken dilin ön kısmını uzatalım. Arka kısmın-
daki tüm Vertexleri seçip dilin arka kısmını genişletelim.

Orta kısımdaki Edgeleri Soft Selection olmadan seçerek Scale ile eşit oranda büyüterek kenar-
lara kavis verelim.

Üst kısmındaki orta alanda bulunan Edgeleri seçip aşağı doğru Move aracı ile indirerek dilin 
orta kısmına kavis verebiliriz. 

Uç kısımındaki Vertex’leri seçerek Scale ile daraltalım.

Dilin dip kısmındaki Face’leri seçerek Extrude ile uzatıp aşağı doğru indirerek alt çeneye yakın-
laştıralım ve ağızdan çıkıyormuş izlenimi verelim.

 Dil modeli seçiliyken > Edit  > Delete By Type > Delete History diyerek dildeki işlemleri sıfır-
layalım.

Bu noktada Maya dosyamızın farklı bir kopyasını kaydederek bozulmalara karşı önlemimi-
zi alalım. Yedek dosya üzerinden çalışmak her zaman tercih edilen, veri kaybını en aza indiren 
yöntemdir. Tercihen bir sonraki dosyaları “dosya adı-2,3,4” diye isimlendirerek kullanım kolaylığı 
sağlayabilir.
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AYAK MODELLEME
Bir Cube oluşturalım. Yan görünümden “0” noktasına referans çizimin ayak kısmına hizalaya-

lım. Daha sonra diğer modellerde de yaptığımız gibi Subdıvısıon ekleyelim. Enine “4”, Derinleme-
sine: “5”,  boy kısmına da “1” Subdivision eklemek başlangıç için yeterli olacaktır. Burada verilen 
değerler referans çiziminizin değişikliğine göre farklılık gösterebilir.

 

Polygon'lara ayırdığımız dikdörtgen ayak modelinin ön kısmını ayağı deforme etmeden daralt-
mak için Latıce efekti kullanılabilir. Üst menülerden > Deform > Latıce seçerek dikdörtgene Lati-
ce’i ekleyelim.

Sol kısımdaki Outliner kısmından Latice seçildiğinde sağ tarafta Shapes kısmından Latice se-
çenekleri girilebilir. Seçeneklere “2/2/2” olarak girelim yani her yüzeyde tek bir face bulunacak 
şekilde. Buraya girdiğimiz Face değerleri modelin kendi Polygon sayıları değil, Latice Deformer’ın 
değerleridir. Bu sayede çok Polygon'dan oluşan yüzeyleri tek bir Polygon yüzeyi gibi şekillendi-
rilebilir Latice’i oluşturduğumuz kutu Polygon modelinin üzerine eklenmiş ayrı bir kutu olarak 
da düşünülebilir.

CTRL+Sağ Mouse Düğmesi’ne basarak Latice in Vertex’lerini seçerek şekillendirme yapalım ve 
kutunun yani ayak modelinin ön kısmını daraltalım.

Latice’i silmek için delete kullanılmamaktadır. Doğrudan silmek modeli eski haline getirecektir. 
Bu yüzden Latice kullanılan model seçiliyken Edit> Delete By Type >Delete History ile Latice sili-
nir ve Polygon Mod’a geri dönülmüş olur.
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Ayak ve gövde modellerini seçip üst menü > Mesh > Combine ile birleştirelim. Ayağın bilek ile 
birleşecek kısımdaki facelerini (Polygon'ları) seçip silelim. 

Bacağın ve ayağın bilek kısmındaki Edge’lerin hepsini seçelim Editmesh > Bridge ile birleştire-
lim.

Vertex mode’a gelelim ve ayak anatomisine uygun bir şekilde referansımıza uygun olacak bi-
çimde ayağın şeklini düzenleyelim.

Obje seçiliyken Sağ Mouse düğmesine basılı tutarak açılan menüden Object Mode’a gelip “3” 
tuşuna basarak Soften Edges ön izlemesini yaparak modellemeye devam edebiliriz.

Gerekli yerlere Edge ekleyip, Sculpt modunda Smooth ve Relax aracı ile gerekli düzeltmeler 
yapılabilir.

GÖZ BURUN VE AĞIZ DETAY DÜZELTMELER
Ağız, göz ve burun çevresinde gerekli yerlere üst menüden Mesh Tools > Multı Cut Tool ile 

isten noktalara Edge eklenerek detaylandırma yapılabilir.

Detaylandırma çalışmasını yapmadan önce modelin diğer yarısını Duplicate Special>Instance 
olarak oluşturalım. Bu sayede modelin bitmiş halini görerek detaylandırma işlemleri yapılabilir.

Özellikle karakterimiz animasyon için hazırlanıyorsa, ağız ve göz bölgelerinde farklı hareketler 
yapılacağı için, bu alanlarda Polygon sayılarının biraz fazla olması yapılacak mimik animasyonları-
nın daha etkili olmasını sağlayacaktır.
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Yukarıdaki örnekte düşük Polygon sayısı nedeni ile kapanan göz kapağının, göz küresi ile çakış-
masını görülebilir.

Multi Cut Tool seçiliyken ve Mouse ikonu model üzerindeyken CTRL tuşuna basılı tutarsak 
bulunduğu alan doğrultusunda EDGE ekleyebileceği yerlerin ön izlemelerini bize gösterir. Bu 
sayede hızlı bir şekilde modele detay Polygon'lar eklenebilir.

Ön ve Yan pencerelerden referans çizimi kontrol ederek 3D modelimizin gerekli yerlerine de-
taylandırmalar yapalım. Detaylandırmaları yaparken dikkat etmemiz gereken unsur Polygon'ların 
özellikle hareket edecek olan ağız göz gibi alanlarda üçgen ya da 5 kenar Polygon'ların olma-
masıdır. Kafanın üst kısmı gibi Polygon'ları esneterek hareket ettirilmeyecek alanlarda üçgen Pol-
ygon'lar gereklilik durumunda kabul edilebilir.

Ayak kısımlarını animasyona uygun hale getirmek için gerekli ayarlamaları yapalım. Ayak mo-
delindeki Vertexler seçilip Soft Selection özelliğini aktif hale getirilip Rotation aracı ile ayakları 
dışarı doğru döndürelim. Döndürme işlemini yaparken odak notasını gerekli görüldüğünde bacak 
hizasına alarak döndürme işlemini yapalım.
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Gerekli yerlerde bacak bölümünde uzun dikdörtgen Polygon'lar bulunuyorsa onlara da ekstra 
Edge ekleyerek simetrik kare Polygon'lar haline getirelim. Animasyon sırasında uzun Polygon'lar 
gerekli esnemeyi yapamayacağı için modelde kırılmalara ve sünmelere neden olurlar. Ayrıca kap-
lamalarda da bozulmalar olabilir. Bu sebepten dolayı Polygon'ları kare ve yeterli sayıda tutmakta 
fayda vardır. Fazla sayıda gereksiz Polygon'un da sistemi zorlayacağını unutmamak gerekir.

Fazla sayıda kare Polygon bulundurmak ta çalışma açısından zorluklara neden olacaktır. Özel-
likle Rıgleme (iskelet sistemini modele bağlama) işlemi sırasında kemiklerin kapsama alanlarını 
belirlemede, fazla sayıda Polygon sizi gereksiz yere uğraştıracak ve sonuca ulaşmanızı engelleye-
cektir.

Modeli klavyeden “3” tuşuna basarak Smooth ön izleme modunda incelerken artırılacak olan 
Polygon'ları göremeyebiliriz (ilk resim). Bu yüzden fikir vermesi açısından kontrol etmek için üst 
menüdeki Mesh>Smooth seçeneğini seçelim. Bu sayede gerçek Polygon değişimin görülebilir 
(ikinci resim). Daha sonra tekrar eski haline CTRL+Z ile getirerek modellemeye düşük Polygon 
halinden modellemeye devam edilebilir.

 Vücut pozlamasını iskelet sistemine rahat bir şekilde giydirebilmek için (Rigging) için mümkün 
mertebe klasik “T” pozuna sadık kalarak modellemeliyiz. Eğer referans çizimimiz “T” pozunda 
değilse modelleme bittikten sonra kolları yukarı doğru yere paralel olacak şekilde Vertexlerden 
Soft Selection ile tutarak ve odak noktasını da omuz hizasına taşıyarak kaldıralım. Daha sonra da 
Sculpt > Relax tool ile gerilen Polygon'ları yumuşak geçişli hale getirelim.

KARAKTERİ MIRROR İLE TAMAMLAMAK
Bu işlem için Duplicate Special ile çoğalttığımız gövdenin yarısını silelim. Mirror işlemi ile kop-

yalanan parça otomatik olarak orijinal parça ile birleştiği için Mirror yöntemini tercih edelim. 
Karakterin merkez noktasının tam “0” noktasında olduğundan emin olalım. 

Merkeze yakın olan gövde modelinin Vertexlerinin tamamını seçelim ve Snap To Grid  
özelliğini aktif hale getirip tüm Vertexleri “0” noktasına hizalayalım.

Vertexlerin tamamını hızlı bir şekilde hatasız olarak seçebilmek için; önce Edge Mode'a gelelim 
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ve merkeze yakın tüm Edgeleri çift tıklayarak seçelim. Daha sonra seçili olan Edgeleri, Vertex’e 
çevirmek için üst menüden > Select > Convert Selection > To Vertıces seçeneğini seçelim.

Vertexlerin tamamı seçili iken hepsini aynı noktaya hızlı bir şekilde hizalamak için > Scale 
aracını seçip yatay doğrultuda daraltma işlemini birkaç kez tekrarlayalım. Bu sayede Vertexler 
yukarıdan aşağı bakıldığında tek bir hizada olacaktır.

 

Mirror ile karakter modelinin diğer yarısını oluşturmak için, üst menlerden > Mesh > Mır-
ror’u>yanındaki kutucuğa basarak seçelim. Bu sayede x,y,z koordinatları ile kopyalama seçenek-
lerini görerek modelin diğer yarısı doğru şekilde oluşturulabilir.

Eğer Mirror seçenekleri ile daha önce çalışılmış ve ayarların sıfırlanması gerekiyorsa menünün 
üzerinde bulunan Edit>Reset Settıngs seçeneklerinden Mirror Tool sıfırlanabilir.

Mirror seçeneği kullanıldığı zaman modelin merkezinde bulunan tüm Vertexleri, oluşturduğu 
modelin diğer yarısındaki merkezde bulunan Vertexler ile kaynaştırarak modeli birleştirir. Tek bir 
mesh model haline getirir. Duplicate Special seçeneğinden en büyük farkı budur.

Mirror seçeneği aktifken açılan menüde bulunan Merge Treshold seçeneği sayesinde mer-
kezde bulunan ve birbirine kaynak yapılacak Vertexlerin yakınlık dereceleri değiştirilebilir. Bu 
sayede belirli bir uzaklıkta bulunan Vertex noktaları da gerekli görüldüğünde kapsama alanı geniş-
leterek modelin birleştirme merkezine dahil edilebilir.
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 Mirror ile birleştirme işlemi yapıldıktan sonra klavyeden “3”’e  basarak modeli Smooth ederek 
merkezde birbiriyle birleşmeyen Vertexler olup olmadığı kontrol edilebilir.

 Ayrıca dudak burun gibi birbirine yakın ama birbirine yapışmaması gereken Vertexlerin isten-
meyen şekilde birbirine kaynayıp kaynamadığını da kontrol etmek gerekmektedir.

GÖZ MODELİNİ DETAYLANDIRMA
Öncelikle göz küresini seçelim ve üst menüden > Modıfy > Freeze Transform ile bulunduğu 

koordinatları sıfırlayalım. 

Göz küresinin Duplicate ile bir kopyasını oluşturalım. Kopyanın ismini > Göz_Saydam olarak 
değiştirelim. Bu göz küresinin etrafını kaplayan ve parlaklığı sağlayan şeffaf alan olacaktır.

Kopya kürenin ön kısmındaki 3 sıra Vertexi seçerek hafif dışarı doğru çıkıntı oluşturalım. Bu 
şekilde gözün ön kısmında bulunan saydam kısmı modelleyerek karakterin bakışlarını daha canlı 
bir hale getirmiş olacağız.

Çıkıntı kısmını modelledikten sonra Sağ Mouse Buton > Assign Favourite Material > Phong 
materyali atayalım. Bu materyal parlak ve saydamlık sağlayan bir materyaldir.

 

Sağdaki Attribute Editor alanınında Phong Material’i seçerek Transparency seçeneğini tam 
beyaz yapalım.
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İlk oluşturduğumuz göz küresini seçelim ve Vertex modundayken önden 2 sırayı seçelim. Seçili 
Vertex alanlarını genişletmek için Vertex seçiliyken > üste menü>  Select > Grow özelliği ile seçili 
alan genişletilebilir.

Çalışma alanının üst kısmında bulunan kısa yollar barına kendi kısayol simgelerimizi ata-
mak için: Üst kısayol barlarından Custom yazan ve içi boş olan barı seçelim. Daha sonra 
oraya simgesini atayacağımız seçeneği en üstteki listeden seçerken CTRL+Shift+Sol Mou-
se Button ile tıklayalım. O seçeneğin simgesinin barda kısayol olarak belirdiğini görebili-
riz. Bu şekilde hızlı çalışma amaçlı istediğimiz seçenekleri oraya taşıyabiliriz. Eklenen kısa-
yol ikonunu Custom menüden silmek için ise sağ tıklayıp Delete seçilmesi yeterli olacaktır.

Gözün iris kısmını ise seçili olan orta kısımdaki  Vertexleri Move aracı ile içeri doğru sürükleye-
rek oluşturalım. İris kısmının başlangıcına bir Edge daha ekleyerek oyuk alanın başlangıç kısmını 
belirginleştirelim. Daha sonra da saydam materyal ile kapladığımız ve ön kısmında kavis oluştur-
duğumuz göz küresini diğer kürenin üzerine taşıyalım ve Scale ile biraz büyüterek kürelerin birbiri 
üzerine binmesini engelleyelim.
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Göz bebeğini oluşturmak için orta alandaki Faceleri (Polygon'ları) seçelim ve sağ tıklayarak 
Assign Favourite Material > Surface Shader materyali ekleyelim. Bu sayede alan siyah ve mat 
olacaktır.

Her iki göz küresini de seçerek Group ile gruplayalım. Daha sonra göz grubunu Duplicate ile 
kopyalayalım. Gruplanan göz kürelerinin odak noktasını göz modelinin merkezine almayalım ve 
“0” noktasında bırakalım çünkü kopyaladıktan sonra aynı hizada olması için odak noktasının sıfır 
noktasında olması gerekmektedir.

Kopyalanan göz grubunu Scale kısmından ilgili koordinat satırına (x,y ve z) eksi (-) değer vere-
rek simetrik olarak göz çukuruna yerleştirelim. 

KARAKTER KIYAFETI OLUŞTURMA
Karakter modelleme çalışmalarında genel olarak iki şekilde kıyafet oluşturulmaktadır. Birinci 

yöntem; bilgisayar oyunları ve basit animasyonlar için modele entegre biçimde oluşturulan ve 
karakter ile birleşik kıyafet yöntemidir. Bunlar karakterin iskelet sistemi ile birleşik olduğu için 
oluşturulan animasyonlara vücudun bir parçasıymış gibi tepki verirler ve daha basit görünüm ser-
gilerler. İkinci yöntemde ise karakterin gövdesinden ayrı şekilde modellenen ve vücut animas-
yonlarına tepki veren simülasyon temelli Polygon kıyafet modelleri kullanılır. Bunlar karakterin 
hareketlerine kumaş simülasyonu şeklinde, yer çekimi, rüzgar ve kumaş ağırlığı gibi etkenleri he-
saplayarak tepki verirler ve daha gerçekçi sinematik animasyonlar elde etmemize olanak verirler.

Bu çalışma örneğinde ikinci yönteme yakın bir kıyafet çeşidi modellenecektir. Bunun için en 
kısa yöntem olan karakterin gövdesinin belirli Polygon alanlarını kopyalayıp kıyafet olacak şekilde 
modelden ayırma yöntemi kullanılacaktır.

Öncelikle gövde modelinden gömlek olacak Polygon alanı seçelim. Üst menü > Duplicate’i 
seçelim. Model üzerinde beliren Move araçlarından Mavi renkte olan doğrultudaki oku seçip 
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modelden uzaklaştırarak ya da açılan kutudaki Local Translate Z satırındaki değeri artırarak seçili 
Polygon'u gömlek halinde modelden belirli bir mesafe uzak olacak şekilde oluşturalım.

Oluşturulan modelde Local Translate işleminden dolayı üst üste binen Polygon ya da Vertex 
noktaları varsa onları Sculpt > Relax Tool ile düzeltelim. Gerekli yerlerde Vertex ve Edge düzen-
lemeleri yaparak referans imaja uygun hale getirelim.

PANTOLON / ŞORT MODELLEME
Gömlek modellerken uyguladığımız tekniğin aynısını burada uygulayabiliriz. Gömlek modelini 

üst menü Display > Hide ile gizleyerek model üzerinde daha kolay çalışabiliriz.

Pantolon olacak alanın Polygon'larını seçelim.

Edit Mesh menüsünden Duplicate'i seçelim.

Local Translate Z kanalına 1-1,5 gibi bir değer vererek pantolonu gövdeden uzaklaştıralım.

Duplicate ederek oluşturulan pantolon modelinin bel kısmı Vertex modunda Soft Selection ile 
daraltalım ve paça kısımlarını genişletelim. Cloth simülasyonu olacağı için efekti daha iyi göster-
mesi açısından kıyafette ayarlamalar yapılması önemlidir. 

Daha sonra Sculpt > Relax aracı ile Polygon'ların eşit olmayan alanlarını düzenleyelim. Kulla-
nım kolaylığı ve eşit düzenleme yapılabilmesi için üst bar menüde bulunan Symetry Tool'u aktive 
ederek Relax işlemini yapalım.
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Şort modelini tamamladıktan sonra Hide ile gizlediğimiz Gömlek modelini üst menü Display 
> Show > Show Last Hıdden diyerek görünür hale getirelim. Pantolon ve Gömlek modellerinde 
Polygon çakışması vs var mı kontrol edelim.

AYAKKABI MODELLEME
Karakterin ayakkabı bölümü Gömlek ya da Pantolon gibi ayrı bir parça olmayacağı için direkt 

gövde modeli üzerinden şekillendirme yapılabilir. Detaylandırma işlemi UV Map çıkarıldıktan son-
ra Substance Painter üzerinden yapılabilir.

Ayakkabı modelini detaylandırırken Gövde modelinin yarısını önden görünümdeyken silip, 
ayakkabı modellemesi bittikten sonra diğer yarısını Mirror ile oluşturmak daha hızlı sonuç alma-
mızı sağlayacaktır.

Referans görselindeki ayakkabı çizimine göre modelleme yapalım.

Çorap kısmına ekstra Edge Loop atarak oluşturalım ve dışarıya doğru Scale aracı ile çıkıntı ve-
relim.

Klavyeden “1” Hard Edge ve “3” Soften Edges ön izlemeleri ile modellemeye devam edelim. 
“2” rakamına basarak da Hard Edge kafesi görünürken bir yandan da Soften Edges ile yumuşatıl-
mış ön izlemede modellemeye devam edelim.
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SAÇLARI MODELLEME
Saçları modellemeye başlamadan önce yarım olan gövde modelini Mırror kullanarak tamam-

layalım. Klavyeden “3”’e basarak  Smooth modundayken Vertexlerin birleşip birleşmediğini açık 
bir yer olup olmadığını kontrol edelim. Birbiriyle birleşmeyen Vertexler Mirror işleminden sonra 
manuel olarak da Merge ile birleştirilebilir.

Gövde modelleme bittikten sonra Low Poly olan modelimizin Duplicate ile bir kopyasını oluş-
turalım. İlerde modelleme ile bir güncelleme gerektiğinde geri dönüş için bu Low Poly modeli 
yedek modeli kullanacağız. Karakteri yerinden oynatmadan kopyasını oluşturalım. Yeniden isim-
lendirelim; “karakter_high_res” olabilir. Düşük Polygon olan ilk modelimizi yeniden isimlendirip; 
“Karakter_Low_Poly”, yeni bir katmana (Layer) Create A New Layer And Assign Selected Object 
butonu ile aktaralım.

Düşük Polygon olan modeli de seçip ayrı bir katmana ekleyelim. İki ayrı katmanda iki ayrı gövde 
modelimiz oluşacaktır.

“High_res” (yüksek çözünürlük) Polygon ile yumuşatacağımız modeli seçelim. Üst menüden 
Mesh > Smooth ile kalıcı olarak Polygon sayısını arttırarak daha yumuşak yüksek Polygon sayılı 
modele dönüştürelim. 

 

Division değerini 1 olarak bırakalım. Bu değeri arttırdıkça modelde oluşacak olan Polygon 
sayısı artar. Fazla sayıda Polygon olması modelin daha güzel görüneceği anlamına gelmez. Ge-
reksiz sayıda oluşturulan Polygon fazlası, Rigleme, animasyon ve render gibi işlemlerin fazladan 
zamanlamasına ya da programın kitlenerek donmasına neden olur. Bu sebepten dolayı Polygon 
sayısını dengede tutmak önemlidir.

Saçları ayrı tutamlar halinde modellemek için “High_res_gövde” modelimi seçiliyken >üst  
menü>MODIFY>MAKE LIVE seçeneklerini aktif hale getirelim. 
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Simge butonlarında ise  simgesine basarak da Make Live özelliği aktive edilebilir.

Make Live özelliği aktif olunca modelimiz artık seçilemez. Fakat çizeceğimiz Curve ya da Quad 
Draw özelliği ile yüzeye Polygon ekleme gibi özellikler direkt olarak modelin üzerine yapışır. Bu 
sayede model ile aynı yüzeyde olması istenen Polygon modeller ya da şekiller eklenebilir.

Üst menülerden Create > Curve Tools > CV Curve Tool’u seçelim. Bu araç Vektörel çizim progra-
mında kullanılan Pen Tool ‘a benzeyen bir mantıkla çalışmaktadır. Belirlenen noktalar arasına çizgi 
oluşturarak işlemini yapar. CV Curve Tool’un kavisli çizime başlaması için en az 4 nokta oluşturul-
ması gerekmektedir. Sol Mouse Butonu ile tıklandığında butona basılı tutup sürükleyerek kavisli 
çizgier oluşturulabilir. Çizgiyi tamamlamak için ise Enter tuşun kullanılabilir.

Curve Tool’u kulanarak her bir saç tutamı için ayrı Pathler (yollar) oluşturalım. Oluşturma 
doğrultusu kafa derisinden dışarı doğru olacak şekilde olmalıdır. Bu sıralama daha sonra Vertex 
noktası eklemek istendiğinde bize yardımcı olacaktır. Bu tutamların birleşiminden ise saç modelin 
oluşturulabilir. Tek bir parça Polygon'dan daha gerçekçi ve stilize duracağı için bu yöntem kullanıl-
maktadır.

Curve Path çizimi bittikten sonra Path’in (çizginin) Vertex noktalarını tutarak kafa modelinden 
uzaklaştırmak gerekmektedir. Bunun için ise Make Lıve komutunu kapatmak gerekmektedir. Çün-
kü Make Live komutu objeleri Live olan objeye yapıştırmaktadır.

Çizdiğimiz çizgiye Sağ tıklayarak > Control Vertex seçeneğini aktive edip Vertexleri seçip Move 
aracı ile dilediğimiz gibi çizgi şekillendirilebilir.
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Eklenen noktalar dışında Curve çizgisine sonradan yeni bir Vertex noktası eklemek için; çizgi 
seçiliyken > Sağ Mouse Buton > Curve Poınt seçeneğini seçelim. Çizgi üzerinde nokta eklemek 
istenen alana tıklayalım. Sarı bir Vertex noktası eklendiği görülebilir.

 

Daha sonra üst menü > Curves > Insert Knot seçeneğini seçelim. Tekrar çizgimizi seçip > Sağ 
Mouse But> Control Vertex seçeneğini seçince çizgimizde kontrol Vertex noktasının eklendiği gö-
rülebilir.

 

Çizilen Curve çizgileri kaldığı yerden devam ederek çizgiyi uzatmak için ise öncelikle Curve  çiz-
gisini seçip daha sonra  üst menüden Curves > Add Poınt To seçeneği ile çizgiye Vertex noktaları 
eklemeye devam edilebilir. Dikkat edilmesi gereken konu ise çizimin yapıldığı yöne doğru Vertex 
noktası eklemektir.

Eklenen fazla noktaları silmek için klavyenin “Del” tuşu kullanılabilir.

Curve Tool’un Vertex noktaları seçiliyken Soft Selection ile daha yumuşak değişiklikler yapıla-
bilir. Soft Selection’ın kapsama alanını ayarlamak için ise klavyeden”B” tuşuna basılı tutarken > 
Mouse Orta Tekerlek Düğmesi basılı tutularak kapsama alanı azaltılıp arttırılabilir.
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Curve çizimini bitirdikten sonra Object Mode’a gelip Pivot noktası merkeze alınırsa, Curve’ü 
kopyalama işlemleri daha kolay yapılır.

Curve çizgilerini kopyalayarak ve referansa uygun hale getirerek karakterin saç modelini oluş-
tururken eğer modelimiz simetrik bir modelse, sadece sağ tarafını oluşturup daha sonra Mirror 
ya da Duplicate Special kullanarak diğer yarısı oluşturulabilir. 

Hacim Kazandırma
Curve path’leri oluşturma işlemi bittikten sonra, kafa modelinde oluşturulan bağımsız bir ya-

rım daire şeklinde Curve daha oluşturup saç Curve’lerine hacim kılavuzu olması için kullanılabilir.

Üst menü > Create > Curve Tools > CV Curve Tool’u seçelim ve oluşturulacak saç tutamının 
kalınlığı kadar 4 Vertex noktasından oluşan yarım daire şeklinde bir Curve çizelim.

 

Curve’e hacim vermek için üst menü > Surface > Extrude seçeneğini kullanılabilir. Surface Ext-
rude Polygon Extrude’dan farklı olarak Curvelere hacim vermek için kullanılır.

İşlemi oluşturmak için çizdiğimiz Curvelerin seçim sıralaması önemlidir. İlk önce hacim verme 
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amaçlı çizdiğimiz “C” şeklindeki curve, daha sonra ise Shift’e basılı tutarak, saç olması için çizdi-
ğimiz kafada bulunan Curve seçilmelidir. Bu seçim sıralaması çok önemlidir.

 

Surface>Extrude seçimi yapıldıktan sonra oluşan model aşağıdaki gibi düzensiz şekilde oluşa-
bilir. Bunu engellemek için Surface > Extrude seçeneklerinin ayarlanması gerekmektedir.

Öncelikle en son çizilen yarım daire şeklindeki hacim verme amaçlı oluşturulan yerde bulunan 
Path’in Pivot noktasını merkezine taşıyalım.  Curve seçiliyken > Üst Menü> Modify > Center 
Pivot.

Seçenekler kutucuğundaki seçeneklerdeki;

	 Result Position = At Profile > At Path olarak,

	 Pivot= Closeset End Point > Component olarak değiştirelim.
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Sonuç aşağıdaki görseldeki gibi olacaktır:

Extrude uygulandıktan sonra artık kullanılan iki Curve Path birbiriyle bağlantılı hale gelmiş bu-
lunmaktadır. Örneğin “C” şeklinde hacim verme amaçlı oluşturduğumuz yerdeki Curve’ü Vertex 
noktalarından tutarak değiştirdiğimizde, Extrude ile oluşan saç modeli de değişmeye başlar.

Extrude ile oluşan modeli değiştirmek için ise modele sağ tıklayarak Control Vertex seçeneğini 
seçerek bitiş kısmını Scale Tool ile uç kısmını daraltarak ve kafa ile birleştiği alanı Rotate ile dön-
dürerek değişiklikler yapılabilir.

 

Extrude ile bir diğer Curve’e hacim verildiği zaman yapılan değişiklikler her iki saç tutamı mo-
delini de etkilemeye başlar. Bunu engellemek için ilk modellediğimiz saç tutamının History'sini 
silmek yeterli olacaktır. Böylece her yeni saç tutamına Curves kullanılarak farklı şekiller verilebilir.
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Modellemesi biten her saç tutamının History'sini silerek tüm Curveleri Extrude ederek mo-
dellemeye devam edelim.

İşlemi hızlandırmak için; önce yarım daire Curve sonra uzun saç Curve Path’i seçip “G” tuşuna 
basarsak son yapılan işlemi tekrarlayalım. Bu sayede en son yaptığımız Extrude işlemi hızlı şekil-
de tüm saç Curvelerine uygulanabilir.

Gerekli yerlerde History’si silinmiş modelleri kopyalayarak ta saç kısmını oluşturmaya devam 
edelim.

Sol kısmın saçlarının modellenmesi bittiğinde tüm modelleri seçip Delete History yapalım ve 
Curve Path çizgilerini silelim. Pathlerin tamamını seçmek sorun olabilir bu yüzden sadece path-
lerin gösterilmesi için çalışma alanının üzerinde bulunan Show sekmesinden > NONE seçeneğini 
seçelim. Daha sonra tekrar aynı listeden Show> Nurbs Curve seçeneğini seçerek Curve Path çizgi-
lerinin görünür olmasını sağlayalım ve hepsini silelim.

  

Bir diğer kolay seçme alternatifi ise üst bar menüde bulunan Selection Mask ikonları. sağa ok 
simgesine basarak gizli olan bu menüyü açalım. Daha sonra ikonlardan Polygon ikonunu kapata-
lım. Bu sayede Select oku Polygon'ları seçmemeye başlayacaktır. Bu sayede Curveler kolaylıkla 
seçilebilir.



63

Curveleri sildikten sonra saç tutam model Polygon'larının tamamını seçip Group yapalım. Yapı-
lan grubun odak noktasını sıfır noktasına getirip Duplicate ile saçların koyasını oluşturalım. Oluştu-
rulan kopyanın Scale değerinde gerekli koordinata -1 değeri vererek simetrik olmasını sağlayalım.

 

Kopyalama işlemi yapıldıktan sonra iki tarafın da aynı olmasını istemiyor ve doğal bir görünüm 
isteniyorsa, yeni eklenen alandaki saç tutamlarının yerleri ve Vertexleri değiştirilerek çeşitlilik ka-
tılabilir.

Saç modellerinin yerleştirilmesi bittikten sonra Nurbs olarak oluşturduğumuz parçaları UV 
haritasını çıkartmak için Polygon'a çevirmek gerekmektedir. 

Nurbs şekilleri Polygon'a Çevirmek İçin: saç tutamı Nurbs model seçili iken > üst menü > Sur-
face > Rebuıld seçenekleri kutucuğuna tıklayarak seçenek menüsünü açalım. Açılan menüde sol 
üstte Edit Reset Settings seçeneği ile Default ayarlara geri dönelim. Bu ayarlar Polygon'a dönüş-
türmek için yeterli olacaktır. Daha sonra Apply tuşuna basarak uygulatalım. 

 

Number Of Spans U ve Number Of Spans V bölümlerine Polygon'u kaç Polygon yüzeye bölmek 
istiyorsak o rakam girilebilir. U ve V kısımları yüzeyin hangi alanlarına geldiği denenerek buluna-
bilir.

Rebuild Surface Options menüsünün en altında bulunan Output Geometry seçeneğindeki 
Polygon seçeneğini ve Type kısmından da Quads seçeneğini seçelim. Tesselation Method kıs-
mından ise Control Points seçeneğini seçelim. Bu sayede sistem kare Polygon'lar oluşturacaktır.
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Oluşan Polygonal modelin Normal’leri ters şekilde oluşmuş ise modeli seçip üst menüden > 
Mesh Display > Reverse diyerek çevirelim.

Polygon'larda bir bozulma olmuyor ise diğer saç tutamı modellerini de aynı yöntemle Polygon 
moduna çevirelim. Her saç modelini aynı anda seçerek bu işlem tamamlanabilir. 

Öncelikle saç modellerinin tamamını seçip Delete History yapmayı unutmamamız gerekmek-
tedir.

Rebuild Surface yapıp Polygon'a çevirlildikten sonra Nurbs modeller sahnede durmaya devam 
eder. Bu yüzden Polygon kopyalarını sahnede tutarken nurbs modelleri silmemiz gerekmektedir.

Aynı koordinatta bulunan ve içiçe geçmiş bu iki Polygon ve Nurbs objeden sadece Nurbs’ü 
seçebilmek için  yine Select Mask ikon menüsünden faydalanılabilir.

Polygon ikonuna Sağ Mouse Buton ile tıkladğımızda açılan seçeneklerden Poly Surfaces seçe-
neğini kaldırırsak seçim yaparken Polygon'ların seçilmesi engellenmiş olur.

Bu şekildeyken saç modelinin tamamını seçtiğimiz zaman sadece Nurbs Surface olan modeller 
seçilmiş olur.

Nurbs modellerin tamamı seçiliyken DEL tuşu ile silelim ve sadece Polygon Modeller’in kalma-
sını sağlayalım.

Tekrar Select Mask alanından Polygon seçinin açalım. tüm yüzeylerinde Normalleri ters olan 
modelleri seçip > üst menü > Mesh Display > Reverse seçeneği ile yüzeylerini çevirelim.
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KAŞLARI MODELLEME 
Kaşların modelini oluşturmak için ise bir Box Polygon modelinden yola çıkarak 3/2 Polygon 

Segmentinde model oluşturalım. 

İlgili yere ekleyelim. Modelin Duplicate ile kopyasını oluşturup scale alanına eksi (-) değer gi-
rerek simetrisini oluşturalım. Mesh Smooth 1 değerinde ekleyelim ve yumuşak görünüm elde 
edelim.

Karakteri Riglerken ya da animasyon sırasında hatalara neden olmaması için eksi (-) değer veri-
len modelleri üst menü > Modıfy > Freeze Transformation yaparak koordinat, Scale ve Transform 
değerlerini sıfırlayalım.

SAÇ DİBİ ALANI OLUŞTURMA
Karakterin kafasındaki saçların dip kısımlarındaki alanı ayrı bir model olarak oluşturulacaktır. 

Cildin görünmesini engellemek için, gövde modelinde kafa kısmındaki saç alanını Polygon olarak 
seçelim.

Polygon'lar seçilyiken üst menü> Edit Mesh > Duplicate ile Polygon Facelerin kopyasını oluştu-
ralım ve yüzeyden dışarı doğru biraz yükseltelim.
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Oluşturulan saç dibi modelinin uç kısımlarını Soft Selection aktifken Vertexlerden tutarak kafa 
modelinin içerisine doğru itelim. Bu sayede aradaki boşluk görünmemiş olacak fakat geri kalan 
kısım saç diplerinin altında görünecek. Modelin Daha belirgin olması için Mouse Sağ Buton ile 
Assign Favourite Material > Lambert diyerek materyal ekleyelim. Materyalin rengini sağ kısımda 
bulunan Attrıbute Editorden renkli yapalım.

Hypershade penceresini açalım üst kısımda bulunan materyal bölümünden daha önce oluştu-
rulan saç materyalini tüm saç parçalarına ve kaş modellerine atayıp kontrol edelim.

 

Ağız içindeki dişler diş etleri ve dil modellerini 3 parça olacak şekilde Combine ile birleştirelim. 
Üst damak ve dişleri seçerek üst menü > Mesh > Combine edelim.

Dil ve dişler seçiliyken üst menü > Mesh>Smooth ile Polygon'ları yumuşatalım. Modellerin 
hepsini seçip üst menü > Edit > Delete By Type > Delete History işlemini yapalım.

Daha sonra da hepsi seçili haldeyken üst menü > Modıfy > Freeze  Transformation ile değer-
lerini sıfırlayalım.

Karakter modelleme kısmının sonuna geldik. Çalışma alanımızın solunda bulunan ve sahnede 
bulunan objelerin listelendiği Outliner alanını da gereksiz objelerde temizleyerek modelleme ça-
lışmasını bitirelim.

Outliner alanında sol tarafında artı (+) işaret olmayan grup simgeleri içi boş grup anlamına gel-
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mektedir. Bu boş grupları kontrol ederek listeden silelim.

Bazı durumlarda içi dolu olan gruplarda da bir obje dışında grup listesindeki diğer objeler boş 
olabilmektedir. Böyle durumlarda da Outliner listesinden grubu seçtikten sonra çalışma alanında 
hangi modellerin Highlight (yeşil olarak seçili görünme) olduğuna bakılmalıdır.  Grup ikonunun 
yanındaki artı (+) simgesine basarak tüm objeleri tek tek seçip Highlight olmayan yani içi boş olan 
isimleri listeden silelim.

Bir objeyi gruptan ayırmak için üst menü > Edit > Unparent seçeneğini seçelim.

Bazı durumlarda da örnekteki gibi dolu görünen ama içinde obje bulundurmayan gruplar ola-
bilir. Bu grupları da silerek Outliner alanını temizleyelim.

Exturded Surface olarak isimlendirilen modeller ise saç demetlerinin her biridir. Bunları şu anda 
Group seçeneği ile grup yaparak saklayalım. Çünkü ilerleyen bölümlerde UV hartası çıkarırken ayrı 
parçalar halinde olmaları işimizi kolaylaştıracaktır. 

Grup dışında kalan bazı modelleri gruba taşımak için objeyi seçerken  Orta Mouse Tekerlek 
Butonu’na basılı tutarak ilgili grubun üzerine sürükleyip bırakalım.

Bu şekilde Outliner listesindeki tüm Grupları temizleyip yeninden isimlendirelim.
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ÜNİTE 3
UV MAP OLUŞTURMA

UV MAP TEMELLERİ
Üç boyutlu bir objenin yüzeyinin iki boyutlu olarak bir düzleme yansıtılmasına UV Mapping 

denmektedir. Bu sayede model üzerine dilediğimiz kaplama çizim ve materyalleri Polygon'ların 
yüzey çakışması olmadan, kaplamaları kaydırmadan ve sündürmeden yapabilmemiz mümkün ol-
maktadır.

U ve V harfi 2D yüzeydeki koordinatları temsil etmektedir. 

Maya UV haritası oluşturmak için UV Editor isimli aracını kullanmaktadır. Ulaşmak için üst 
menü > UV > UV Editor seçilmelidir.

 

UV Editor açıldığı zaman iki boyutlu bir çalışma alanı belirecektir. Çalışma alanında seçili olan 
3D objelerin iki boyutlu mesh krokileri üzerinde bu alan üzerinde çalışılabilmektedir. Çalışma 
alanında objenin görünmesi için mutlaka 3D çalışma alanında da seçili olması gerekmektedir.

Bu alanda hareket etmek için; 

Alt+ Mouse Orta Tekerlek Butonu ile Pan (bakış açısını kaydırma)

Alt+Sağ Mouse Buton ile zoom in ve zoom out (yakınlaşma ve uzaklaşma) kullanılabilir.

UV Editor’ün tam ortasında kalan 0 noktasında bulunan  ve "01 alanı" olarak bilinen alan, UV 
haritalarımızı oluşturduktan sonra haritaların saklanması gereken alandır.

UV Editor alanının sağ tarafında bulunan alanda UV Tool Kit (UV araçları) bulunmaktadır. Bu 
alandan, seçili UV’yi açma kesme birleştirme gibi işlemlerin araçlarına hızlı bir şekilde ulaşılabilir.
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UV Mapping mantığını anlamak için sahneye bir Cube modeli ekleyelim. Daha sonra objeyi 
seçip UV Editor’ü açalım. UV Toolkit’in en üstünde bulunan alandaki seçeneklerden Polygon’u 
seçelim. UV Editor alanında yüzeylerin seçilebildiği görülebilir. Seçilen her yüzey gerçek zamanlı 
olarak sahnedeki modelde de seçilmektedir. Bu özellik sahnedeki modelde seçilen yüzeylerin UV 
haritasında da gösterilmesi şeklinde kullanılabilir. Kolaylık sağlayan bu yöntemle şekil üzerinden 
hangi alanların seçilip kesilerek harita oluşturulacağı belirlenebilir.

Çalışma mantığı olarak üstteki örnekteki haritada 2 numaralı alana eklenecek her türlü kap-
lama direkt olarak 3 numarada görünen üç boyutlu modelin yüzeyinde belirecektir. Kaplama 
oluşturma işlemi için ise sıklıkla direkt model ve harita üzerinden boyama yapılabilen Substance 
Painter, Marı ya da Photoshop programları kullanılmaktadır.

Yukarıdaki örnekteki Cube modeli üzerinde herhangi bir modelleme işlemi yapılmadığı için uv 
haritasında otomatik olarak açılmış şekilde görülebilmektedir. Fakat modelleme yapılan 3D obje-
lerde UV haritaları daha karmaşık ve üst üste binmiş Polygon yüzeyler şeklinde görünmektedir. 
Böyle durumlarda Unfold işlemi yapılıp UV haritası bir düzlem haline getirilmelidir.

Aşağıdaki örnekte 3D model üzerinde yapılan değişikliğin, sağ tarafta bulunan UV Editor ala-
nında oluşmadığı görünmektedir.

Sağ alanda bulunan UV Toolkit bölümündeki Unfold kısmındaki Unfold seçeneği ile basit mo-
dellerin UV haritasını düzlem haline getirme ve yapılan değişikliğin UV editörde görünür hale 
gelmesi  işlemi gerçekleştirilebilir.
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UV Map oluştururken kullanacağımız UV Editor’deki bir diğer özellik ise; Checker Map özelli-
ğidir. Bu özellik kısaca UV haritasına siyah beyaz karelerden oluşan bir kaplama atar ve bize 3D 
modeldeki yüzeylere kaplama yapıldığında hangi Polygon'ların esneyip sündüğünü ve bozulduğu-
nu, hangi yüzeylerin düzgün durumda olduğunu gösterir.

Aşağıdaki örnekte model üzerinde boylamasına bir değişiklik yapıldığı ve kaplamaların sünme 
yaparak bozulduğu görünmektedir. Fakat Unfold işlemi yapılmadığı için UV Map üzerinde henüz 
değişiklik görünmemektedir.
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Model üzerinde Edge, Polygon ekleme çıkarma esnetme gibi herhangi bir değişiklik yapıldı-
ğında model kaplama programlarına gönderilmeden önce mutlaka UV haritası oluşturulması, 
oluşturuldu ise de güncellenmesi gerekmektedir. Aşağıdaki resimde Unfold işlemi uygulandıktan 
sonra UV Map’in değişimini görmekteyiz. Bu örnekte Checker Map kaplamalarda bozulma  görül-
memektedir.

UV Editor alanında Checker Map kaplaması aktifken daha rahat çalışmak için Checker Map 

açma butonunun hemen yanındaki butonu  kapatmamız gerekmektedir. Bu sayede kaplama 
sadece 3D modelde görünür ama UV editörde görünmez.

Unfold seçeneğine ayrıca UV Editor penceresindeki Modify > Unfold seçeneğinden de ulaşı-
labilir. 

Detaylı bir modelde eğer UV Map yoksa o modele materyal atayabiliriz fakat dokulu bir kap-
lama yapıldığında bozulmalar oluşacaktır. Mutlaka bir UV haritası oluşturmak gerekmektedir.

UV MAP OLUŞTURMAK için; 

Üzernde hiç UV Map bulundurmayan bir 3D modele Map yaratmak için Sağ tarafta bulunan UV 
Toolkit alanından > Create > Automatic seçerek otomatik bir şekilde UV Map oluşturulabilir. Bazı 
karmaşık modellerde otomatik UV oluşturma seçeneği yeterli gelmeyebilir. Fakat basit geometrik 
modellerde bu yöntem kullanılabilir.
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Yukarıdaki görselde Automatic Map oluşturma özelliği 6 farklı açıdan bir yüzey tarama alanı 
açarak UV Editor alanına modelimizin UV Map’ini oluşturduğu görünmektedir.

Oluşturulan her yüzey birbirinden bağımsız şekilde oluşturulmuştur. Bazı durumlarda  bu ba-
ğımsız Polygon yüzeylerin birbirleriyle birleştirilmesi gerekebilir. Bunun için UV Editor alanınday-
ken Edge Mode’a geçilmeli ve birleştirilmek istenen kenarlar (Edge) seçilmelidir.

Bir Edge seçildiği zaman hemen onun birleşeceği kenar otomatik olarak aydınlanarak kendisini 
gösterecektir.

UV Map’in seçili iki Edge’ini UV Editor’de birleştirmek için Editor üst menüdeki Cut And Sew> 
Move And Sew seçeneklerini kullanılabilir. Bu sayede seçilen Edgeler birbirlerinin yanına taşına-
rak birleştirilmiş yani dikilmiş olur. Bazı durumlarda sadece Edgeleri birleştirmek ve bağlı olduğu 
Polygon yüzeyi hareket ettirmemek gerekebilir. Böyle durumlarda da sadece  Sew özeliğini kulla-
narak birleştirme yapılabilir.
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Tüm parçalar birleştirildikten sonra Checker Texture kaplamasına bakıldığında zaman esneme-
ler ve bozulmalar görünebilir. Bu bozulmaları engellemek için, tüm Edge’leri birleştirdikten son-
ra Unfold işleminin uygulanması gerekir. Bu sayede Texture'daki esnemeler düzelecek ve Checker 
Box kareleri düzgün bir kare formuna gelecektir.

Özetle bir UV MAP oluşturmak için;

1- CREATE ile UV Map oluşturmalıyız.

2- SEW ile gerekli UV Map parçalarını Editor’de birleştirmeliyiz.

3- UNFOLD ile Checkerbox Texture'ların kare olmasını sağlamalıyız.

GÖMLEK MODELİNİN UVSİNİ OLUŞTURMA
Daha kolay bir çalışma yapabilmek için Maya’nın modelleme için oluşturulmuş arayüzünü Uv 

Mappıng için olan ara yüzüne çevirebiliriz. Sağ üst köşede bulunan Workspace alanında Maya 
Classıc yazan yazıya tıkladığımız zaman açılan menüden UV Editing seçeneğini seçerek arayüzü 
değiştirebiliriz.

 3D modelleme alanı solda ve UV Edit menüsü sağda olacak şekilde çalışma alanımız yeniden 
düzenlenecektir.

Modellenen gömlek modeli seçildiği zaman UV Editor alanında karmaşık bir şekilde Map’in 
oluştuğu görülebilir. Bu haritayı silerek baştan yeni harita oluşturulması gerekmektedir. Uygun 
olmayan harita UV Editor alanındaki menüden sol üstteki Edit> Delete seçeneği ile silinebilir.
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Eski UV Map silindikten sonra UV Editor alanından >Create > Planar seçeneğine Mouse’un Sağ 
Butonu ile tıklayalım. Mouse Sol Buton ile tıkladığımızda  farklı bir açı ile, Sağ Buton ile tıkladığı-
mızda karşıdan görünüm olacak şekilde UV Map oluşturur. Bu özellik sadece Planar uv oluştur-
ma yönteminde geçerlidir.

Oluşturulan UV Map şu anda birleşik olduğu için Texture kaplandığı zaman kaplamada esneme 
ve bozulmalar oluşacaktır. Bu yüzden uygun kenarlardan keserek parçalara ayrılması gerekmek-
tedir.

Bu durumu bir hediye kutusu paketleme kağıdını soyup masaya düz bir şekilde sermek gibi 
de düşünülebilir. Masaya serilen kağıdın üzerine istenilen resmi çizip daha sonra tekrar hediye 
kutusuna sararak desenli bir hediye paketi elde etmiş oluruz. Aynı mantıkla düşünecek olursak UV 
haritamızın da tamamen düzlem haline getirilmesi gerekmektedir.

UV Editor’deki Checker Map seçeneğini aktif hale getirdiğimizde gömlek üzerinde bazı kapla-
maların sündüğünü görebiliriz. Bu da haritanın henüz düzlem haline getirmediğinde ne olacağını 
bize gösteren bir örnektir.

UV Map’i kesmek için Cut And Sew > Auto Seams seçeneği ile otomatik olarak Map’in kesile-
cek alanlarını belirlemeyebiliriz. Alttaki resimde turuncu olarak çizili olan Edge alanları modelin 
kesip ayrılacağı el ile seçilmiş kenarlarını göstermektedir.
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Bazı durumlarda Auto Seams özelliği gerekli tüm Edge'leri seçemez. Böyle durumlarda manuel 
olarak Edge modundayken model üzerinden kesilecek konturleri seçmek gerekmektedir. Kendi 
seçtiğimiz turuncu olarak beliren Edge'leri kesmek için UV Edit alanındaki > Cut and Sew > Cut 
seçeneği ile seçili alandaki Edge'leri keselim.

Ortadan ikiye kesilen Gömlek UV haritası şu anda üst üste iki ayrı parçadan oluşmaktadır. 
Sağlıklı bir kaplama yapabilmek için UV haritalarında hiçbir poligonun üst üste binmemesi gerek-
mektedir. Bu yüzden  en üstte bulunan parça diğer parçanın üzerinden alınmalıdır. 

UV Editor alanında üsttek parçaya sağ tıklayıp > UV Shell seçeneğini seçtikten sonra üstte du-
ran parçayı seçip “W” ile Move Tool’u açıp yana doğru kaydırarak alanı düzenleyelim.

Ayrılan parçalar önceden de gördüğü şekilde Unfold edilmelidir. Bu sayede her Polygon'un 
kendi üzerinde bulunan Texture esnetme ve deforme etme sorunlarını gidermiş oluruz. Her iki 
parçayı da seçelim ve Editor menü > Modıfy > Unfold yapalım.

UV Editor'deki Checker Texture modu açıldığı zaman gömlekte yanlarda olan kaplama bozul-
ma ve esnemelerinin kaybolduğu görülebilir.

Bazı durumlarda oluşturulan UV Map’lerin kontur kenarlarını düz bir şekilde hizalamak gere-
kebilir. Fakat otomatik olarak Unfold işlemi yaptığımızda bu kenarları düz tutmak zolaşır. Böyle 



76

durumlarda belirli Vertex'leri manuel olarak seçip Align işlemi, ardından da Pinning işlemi ile 
sabitledikten sonra Unfold işlemi uygulanabilir.

Öncelikle UV Selection moda geçelim. Align ile hizalamak istediğimiz Vertex'leri seçelim ve UV 
Toolkit alanındaki Align menüsünden Align Left'i seçelim. Bu işlemi Alt ve Sağ Vertexler için de 
tekrarlayalım. Align Left ve Align Right.

Align işlemlerini yaptıktan sonra tekrar Unfold yapmak gerekmektedir. Çünkü Align işlemlerin-
den sonra UV Map’deki Polygon'larda esneme oluşmuş ve Texture'larda kayma meydana gelmiş 
olabilir.  Fakat Unfold işlemi Pinning yapmadan yapılırsa Vertex'ler tekrar bozularak başlanan nok-
taya dönülebilir.

Bu sebeple Align işlemi yaptığımız tüm Vertex'leri seçelim.

Sağdaki UV Toolkit alanında > Pinning > Pin diyerek bu Vertex'leri sabitleyelim. Bu sayede Un-
fold edildiklerinde kayma yapmayacaktır. Vertex'lerin tamamını seçelim ve Unfold işemi yapalım. 
Diğer UV harita parçasını da aynı şekilde düzenleyelim.
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PIN işlemi yapıldıktan sonra UV Map'leri taşımak ya da Scale ile küçültmek istersek hareket 
etmezler. Hareket etmeleri için PIN’lerini çözmemiz gerekmektedir. Bunun için Pinning menüsün-
deki Unpin seçeneğini seçmemiz yeterli olacaktır.

Bazı modellerde Pinning yapıldığında sabit kalan Vertex'ler ile Map içindeki diğer Vertexler 
uyumlu bir şekilde hareket etmeyebilirler. Bu da sabitlenen (PIN yapılan) Vertex noktalarında 
Textureda bozulmalara neden olabilir. 

Bunu engellemek için ise UV Map içerisindeki bozulma yaratan alana yakın olan tüm Vertex'ler 
UV Selection seçeneği ile UV Editor (alanında en alt çizgideki sınır vertex'leri hariç) seçilmeli. 
Shift+Sağ Mouse Buton > Unfold> Unfold Along V seçeneğini ile düzeltme işlemi yapılmalıdır. Bu 
sayede ilgili mapteki kaplamalar düzelir.
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Her iki UV Map parçasında da aynı uygulama yapıldıktan sonra Texture'lardaki kaymalar düze-
lecektir.

Daha önce bahsettiğimiz gibi oluşturulan UV haritalarının belirli programlarda kaplamasının 
yapılabilmesi için model Map'inin UV Editor alanındaki Grid bölümünün 0-1 noktasında bulunma-
sı gerekmektedir. Bu alanın dışında kalan  UV Mapler bazı programlar tarafından görülmemekte 
ya da eksik tanımlanmaktadır. 

Bu sebepten dolayı Align ve Unfold ettiğimiz ve daha sonra Unpin yaptığımız Maplerin tüm 
Polygon ya da Vertex'lerını seçip > hızlıca 0-1 alanına taşımak için UV Toolkıt> Arrange And La-
yout > Layout seçeneğini seçmemiz yeterli olacaktır. Bu sayede her iki parça da otomatik olarak 
taşınarak 0-1 alanına Scale ile küçültülerek hizalanır. Bu şekilde Gömlek modelinin UV haritası 
çıkarılmış olunur.

PANTOLON UV MAP OLUŞTURMA
UV Map oluştururken bir önceki planer seçeneği ile Map oluşturma tekniği burada da kullanı-

labilir. Fakat bazı durumlarda modellerin genel şekileri itibari ile onlara yakın hazır Map seçenek-
lerini kullanmak daha hızlı ve doğru sonuçlar almaya yarar.

Pantolon modelinde UV Editor > Create > Cylindirical seçeneğini kullanarak UV map oluştura-
lım.

Map kaba bir şekilde oluşturulacaktır. Checker Texture'ı aktive ederek kontrol edilebilir. Seams 
diye adlandırılan ve 3D Modeli Map oluşturmak için kesen beyaz çizgi şeklindeki kesme alanlarını 
kontrol edelim.
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Örnekte de görüldüğü üzere sadece tek alanda pantolonu ortadan kesme çizgisi oluşmuş ve o 
da yarıda kalmış durumdadır. Ayrıca modeli iki parçaya düzlem şeklinde ayırmaya yarayacak hiç 
bir beyaz Seams çizgisi bulunmamaktadır. 

Böyle durumlarda manuel olarak Edge'ler seçilerek kesme çizgisi oluşturulabilir.

Ya da daha farklı bir yöntem olan ve direkt olarak 3D alandaki model üzerinde çalışılmasına 
imkan veren; üst menü > UV > 3D Cut And Sew UV Tool’u kullanılabilir. 

Model seçili iken bu aracı aktifleştirdiğimizde 3D modelin renginin değiştiğini görebiliriz. 3D 
model üzerinden istenilen edge loop’lar Edge modundayken çift tıklayarak seçildiği an kesim 
işlemi yapılacaktır.

UV Editor alanına gelip Unfold işlemini gerçekleştirelim. Tam açılmayan bir Map ile karşılaşırsak 
gerekli yerlere Edge Cut atarak keselim ve tekrar deneyelim.

Üstteki görsellerde solda bozuk bir UV Map, sağda ise doğru oluşturulmuş bir UV Map görün-
mektedir.

Oluşturulan UV Map’i istendiği taktirde iki parçaya bölünerek de çalışılabilir.
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UV Editordeyken UV Selection modda  vertexler seçili iken > Unfold > Unfold seçenek-
leri ile Textureların bozulmasını düzeltilebilir.

Gömlek modelinde yaptığımız gibi, kenar ve uç kısımlara denk gelen Vertexleri Align ile düz 
bir şekilde hizalayarak ve PIN ile sabitleyip Unfold işlemini iç vertexlere uygulayarak işlemimize 
devam edelim.

 

Checker Texture’da bozulmalar olur ise üst ve alt Alignlanmış Vertexler hariç tüm Vertexler 
seçili iken UNFOLD U seçeneği ile kaplamadaki esnemeler düzeltilebilir.

İşlemler bittikten sonra Arrange and Layout alanından Layout butonuna basarak pantolon UV 
haritasının da 0-1 alanına sığdırılmasını sağlayalım.

Birden Fazla 3D modeli tek bir UV 0-1 alanına ekleyebiliriz. Bunun için modelleme alanından 
her iki modelin de seçilmesi gerekmektedir. 

Her iki model de seçildiği zaman UV Haritalarının üst üste bindiği gözlemlenebilir. Bu sorunu 
gidermek için her iki modelin UV haritaları UV Editorde seçiliyken (Face ya da Vertex moddayken) 
Arange and Layout kısmından > Layout yaparak tüm UV haritalarını aynı alana sığdırılabilir. Bu 
işlem tamamen otomatik bir şekilde yapıldığı için bazı durumlarda farklı modellerin UV Haritaları 
arasında çözünürlük farklılıkları oluşabilmektedir. Bunu anlamak için Checker Map Texture’ı aktif 
hale getirip modeller arasındaki kaplamalardaki kare büyüklükleri kıyaslanabilir.
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Yukarıdaki örnekte Küçük UV haritasına sahip olan pantolonun büyük karelerden oluşan dü-
şük çözünürlükte UV kaplamasına sahip olduğu görünmektedir.  Büyük kaplama haritasına sahip 
olan gömlek ise daha ufak karalerden oluşan, yani daha yüksek çözünürlükte ve net bir kaplamaya 
sahip olduğu görünmektedir.

Bu gibi durumlarda her UV haritasını Scale ile küçültüp büyüterek denkleştirmeye çalışmak 
çok zaman alan ve çoğu zaman da doğru sonuç vermeyen bir yöntemdir. Bu yüzden tüm UV ha-
ritalarının aynı çözünürlükte olmasını sağlamak için; uygun gördüğümüz bir UV Haritasını Editor 
alanından seçelim, sağdaki UV Toolkıt alanından > Transform > Texel Density kısmından > GET 
butonuna basarak seçmiş olduğumuz haritanın pixel çözünürlüğünü hafızaya kaydedelim. Daha 
sonra eşit çözünürlüğe getirmek istediğimiz haritaların tamamını seçelim ve SET butonuna basa-
rak hafızaya kaydedilen çözünürlük bilgisini son seçilen haritalara verelim.

Sol taraftaki 3D çalışma alanında da göründüğü üzere Texture kare büyüklükleri eşit durumda-
dır. Bu şekilde diğer modeller de ayarlanarak  karakterin bölümleri arası çözünürlük farkı oluşması 
engellenebilir.

Eşitlenen UV Haritalarını Scale ve Move araçlarını kullanarak mutlaka 0-1 karesi tabir edilen 
alanın içerisinde en verimli şekilde yerleştirerek tutulması gerekmektedir.  
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GÖVDE TEXTURE MAP OLUŞTURMA
KAFA UV MAP

Gövde modelleri genel olarak Pantolon ve gömlek modelleri kadar basit ve detaysız modeller 
olmadıkları için  hazır olarak  modelde bulunan UV haritası üzerinden devam etmek yerine, olan 
haritayı silip her gövde parçasını ayrı şekilde yeniden haritalandırmak daha doğru olacaktır.

Gövde modelini seçelim ve Isolate seçeneği ile diğer model parçalarından izole ederek daha 
kolay çalışılır hale getrelim. Kafa bölgesindeki tüm Polygon'ları (FACE) UV Editor alanından face 
mode aktifken seçili hale getirelim.

 

UV Editor alanından > Create > Spherical seçeneğini kafa modeli küreye şekil olarak yakın 
olduğu için seçerek kafa bölgesinin haritasını oluşturalım. Daha sonra UV Selection Tool seçiliy-
ken UV Editor alanındaki tüm Vertexleri seçerek > Unfold > Unfold seçerek oluşturduğumuz kafa 
Map’ini düzlem haline getirelim.

Oluşturulan Map’in Edge'lerinde düzensizlikler varsa Edge modundayken kenar Edgeler seçilip 
Sew komutu ile birleştirilebilir.
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Sew işleminden sonra tekrar UV Vertexleri seçilip Unfold işlemi yapılmalıdır. 

UV haritasına yakından bakıldığı zaman ağız içi, göz çukurları ve burun kısımlarının Polygon'la-
rının sıkışık ve bazı yerlerde de üst üste binmiş olduğu görülebilir.

Bu sebeple kapalı kalan alanları da Cut Tool ile keserek ayrı UV Haritaları haline getirmek uygu-
lama açısından daha kolay olacaktır.

3D çalışma alanındaki görüş açısını kafanın iç kısmına girerek, ağız içi modelinin başlangıç alanı 
rahat görünecek şekilde ayarlayalım. Daha sonra Edge modunda ağız içi modelini dudak kısmıyla 
birleşen yerden tam bir Edge Loop olacak şekilde seçip UV Editor alanındaki Cut And Sew > Cut 
seçeneğiyle keselim.

Kesilen kafa ve ağız içi UV Maplerini daha rahat görebilmek için UV Editor alanından UV Shell 
Selection Tool seçerek kafa UV'sini Move aracı ile biraz yana çekelim ve iki haritayı birbirinden 
ayıralım.

Ağız içi UV Haritası küre bir model olduğu için tam olarak düzlem haline getirilemeyebilir. Bu 
yüzden ağız içi modelinin sağ ve sol taraflarındaki Edge'lerin belirli bir bölümünü seçerek Cut işle-
mi ile kesilmesi gerekmektedir. Bu sayede Unfold işlemi yapıldığı zaman tam bir düz UV Map halini 
alacaktır ve Texture'larda esneme ve bozulma oluşmayacaktır.

Ağız içi alanını kafa modelinden keserek aldığımız için Kafa modelini tekrar Unfold yaparak 
Vertexleri şu anki Vertex sayısına ve koordinatlarına göre düzenlemek gerekir.



84

UV Editor alanında üst simgelerdeki UV Distortions butonu , UV Map üzerinde esneme 
yapan ve bozulan ya da bozulmaya yatkın olan alanları kırmızı renk koduyla gösterir. Mavi ve 
açık mavi olan alanlar ise Texture'larda sıkıntı olmayan alanları temsil eder. Aşağıdaki örneğe 
bakıldığında kulaklar ve göz içleri alanlarında kırmızılıklar görünmektedir. Bunu gidermek için ise 
kulak alanlarını Edge modunda UV haritasından ayrılması ve Unfold işleminin uygulanması ge-
rekmektedir. Unfold işlemi UV Haritalardan her Cut işlemi ile  parça ayırdığımızda hem ayrılan 
parçaya hem  de ayırdığımız parçaya uygulanmalıdır.

Kafa kısmındaki diğer parçalar isteğe göre bölünüp ayrı Map'ler halinde oluşturulabilir. Fakat  
bu çalışmadaki model stilize bir karakter olduğu ve kaplamasını da gerçekçi olmayacağı için bu şu 
ana kadar yapılan işlemler yeterli olacaktır. 

GÖVDE UV MAP OLUŞTURMA
İnsan vücudu gibi anatomik modellerin UV Haritasını oluştururken organik ve girintili çıkıntılı 

diye adlandıracağımız alanların fazla olmasından dolayı, modeli farklı parçalar halinde harita-
landırmak çalışma kolaylığı sağlayacaktır. Bu sebeple gövdenin diğer kısmını kollar ve bacaklar 
olmadan Torso şeklinde haritalandırılabilir.

Vücudun kafa kısmındaki UV Map oluşturulan alanı seçmemeye dikkat ederek gövdeden Pol-
ygon'ları seçelim.

 

UV Editor alanından > Create > Planar seçeneği ile düzlem olarak Map'i oluşturalım. Gövde 
haritası tam karşıdan görünecek şekilde olmalıdır. Eğer tam karşıdan UV Haritası oluşmuyorsa 
Mouse sağ butonuna tıklayarak Planar düğmesine basılabilir. 
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Oluşan Torso UV Haritasının Unfold işlemi sağ ve sol yanından kesim yeri oluşturduktan sonra 
yapılabilir. Gövdenin sağ ve sol kısımlarından da Edge modundayken kesim yerleri oluşturup Cut 
seçeneği ile keselim. UV Shell Sellection moduyla gövdenin tek UV parçasını yana çekelim ve her 
ikisine de Unfold işlemi uygulayalım

Symmetry Tool açık durumdayken kolların bileklere kadar olan kısmını Polygon modu aktif-
ken seçelim. Daha sonra Create > Planar butonuna Sağ Mouse Butonu ile tıklayarak UV Map 
oluşturalım. Kolların alt kısmından da Edge modunda kesim yeri seçip Cut ile keselim ve tüm kol 
Vertexleri seçiliyken Unfold yapalım ve düzlem haline getirelim.

 

Bu şekilde kolların UV Haritası da hazırlanmış olur.

EL UV HARİTASI OLUŞTURMA
Öncelikle başparmak hariç diğer tüm parmakların Polygon'ları seçilip > UV Tools> Create> 

Planar ile 4 parmak da görünecek şekilde haritaları oluşturalım. 

Daha sonra parmakları sadece yarısına kadar dikine kesecek şekilde parmak aralarında kalacak 
şekilde Edge ler seçip Cut ile Seams oluşturalım. Üst menü UV > 3D Cut and Sew Uv Tool seçe-
neği ile Edge'leri seçip kesmek için, seçeneği akifleştirdikten sonra Edge'leri seçerken Mouse Sol 
Butona basılı tutup Edgeler üzerinde sürüklenmesi yeterli olacaktır. Her dokunulan Edge seçilip 
kesilecektir. Parmakların aralarında kalacak şekilde Edge'lerin seçilmesinin nedeni birleşme yer-
lerini mümkün olduğunca gizlemektir.
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Tüm Edgeleri oluşturduktan sonra UV Editor alanından UV Selection ile Vertex moduna geçip 
tüm parmak Vertexlerini seçelim.  UNFOLD işlemi uygulayalım. UNFOLD işleminden sonra 4 par-
mağın UV Map’i 4 parça olacak şekilde belirmiş olur. Bu parçaları üst üste binmeyecek şekilde 
yanyana dizelim.

Başparmak için de aynı şekilde Polygon modundayken parmağın tamamını seçelim. 

Gerekli durumlarda UV Edııtor > Create > Camera Based Map oluşturma modu da kullanılabi-
lir. Bu modun çalışma mantığı, 3D alanda Polygon olarak seçili olan parçanın UV Haritasını Editor 
alanında bakılan açıya göre oluşturmasıdır. Yani seçili olan parmağa tam karşı açıdan bakılıyorsa 
harita karşıdan görülecek şekilde oluşur. Çalışma alanından parmağa tam yandan bakılıyorsa UV 
haritası yandan görünecek şekilde oluşturulur. 

Planer ve Camera Based duruma göre sık kullanılan yöntemlerdir. Her iki yöntem de de sağlıklı 
sonuçlar elde edilebilir.

Başparmak modeline geri dönersek, Polygon'ları seçili iken Create > Planar ile Map oluştura-
lım. Daha sonra da düzlem haline getirebilmek için (Unfold) dikine yarım kenarını Edge modunda 
seçip Cut işlemi uygulayalım. UV Selection Tool ile Vertex'lerini seçelim > Unfold işlemini yapalım. 
Bu işlemlerin sonunda aşağıdaki görseldeki gibi 5 parmağın da bir parçadan oluşan UV Mapleri 
hazırlanmış olacaktır.
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Avuç içi kısmı için ise aynı diğer parçalara uyguladığımız işlemler gibi yapalım; Tüm Polygon'ları 
seçelim> Create > Planar veya Camera Based ile Map oluşturalım. Seçili alanı yarısına kadar, yani 
elin sadece sol tarafını Edge Modunda seçelim > Cut ile Edge'leri keselim. UV Selection> Unfold 
işlemi ile düzlem haline getirelim. İşlem sonunda 5 parmak ve bir adet avuç içi bölümünden olu-
şan toplam 6 parça el UV Haritası hazır durumda olacaktır.

UV Haritalarının çözünürlüklerinin eşit olması için uyguladığımız Texel Density işlemini kafa 
UV hartasından GET ile ölçü alarak SET ile el kaplamalarına uygulayalım UV Tool Kit > Transform 
> Texel Density > Kafa Uv Map’i Seç > Get> Geri Kalan Tüm UV Haritalarını Seç > Set. Bu sayede 
kafa ve el UV leri Checker Texture açıldığında eşit büyüklükte karelerle görünecektir. 

Diğer el için de aynı uygulamaları yaparak bacak ve ayak UV oluşturmaya geçelim.

BACAK VE AYAK UV MAP OLUŞTURMA
Sağ bacağı oluşturulan modele göre ayakkabı ya da çorap modeli alanına kadar Polygon mo-

dundayken seçelim ve Create>Planar ile UV oluşturalım. Planar butonuna sağ ve sol tıklayarak 
istenilen seçime ulaşılabileceğini unutmayalım.

Daha sonra en üst menü UV>3D Cut and Sew UV Tool ile bacağın iç kısmda kalan Edge'lerinden 
seçelim. UV Selection ile Vertex'leri seçelim > Unfold ile düzleştirelim. Bir önceki haritalandırma 
işlemleriyle aynı prosedürleri uygulayarak devam edelim. Bacak kısmının UV işleminden sonra 
aynı işlemleri çorap modelinde de uygulayalım. Bu işlemler sonunda 2 parça UV Haritası oluşmuş 
olur.
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Ayakkabı UV'si için ise ayakkabının tamamını Polygon modda seçip daha sonra perspektif ala-
nında ayakkabı modelinin üst kısmından bakarken Create>Camera Based ile Map’ini oluştura-
lım.

İşlemler sonrasında ayakkabı tabanı, ayakkabı yüzeyi çorap ve bacak parçalarından oluşan 4 
adet UV Haritası ile bacak kısmı da haritalandırılmış oldu. Texture çözünürlük eşitliğini sağlamak 
için Texel Density işlemini de kafa UV Haritasından ölçü alarak yaparak bacak ile işlemleri bitire-
lim. Aynı işlemleri diğer bacak için de uygulayalım. 

Bir diğer yöntem de UV Map uygulaması yapılmayan bacağı 3D çalışma alanında silmek ve UV 
haritası olan bacağı üst menü > Edit Mesh > Detach edip simetrik şekilde kopyalayıp her iki ba-
cağı da gövde ile Combine etme yöntemidir. Combine işleminden sonra da her iki bacağın gövde 
ile birleştiği Vertex'leri Merge edelim. Bu şekilde kopyalanan bacağın UV Editor alanında üst üste 
aynı Map’den 2 kopyası oluşacaktır. Üst üste olan Map'leri kaydırıp hizalayarak kullanalım.

Her iki şekilde de uygulamaları yaptıktan sonra elimizde olacak UV Haritaların tamamı aşağıda-
ki görseldeki gibi olmalıdır. 

Son olarak gövde modeline sağ tıklayıp basılı tutarak Assign Favourıte Materıal>Lambert di-
yerek gövdeye yeni bir materyal atayalım. Sağ taraftaki Attribute alanında da materyalin rengini 
dilediğimiz bir renk olarak belirleyelim. Materyal atamak 3D objelerin kaplama programları tara-
fından fark edilebilmesi ve sınıflandırılabilmesi için önemli bir işlemdir.
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GÖZ UV HARİTASI OLUŞTURMA
Göz küresinin saydam olan en dışarıda bulunan kısmının UV Haritasının oluşturulmasına gerek 

olmadığından dolayı o parçayı seçip Hide ile gizleyelim.

Göz küresinin çeride kalan kısmını seçip UV Editor > Create> Planar ile karşıdan görünecek 
şekilde UV Haritasını oluşturalım.

Gözün orta kısmının bir iki Polygon şeridi gerisinden geçecek şekilde Edge alanı seçip Cut ile 
keserek 2 parçadan oluşan bir Map oluşturalım. Haritaları UV Editor alanında yan yana yerleştire-
lim. Her iki parçayı da Unfold işlemi ile düzleştirelim. Checker Texture’ı aktive edip esneme olup 
olmadığını kontrol edelim.

Hide ile saklanan gözün saydam kısmını > Display > Show > Show Last Hidden diyerek görünür 
hale getirip tüm göz objelerini bir grup haline getirelim. Mayada çalışma kolaylığı ve çalışma hızı 
olması açısından birbirinin kopyası olan objelerin sadece bir tanesinin UV Haritası çıkarılıp kop-
yalanarak çoğaltılabilir. Burada da o tekniği kullanarak UV Haritası olmayan göz küresini silelim 
ve UV Haritasını oluşturduğumuz küreyi Duplicate ile çoğaltarak eskisinin yenine yerleştirelim. 
Daha önce bahsedilen -1 Scale kullanarak da yerleştirme uygulaması hızlıca yapılabilir. Her iki göz 
modelini de seçelim ve UV Editor alanında Arange and Layout kısmından Layout   seçeneği ile 
Kaplama Haritalarını 0-1 alanına otomatik olarak yerleştirelim. 

Unutmayalım ki üst üste gelen UV haritaları üzerinde yapılan kaplama ve çizimler kaplamaların 
tamamını etkileyeceği için istenmeyen durumlar meydana getirebilirler. Örneğin Bir modeli her-
hangi bir kaplama Editleme programında(Substance Painter, Mari) boyarken, modelin bir parça-
sını boyarken başka bir  tarafı da aynı anda boyanabilir. Böyle durumlar kaplama haritasında üst 
üste binen Polygon'lar olduğunu ve Layout işleminin başarısız olduğunu gösterir. Bu sebepten 
dolayı Layout işlemi (UV Haritaların 0-1 noktasına üst üste gelmeden çözünürlük dengesine uygun 
şekilde hizalanması ve yerleştirilmesi) kaplama haritası çıkarma işleminin önemli bir bölümüdür.



90

SAÇ TUTAMLARININ UV HARİTASINI OLUŞTURMA
Saç modellerinden bir parçasının modelini seçelim. UV Editor alanında modelin kendinde var 

olan dikdörtgen şeklinde bir UV görünecektir. Eğer yoksa da Create > Planar diyerek oluşturabili-
riz.

Oluşan UV Haritasına Unfold işlemi yapalım. Son olarak da Arrange and Layout > Layout işlemi 
yaparak 0-1 alanına yerleştirelim.

Bazı durumlarda saç tutamlarını oluştururken kullandığımız yönteme göre saç tutamlarının 
UV Haritaları sağlıklı sonuç vermeyebilir ve ekstra işleme ihtiyaç duyabilir. Böyle durumlarda UV 
Haritasının dikdörtgen kısmının konturlerini seçerek Align işlemi oluşturulur. Tüm konturler düz 
bir dikdörtgen oluşturacak şekilde hizalanır. Son olarak da düzgün dikdörtgen UV Harita konturleri 
dışında içeride kalan tüm Vertexler seçilip Unfold Along U ve Unfold Along V işlemi uygulanır. 
Son olarak da kontur çizgilerindeki Vertexler köşeler hariç seçilerek Unfold U ve V uygulanır. Bu 
sayede esneyen bozulan kaplama kalmaz.

Bu işlem saç tutamlarının tamamına uygulanır. Uygulanan saç tutamı modelleri seçiliyken La-
yout işlemi ile hepsi 0-1 alanında toplanır.

AĞIZ KISMI UV MAP OLUŞTURMA
Vücut modelini seçip Display > Hide > Hide Selection  ile gizleyelim (CTRL+H). 

Modelleme esnasında dişler ve diş etini kolay çalışma olması açısından birleştirmiştik. UV Ha-
rita oluşturmak için ise ayırmamız gerekmektedir. Bu işlem için üst damak ve dişler seçiliyken üst 
menü > Mesh > Seperate seçerek dişleri ve damağı birbirinden ayıralım.

Damağın orta kısmından itibaren dişlerin sağ ve sol kısımı simetrik olduğu için, göz mode-
linde kullanılan teknik burada da uygulanabilir. Yani dişlerin sadece sağ kısımda olanlarının UV 
Haritasını çıkarılıp daha sonra sol tarafa Duplicate ile çoğaltılabilir. Alt damakta da aynı işlemleri 
tekrarlayalım.
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Diş eti ile işleme başlayalım. Diş etini seçip İsolate ile izole edelim. Modelin kendisinin eski 
uvsini UV Editor > Edit > Delete ile silelim. UV Edit > Create Planar ile Map oluşturalım. Damak 
modelinin tam ortasından geçecek şekilde üst menü > UV > 3D Cut And Sew Uv Tool ile bir kesim  
çizgisi oluşturalım. Vertex modundayken Unfold işlemi uygulayalım.

Arrange And Layout > Layout seçeneği ile Layout uygulayalım. Transform > Texel Density işle-
mi ile iki UV Haritasını da eşitleyelim. 

Aynı işlemi alt diş eti modellemesi için de uygulayarak UV Haritasını oluşturalım.

Dişlerin UV Map’ini oluşturmak için ise;

Alt ve üst damaktaki sağ kısımdaki tüm dişleri seçelim ve kolay çalışabilmek içim Isolate ile 
izole edelim. 

Dişlerin tamamını seçerek Create > Planar > Sağ Mouse Buton ile UV Maplerini oluşturalım. 
Diş modelleri kapalı modeller olduğu için ortalarından geçecek şekilde  üst menü > UV > 3D Cut 
and Sew Uv Tool ile bir Seams (kesme çizgisi) oluşturalım. Burada dikkat etmemiz gereken durum 
dişlerin tamamı seçiliyken Seams oluşturamayız. Dişleri tek tek seçip 3D Cut and Sew işlemi uygu-
lanması gerekmektedir. 

Dişlere Seams oluşturma işlemi bittikten sonra tamamını seçelim ve UV selection vertex mo-
dunda Unfold (düzlem haline getirme) edelim. Unfold işleminden sonra dişlerin tüm Map'leri üst 
üste binecektir.  Arrange and Layout > Layout diyerek tamamını 0-1 alanının içerisine otomatik 
olarak yerleştirelim. 



92

Diş UV Mapleri dağınık olarak ve rotasyonu karışık olarak yerleştirilir. Eğer UV Maplerin üst 
kısmı üste alt kısmı ise alta gelecek şekilde hizalamak da istiyorsak maplerin tamamı seçiliyken 
> Arrange and Layout> Orient Shells seçeneği ile otomatik olarak döndürebiliriz. Bu işlemden 
sonra UV lerin üstüste binmediğini kontrol etmekte fayda vardır. Bazı durumlarda UV çakışmala-
rına da sebep olmaktadır.

Dişlerin UV Map işlemi bittikten sonra tüm dişleri seçip Duplicate işlemi ile kopyalayalım. 
Kopya modellerin tam simetrik olarak karşı tarafa yansıması için Scale seçeneğini ilgili koordinata 
-1 olarak girelim

Dil kısmı için ise dil modeline yukarıdan bakarken Create > Camera Based seçeneği ile UV Ha-
rita oluşturalım. Daha sonra dilin kenarlar Edgelerini seçerek Seams oluşturalım. Vertex modunda 
Unfold yapalım. Hizalamak için Arrange and Layout > Layout yaparak 0-1 alanına hizalayalım.
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Ağız içi modellerinin UV işlemleri bittikten sonra dil, dişler, diş etleri modellerinin tamamını 
seçelim > Arrange And Layout > Layout yaparak 0-1 alanına hizalayalım.

Son olarak rahat çalışmak için gizlediğimiz gövde modelini de Display > Show > Show Last Hid-
den diyerek görünür hale getirelim.

UV HARİTALARINI PAKETLEME
İlk olarak gömlek ve pantolon UV Haritalarını diğer UV'lerini oluşturduğumuz modellerden ba-

ğımsız olarak paketleyelim. Gömlek ve pantolon modeli seçiliyken Mouse Sağ But basılı tutarak> 
Assign Favourıte Material > Lambert materyali seçelim. Bu sayede her iki modele de Lambert 
materyali atandı. Materyalin üzerinde değişiklik yapmak için sağ taraftaki Attribute Editor alanın-
dan materyal rengi kısmına sarı kırmızı mavi gibi farklı bir renk verelim.

Ağız kısmındaki UV Haritaları paketlemek ve daha rahat çalışabilmek için öncelikle gövde mo-
deli seçiliyken Display> Hide ile gövdeyi gizleyelim. Daha sonra ağız kısmındaki dişler diş etleri 
dil modellerini seçelim ve Lambert Materyali atayalım ve rengini diğer modellerden farklı seçim 
yapmamızı kolaylaştıran bir renk seçelim.
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Çok parçadan oluşan bazı modellerde UV Haritaları çok fazla elemandan oluşabilir. Böyle du-
rumlarda kaplama haritaları arasındaki mesafe kısa olduğundan Texture işlemi sırasında bazı sı-
kıntılar oluşabilir. Bunu ortadan kaldırmak için UV parçaları arasında mesafe koymamız gerekmek-
tedir.

Mesafeleme işleminin ayarlamalarını yapmak için UV Toolkıt > Arange and Layout > Layout 
butonuna Shift tuşuna basılı tutarken basalım. Bu sayede Layout seçeneklerinin olduğu pencere 
açılacaktır.

UV Haritalar Face (Polygon) modundayken ve tamamı seçiliyken > Açılan pencereden > Layout 
Setting > Shell Padding ve Tile Padding alanlarına olmasını istediğimiz mesafe boşluğunu Pixel 
değeri cinsinden girelim. Her iki alana da "4" ya da "5" Pixel değeri standart bir Texture işlemi 
için yeterli olacaktır. 

Girilen mesafe değerlerini aktive etmek için en altta bulunan Apply butonuna basarak UV Edi-
tor alanındaki harita yeniden mesafeli bir şekilde düzenlenebilir.

Göz modellerinin UV Haritalarını paketlemek için gözlerin en dışında bulunan saydam kısmı 
Hide ile gizleyelim. Daha sonra gözlerin küre kısımlarını seçelim. Seçili kürelere Assign Fav Mate-
rial > Lambert ile yeni materyal atayalım ve renk verelim. Materyallere isim ekleme kısmından 
mutlaka isimlendirme yapalım çünkü Substance Painter veya diğer kaplama programları mater-
yallere verilen isimleri kaplama yaparken kullanacaklardır. Daha kolay ve hızlı bir çalışma için 
materyallere objesine göre isim verelim. Yeni materyal atayınca gözdeki siyah noktalar kaybola-
caktır ama zaten biz kaplama ile o siyahlıkları verileceği için önemli değil.
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Saç UV Haritalarını paketlemek için saç tutamlarının tamamının teker teker UV'lerinin çıkartıl-
mış olması gerekmektedir. Ayrıca saç dibi olarak modellediğimiz alanın da UV'si hazırlanmış olmalı 
ve LAMBERT materyal saçların tamamına atanmış olmalıdır.

KAPLAMA OLUŞTURMAK İÇİN EXPORT ALMA
Öncelikle çalışma alanından karakteri oluşturan objelerin tamamını seçip gruplayalım ve isim-

lendirelim. Bu sayede Outliner listesinde kullanılmayan gruplar daha net görünecektir. Outliner 
listesini temizleyelim. Kullanılmayan gruplar ve objeleri Outliner listesinden silmek için üst men-
den > Fıle > Optimise File Size seçeneğini kullanılabilir. Bu sayede sahnede kullanılmayan grup 
obje ve materyaller silinecektir.

Bu işlemden sonra tekrar kontrol edelim ve içi boş kullanılmayan gruplar kaldıysa manuel ola-
rak silelim.

Objelere atanmış olan materyallerden isimsiz olanları kontrol edelim ve isimlendirelim. İsim-
lendirme kısmı Substance Painter programı için önem arz etmektedir.

Tek grupta topladığımız karakterin parçalarını alt gruplar haline getirelim. Saç parçalarının 
tamamını seçelim ve Ctrl+G ile grup altında toplayalım. Göz kürelerini üzerindeki saydam tabaka 
ile birlikte sağ göz ve sol göz olarak iki farklı grup yapalım.

Dişleri Üst Dişler Ve Diş Eti ve Alt Dişler Ve Diş Eti olarak iki farklı gruba ayıralım.

Gruplandırma işlemleri bittikten sonra tüm modeller seçiliyken > üst menü > Modıfy > Free-
ze Transform yaparak tüm objelerin koordinatlarını sıfırlayalım. Aksi taktirde Substance Painter 
programına attığımız zaman objelerde kayma meydana gelebilir.
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Gruplama işlemi bittikten sonra modelin tüm parçalarını seçelim > Üst menü > File > Export 
Selection seçeneğinin yanındaki kutucuğa basarak export seçenekleri penceresini aktif hale geti-
relim. Fıle Type kısmından FBX dosya formatını seçelim. Export > Selection > Selection seçeneği 
ile kaydedeceğimiz dosyayı seçelim, dosyayı isimlendirelim ve save ile pencereden çıkalım.

Modeli Export ettikten sonra kaplama kısmına geçilebilir.

ÜNİTE 4- KAPLAMA OLUŞTURMA

SUBSTANCE PAİNTER NEDİR?
Bu projede kaplama oluşturmak için yüzey boyama programlarından biri olan Substance Pain-

ter programı kullanılacaktır. İlk olarak Allegorithmic firmasının oluşturduğu program 3D modelle-
rin kaplamalarını oluşturmasındaki üstün başarısı ve kullanım kolaylığı dolayısı ile daha sonraları 
Adobe firması tarafından satın alınmış ve 2020 yılı itibari ile Adobe Substance 3D Painter olarak 
piyasada bulunmaktadır.  Substance Painter, oldukça güçlü bir 3D boyama aracıdır. Adobe Pho-
toshop’un dijital boyama çalışması için 3D versiyonuna benzetilebilir. 

Substance Painter’ın temel işlemi modelleri dokulandırmaktır. Gelişmiş maskeleme ve prose-
dürel doku oluşturma araçları, Photoshop gibi tamamen 2B programlarda elde edilmesi çok daha 
zor olan dokular oluşturmanıza olanak tanır. Direkt olarak modellediğimiz obje üzerinden boyama 
ve doku oluşturmaya imkan sağlayan program 8000 pixele kadar bake tabir edilen modeldeki 
dokuları modelin UV haritalarına uygun halde istenilen resim formatında kaydetme özelliğine 
sahiptir. Gerçek zamanlı PBR (Physically Based Rendering / fiziksel temelli render) materyal ve 
kendi bünyesinde birçok malzeme ön ayarını ve arşivini içerir (Li ve arkadaşları, 2021).

Programı kısaca tanıdığımıza göre kullanımına geçelim.
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SUBSTANCE PAİNTERDA PROJE OLUŞTURMA
Çalışma alanının en üstünde bulunan ana menü kısmından > File > New diyerek obje import 

etme ve özellik seçme penceresini açalım. 

Açılan pencerede ilk gözümüze çarpan Template seçeneği olacaktır. Bu alandan Import edile-
cek model hangi programda kullanmak üzere kaplanıyorsa o platformun kabul ettiği seçeneğin 
seçilmesi gerekir. Daha sonra Export edilirken de değiştirilebilen bu özellikler için bu projede PBR 
Metalic Roughness Allegro Metric seçeneğini seçilebilir.

Bu alanda bulunan Select butonu ile Maya programında modellenen ve FBX formatına çeviri-
len model programa çağırılabilir.

Project settings bölümünden Document Resolution kısmına gelerek  modele kaplama yapar-
ken  kullandığımız çalışma alanındaki materyallerin çözünürlüğünü seçelim. 2048 piksel değeri 
çoğu çalışma için yeterli çözünürlük sunacaktır.

OK seçeneği ile modeli çalışma alanına alalım.



98

Substance Painter programının menülerini ve çalışma alanlarını tanımak gerekirse:

1. Boyama silme doku ekleme mesh seçme gibi Photoshop programından da aşina olunan 
araçların bulunduğu alandır. Buradan seçilen her araca göre 2 numaralı alandaki özellikler pence-
resi değişiklik gösterir.

2.  Seçili olan aracın özelliklerinde değişiklik yapmamızı sağlayan detaylı seçenekler bölümüdür.

3. Simetri seçeneği. Modelleme çalışmasında örneği bulunan 3D modeldeki gibi simetrik ka-
rakter objelerin aynı anda hem sağ hem de sol taraflarını boyamak ve detaylandırmak amaçlı 
simetri özelliğini açıp kapadığımız buton.

4. Program ile birlikte gelen Materyal, Texture, Alpha kanalı, Fırça gibi arşivlerin bulunduğu 
alan. İmport edilen materyal ve alfa kanallarına da aynı bölgeden ulaşılabilmektedir.

5.  Modelin üzerinde boyama yaptığımız ana çalışma penceresini 3D ve 2D maplar olarak ikiye 
ayırma imkanı sağlayan alan. Buradaki seçenekler ile çalışma alanını sadece 3D yaparak direkt 
model üzerinden boyama yapılabilir. Ya da sadece 2D UV Harita görüntüsü haline getirilip harita 
üzerinden daha detaylı boyamalar düz zemine yapılabilir. Aynı anda 3D ve 2D görünümü görerek 
çalışma olanağı da bulunmaktadır.

	 5.1  Küp şeklindeki ikon ile Perspective ve Ortographic görüntü seçenekleri arasında geçiş 
yapılabilir. Ortographic görünümde daha çok Airbrush ve Stencil uygulamalar için kullanılmakta-
dır.

	 5.2 Kamera ikonunu ile Free Rotation ve Constraint Rotation kamera seçenekleri seçile-
bilir. Bu seçenekler sayesinde çalışma alanındaki objeye bakış açısı değişecektir. 

	 5.3 Render seçeneğidir. Fotoğraf makinesi ikonu şeklindeki butona basarak boyaması ya-
pılan model Substance Painter’ın kendi içinde bulunan IRAY RENDER motorunda render alınabilir. 
Çalışma alanına tekrar geri dönmek için aynı ikon kullanılır.

6. Modelin Farklı bölümlerinin seçildiği alan. 3D modelin boyamak istenen bölümleri bu kısım-
dan seçilebilir. 3D modelin parçalara ayrılacak kısımlarına daha önceden Maya programında fark-
lı materyaller atanmış olması gerekmektedir. Her farklı materyal bu alanda farklı bir satır olarak 
belirecektir. Ayrca Maya programında yazılan materyal isimleri de burada aynı isimle belirecektir. 
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Kaplama haritaları çıkarılırken de kaplama dosyalarına aynı ismi verileceğinden açıklayıcı isimler 
yazılması önemlidir.

7. Katman kısmı. Photoshop programındaki Layer mantığıyla neredeyse birebir aynı olan, renk 
doku ve alfa kanalı eklenilen alandır. Bu kısımda oluşturulan katmanlar sayesinde birden fazla renk 
doku filtre ve efekt 3D modele kaplanabilir. Bu kısımda oluşturulan katmanlar üst kısımdan seçilen 
model parçalarına kaydedilir. Her seçilen 3D model parçası kendine ait Layer grupları oluşturur. 
Bu yüzden kaplama yaparken doğru model parçasının seçili olduğundan emin olunması gerekir.

8. Özellikler bölümü. Bu kısımdan seçili olan araç ve katman ile ilgili özellikler değiştirilebilir. 
Ayrıca katmanların alt özelliklerini, kanal, materyal ve filtre özellikleri de yine bu kısımdan ayarla-
nabilir.

Modelin göründüğü üç boyutlu çalışma alanında hareket etmek için ALT+Sol Mouse Buton'a 
basılı tutarak model etrafında dolaşılabilir. Modele yakınlaşıp uzaklaşmak için ise Orta Mouse 
Tekerleğini ileri geri hareket ettirebilir ya da Alt+Sağ Mouse Buton basılı tutarak zoom yapabili-
riz.  Yine Alt+Orta Mouse Tekerlek Buton’a basılı tutarak da ekranı kaydırarak modelin soluna ve 
sağına ya da üst ve alt kısımlarına inilebilir. 

2D çalışma alanında da Alt+Sol Mouse Buton ortam iki boyutlu olduğu için UV Haritasını saat 
yönünde ve ters istikamette döndürür. Shift tuşu basılı tutarsak Snap özelliği ile belirli dereceler-
de dönüş yapar. Diğer komutlar aynı 3D alandaki işlevlerini devam ettirir.

Çalışma alanının sağ üst köşesinde bulunan Material sekmesine tıklarsak, ekranda bulunan 
modeli; Base Color, Heighet, Roughness, Metalic, Normal, Normal+Height+Mesh Ön izlemeleri 
arasında seçim yapılabilir.

GÖVDE MODELİNİ RENKLENDİRME
Sağ üst kısımdaki Texture Set List alanından renklendirmesi yapılacak 3D modeli seçelim. Bu 

çalışmamızdaki örnekte gövde 1 ismi ile kayıtlı olan sekme gövde modelini temsil etmektedir.

Daha sonra Layers sekmesine gelerek bir boyama katmanı oluşturalım. Hazırda zaten her mo-
del için boş bir Layer bulunmaktadır. Dilersek o katmanı silerek yeni katman oluşturarak da çalışa-
biliriz. Yeni katman oluşturmak için iki farklı seçenek mevcuttur. 

Add a Layer seçeneği ve Add a Fill Layer seçeneği.  

Add a Layer seçeneği boş bir Layer oluşturur. Üzerine brush ve diğer araçlarla boyamalar ya-
pabilir şekiller çizilebilir. Transparan bir katman olduğu için boyama yapılan alanın altında kalan 
katmanlar görünür olacaktır.

Hazır olarak gelen boş Layer'ı silelim ve Fill Layer seçeneği ile yeni bir katman oluşturalım. Fill 
Layer seçeneği ile kendi içinde renk barındıran bir katman oluşacaktır. Bu seçenek ile birlikte Layer 
alanının hemen altında yer alan Properties panelinde seçeneklerin değiştiğini ve renk ekleme gibi 
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özelliklerin aktive olduğu görülebilir. Gri bar alanına çift tıklayarak renk skalasından renk ekleye-
lim.

Modele renk eklendiğinde ayak kısımları da gövde ile birlikte modellendiğinden dolayı renk-
lenmektedir. Bu durumu engellemek için MASK uygulaması yapılabilir. Maskeleme uygulaması 
için Fıll Layer’a sağ tıklayarak Add White Mask ya da  Add Black Mask seçeneklerini uygulayabilir 
ya da Layers sekmesindeki ikonuna basarak maske seçeneklerine ulaşılabilir.

White mask ekleyerek çalışmamıza devam edelim. Beyaz maske eklendikten sonra da modele 
uyguladığımız rengin görünmeye devam ettiği görülebilir.  

Beyaz maske eklendikten sonra Mouse ikonu solda seçili olan Brush aracına dönüşecektir. La-
yer alanındaki kare maske ikonunu seçerek siyah Brush ile modelin üzerinde görünmesi istenme-
yen alanlar boyanarak maskelenebilir.

Bir diğer yöntem ise model üzerindeki Polygon'ları seçerek maskeleme yöntemidir. Sol alan-

daki Tool Bar'dan Brush seçeneğinin altındaki  ikonuna basarak Polygon Fill modu aktive 
edilebilir. Bu moddayken model üzerinde beliren Polygon'ları seçerek maskeleme yapılabilir. Kes-
kin sınırlar şeklinde maskeleme yapmak için ideal olan bu yöntem geniş alanları hızlı bir şekilde 
maskeleme imkanı da sağlamaktadır.



101

Polygon Fill modu seçildiğinde Properties alanında Poly Fill özelliklerinin aktif olduğu görülür. 
Bu alandan eklemiş olduğumuz maske beyaz olduğu için Color kısmından siyah renk seçeneğini 
kaydırma çubuğu vasıtası ile seçilebilir. Siyah maske kulanımında ise renk Beyaz olarak ayarlana-
bilir.

Polygon seçme tarzlarını değiştirmek için ise üst barda bulunan özellikler arasında tercih yapı-
labilir.

Bunlar soldan sağa sırası ile; Üçgen Polygon Seçme, Kare Polygon Seçme, Obje Olarak Seçme 
ve UV Map Olarak Seçme tercihleri şeklindedir.

En sık kullanılanı Kare Polygon Seçme ve UV Map seçme tercihleridir.

Bu çalışmadaki modellemede Maya programında model için UV Map oluşturulduğu için UV 
Map Seçme tercihi ile kolaylıkla ayakkabı ve çorap kısmı maskelenebilir.

Gömlek ve Pantolon modellerini renklendirmek için de aynı çalışma sıralaması kullanılabilir. 
Öncelikle Texture Set List’den elbiselerin olduğu model setini seçelim. Daha sonra Layers sek-
mesindeki boş Layerı silelim ve kendimiz bir Fill Layer oluşturalım > Properties > Color alanından 
dilediğimiz rengi seçelim.
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Properties alanının Material sekmesinde bulunan Color, Height, Metal, Normal seçenekleri 
objeye verilen kaplamanın kanallarıdır. Bu kanallarının her zaman aktif olmasına gerek yoktur. Bo-
yanan modelde eğer kumaş vb gibi yumuşak yüzey olacak ise Height, Metal ve dokulu bir kumaş 
oluşturulmayacaksa Normal kanalı kapatılabilir. Bu alanda kapatıp aktive edilen Material kanal-
ları, kaplamaları Export edildiği zaman her biri ayrı resim dosyası olarak dışarıya aktarılacaktır. Bu 
sebeple ihtiyacımız olan kanalları doğru seçmek önemlidir.

Roughnes ayarını yapmak için Properties sekmesindeki Roughness kanalının barı siyah ve be-
yaz renklere doğru çekilebilir. Siyah renk materyali parlatırken beyaz renk ise materyali matlaş-
tıracaktır.

Çok parça modelden oluşan yüzeylere renk attıktan sonra doku atadığımız zaman bazı durum-
larda maskeleme işlemine rağmen doku diğer parçalarda da görünebilir. Bir modelin parçasında 
farklı materyaller ve dokular kullanmak gerekirse, farklılık gösterecek Layer'ları renklendirdik-
ten sonra Folder oluşturarak içine konulması gerekebilir. Folder oluşturduktan sonra eklenen 
Layer'ları Folder'ın içine taşıyarak klasörün kendisine maske atılması gerekmektedir. Bu sayede 
klasörde bulunan tüm Layerlar ve efektlere maskeleme işlemi uygulanabilir.

Pantolon kısmını renklendirmek için de bir adet Fıil Layer oluşturup Folder içine sürükleyip 
bırakalım. Klasöre Mask özelliği ekledikten sonra maskelenecek alanı seçip kapatalım.

Saç bölgesini renklendirmek için Texture Set List kısmından saç modelini seçelim ve Layer ala-
nına yine bir Fill Layer oluşturup saç için düşündüğümüz rengi atayalım. Saçın parlaklık durumu 
Roughnes kanalından ayarlanabilir.

Ayakkabı ve Çorap kaplamasını oluşturmak için Texture Set List alanından Gövde modelini 
seçelim. Hatırlanacak olursa çorap ve ayakkabı modelleri gövdeye birleşik şekilde modellenmiş-
ti. Daha sonra yeni bir Fill Layer oluşturarak isimlendirelim. Karmaşık modellerde hem Layer'ları 
hem de klasörleri isimlendirmek düzenli çalışma açısından kolaylık sağlayacaktır. Eklenen Fill La-
yer'ı maskeleyelim ve çorap UV Map’ini seçerek renkleri ortaya çıkaralım. Çorap kısmı için yaptığı-
mız işlemlerin aynısını ayakkabı kısmı için de tekrarlarsak ortaya aşağıdaki gibi bir sonuç çıkacaktır.
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CİLDİ DETAYLANDIRMA
Ten rengi çorap ve ayakkabı renklendirmesi yapılan modeli seçelim. Bu sayede Layer alanında 

daha önceden eklenen katmanlar görülebilir. Bu katmanların en üst kısmına gelecek şekilde boş 
bir katman ekleyelim. Boş katman eklememizdeki amaç detaylı çizim işlemlerinin yapılmasına izin 
vermesidir. Fill Layer temelde düz renk atma amaçlı kullanılır.

Yeni boş Layer oluşturduktan sonra sol alandan Paint Brush aracını seçelim. Brush aracı seçil-
diği zaman Layer alanının altında kalan Properties sekmesinden fırçanın özellikleri ayarlanabilir. 

Oluşturulan bu katmanı yanak, dudak, çil gibi detayları eklemek için kullalım. Aşağıda Brush 
seçenekleri sırası ile görülebilir. Çalışma alanının hemen üst kısmına bulunan Symetry butonunu 
aktifleştirerek simetrik objelerin her iki tarafı da aynı anda eşit miktarda renklendirilebilir. Sy-
metry butonu aktifken modelin tam ortasından geçen bir kırmızı çizgi oluşacaktır. Bu şekilde 
dengeli boyama yapılabilir.

 

Brush seçeneklerinden Base Color kısmına pembemsi bir renk ekleyerek modelimizin yanak 
ve dudak kısımlarını yeni açtığımız boş Layer'a çizelim. 

Substance Painter programında daha güzel sonuçlar alabilmek için bir Grafik Tablet kullanma-
nız tavsiye edilir.  Grafik tablet kullanılarak yapılan çalışmalarda  Pen Pressure seçeneğini aktif 
etmemiz gerekmektedir.

Bu sayede tablet kalemimiz basınca duyarlı şekilde modelimizi renklendirecektir.
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Karakterin cilt kısmı istenilen tarzda renklendirilebilir. Stilize bir karakter olmasından dolayı ya-
naklar, dudak kısmı, burun ve kulak ucu, göz ve kaş arasındaki göz kapağı bölgesi, dirsekler dizler 
ve parmak uçları alanlarını pastel renklerde renklendirilebilir. Karakterin yüz kısmına çil, ben gibi 
detaylar eklemek daha da karakteristik hale getirecektir.

Alt kısımda bulunan Shelf sekmesinden > Brushes alanından cilt dokusuna uygun fırça seçe-
nekleri ile detaylandırma çalışması kolayca yapılabilir.

GÖZ KÜRESİNİ RENKLENDİRME
Göz küresi için Texture Set List alanından gözlerin olduğu modeli seçelim. Layer sekmesinden 

bir Fill Layer ekleyerek kırık beyaz renk ekleyelim. Bir başka Fill Layer daha ekleyelim ve renk ola-
rak oluşturmak istediğimiz göz rengini seçelim (Kahverengi Mavi vs..). Üzerine bir Fill Layer daha 
atayıp siyah renk seçelim. Maske attıktan sonra göz bebeği olacak şekilde sadece ortadan ufak 
bir küre alanı Polygon Fill modunda seçelim. Daha sonra göz rengi katmanına bir maske atalım ve 
sadece gözün orta kısmındaki retina alanı görünecek şekilde Polygon Fill seçeneği ile Polygon'ları 
seçerek maskeleyelim. Bu işlemleri yaparken Symetry seçeneğinin açık olduğundan emin olalım.

Daha sonra bir boş katman ekleyerek göz küresinin göz kapakları ile birleşen alanlarını hafif 
pembemsi renkle boyayalım. Pembelik ve gölgelendirmeler koyu gelirse Blend Mode'ları kulla-
narak renkleri açabilir ya da daha canlı hale getirilebilir. Bir boş katman daha ekleyerek detay göz 
pınarı damar vs gibi ince çalışmaları da eklenebilir. 
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GÖMLEK KAPLAMA OLUŞTURMA
Diğer parçaların renklendirilmesi gibi öncelikle modeli seçelim. Grup olarak hazırlanan Layer-

lardan gömlek için olanının grubunun içine bir Fill Layer açarak ve bu katman maskeleyerek de-
taylandıralım.

Eğer Polygon'ları seçerek ya da maskeleme yaparak renklendirme istenmiyorsa, boş bir Layer 
açarak Brushlar yardımı ile renklendirme de yapılabilir. Ya da maske seçilip Brush yardımı ile mas-
ke üzeri boyanarak serbest şekiller ile renklendirme yapılmış olur. 3D tekli çalışma alanı yerine 
3D ve 2D görünümleri aynı anda açarak UV Map üzerinden de çalışarak renklendirme yapılabilir. 
Yumuşak Brush seçenekleri yerine Hard Brush tabir edilen keskin çizgiler çekilebilen fırça uçları 
seçerek de desen ve doku oluşturulabilir. Düz çizgiler çekmek için Brush seçili iken bir noktaya Sol 
Mouse Buton ile tıkladıktan sonra çizeceğimiz çizginin biteceği noktaya Mouse ikonunu götürüp, 
Shift + Sol Mouse Buton'a basılı tutmamız gerekmektedir.

Substance painter’ın hazır materyal arşivi bulunmaktadır. İstendiği taktirde bu arşivdeki Fab-
rıc hazır materyalleri kullanılarak hazır kumaş dokulu kaplamalar oluşturulabilir. Materyal kütüp-
hanesindeki arama satırına Fabric yazarak hızlı bir flitreleme yapılabilir. Aşağıda belirecek olan 
alandaki materyallerden istenen kumaş materyali sürüklenip kıyafet modelinin üzerine bırakılarak 
materyal objeye atanır.

Sağ alt köşede bulunan Properties alanından Fill sekmesinden kumaşın dokusunun sıklığı ve bü-
yüklüğü ayarlanabilir. Eklenen her hazır materyalin detay ayarlamaları bu alandan yapılmakta-
dır. Ayrıca materyalin rengini değiştirip Blend Mode'ları Multiply yaparak da boyanan kumaş 
modeline doku kazandırılmış olur.
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PANTOLON KAPLAMA
Gömlek ile ilgili tüm kaplama ve boyama katmanları daha önceden oluşturulan Gömlek Kla-

sörü altında oluşturulmuştu. Dosya kendini maskelendiği için klasör içinde oluşturulan tüm renk 
ve dokular otomatik olarak maskelenmişti. Şimdi de aynı mantıkla oluşturulan Pantolon Klasörü 
altına Layer'lar oluşturarak renklendirmeye devam edelim. 

Bu örnek için Add a Fill Layer seçeneği ile renkli Layer ile pantollon rengini oluşturalım. Daha 
sonra boş katman oluşturarak istenilen yerlere leke dikiş gibi detayları ekleyelim. En son alt kısım-
da bulunan Shelf arşiv kısmındaki hazır Fabric materyallerden istenen Layer sekmesinde Pantolon 
Klasörünün içine ekleyelim. Gömlek modelinde yaptığımız gibi kumaş Layer'ının ana rengini be-
yaz  ya da açık gri yapıp Blend modunu Multıply yaparak dokuyu renkle birleştirelim.

Klasöre attığımız materyal eğer klasörde maskeleme yoksa modelin tamamına yansır. Sınırlı 
yerlere hazır materyal dokusu atamak isteniyorsa klasörler maskelenebilir.

Çorap ve ayakkabı modellerini de aynı Fill Layer ile ana renk, Boş Layer oluşturarak desen ya da 
eskitme dokusu atarak ve hazır Fabric materyal ekleyip beyaz renge çevirip Multiply ile modunu 
değiştirerek renklendirelim. Farklı teknikler deneyerek farklı etkiler yakalanabilir.

Hazır Brush ya da Alpha kanalı ile desen oluşturma dışında kullanılan bir diğer yöntem ise Sten-
cil yöntemidir. Bu yöntemde modele eklemek istenen herhangi bir piksel tabanlı görsel ekrana 
yansıtılarak Brushlar vasıtası ile yüzeylere uygulanabilir.

Stencili kullanmak için boş bir katman oluşturalım. Brush aracını seçelim. Çalışma alanının sağ 
tarafında bulunan Brush Properties alanındaki Stencil penceresine gelelim.

Bu alana Substance Painter’ın kendi içerisinde bulunan hazır imajları kullanabilir ya da progra-
ma Import ederek arşive eklenen bir görsel sürükleyip bırakma yöntemi ile kullanılabilir.
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Bir görseli Substance Painter programının içine çağırmak için; üst menü > Fıle > Import Re-
sources > açılan pencereden > Add Resources diyerek bilgisayarımızdaki görseli seçelim.

Daha sonra görselin çeşidini Undefined butonuna basarak programa tanıtılması gerekmekte-
dir. Burada bulunan Alpha, Colorlut, Texture, Environment seçeneklerinden görseli hangi amaçla 
kullanacaksak o seçeneği seçelim. Mesela siyah ve beyaz renk ağırlıklı ve Alpha kanalı olarak kul-
lanmayı amaçlayarak oluşturduğumuz bir görsel ise listeden Alpha seçeneğini seçelim. Bu sayede 
siyah alanları transparan olarak algılayacaktır. Son olarak da import your resources to kısmından 
Current Sessıon, Project ’projenizin ismi’ ya da  Shelf seçeneklerinden birini seçelim. Sadece bu 
projede kullanacağımız için Project seçeneğini seçebiliriz. Bu sayede görsel direkt olarak Shelf 
kısmındaki Alpha klasörüne indirilecektir. 

Alpha Stencil olarak kullanmak için Import ettiğimiz görseli Brush aracı seçiliyken Brush se-
çeneklerindeki Stencil alanına sürükleyip bırakalım. Bu işlemi yaptıktan sonra çalışma alanının 
ortasında görsel ortalı bir şekilde görünecektir. Bu görselin büyüklük - küçüklük ve rotasyonunu 
belirlemek için klavyeden "S" tuşuna basılı tutulması ve aynı anda Sol ve Sağ Mouse düğmelerine 
basılı tutarak Mouse’un hareket ettirilmesi gerekmektedir. 

Büyüklüğünü ayarladıktan sonra modelde istenen alana görseli denk getirelim ve izini modele 
çıkarmak için üzerinden Brush ile üzerinden geçelim. Aynı karbon kağıdının üzerini karalar gibi 
çizdiğimiz alanlardaki şekil modele aktarılacaktır.
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Eğer görsel modelin üzerinde Piksellenmiş ve bozuk bir şekilde görünüyorsa modelin Texture 
ayarlarını yükseltmemiz gerekmektedir. Bunun için sağ kısımda bulunan Texture Settings alanın-
dan kaplama değeri 1024 yerine 2048 ya da 4096 yapılabilir. Fakat unutmayalım net kaplamalar 
elde etmek için export alırken de kaplama ölçülerini aynı değerlerde tutmamız gerekmektedir. Bu 
da kaplama dosyalarının boyutlarını büyütecektir. 

1024 pixel ve 4096 pixel netlik karşılaştırması

Alpha olarak programa indirilen görsel ayrıca Brush seçeneklerindeki Alpha kısmına eklenerek 
de direkt olarak fırça ucu şeklinde kullanılabilir.

Renkli bir görseli Stencil olarak kullanmak ve modele kaplamak için > Projection Tool kullanı-

labilir. Sol tarafta bulunan araç çubuğundaki  simgesine basarak ekrana görsel aktarma ku-
tucuğunu aktive edelim. Sağ tarafta bulunan Projection Properties alanındaki Base Color alanına 
daha önceden İmport edilen renkli imajı kütüphaneden sürükleyip bırakalım. Ekranın ortasındaki 
boş kutucuk alanında görselin belirdiğini görülebilir. Üzerinden Brush ile geçerek eklenecek mo-
dele imajın aktarımını yapılabilir. Klavyeden “S” tuşuna ve Sağ Mouse Butonu’na basarak görsel 
kutucuğu büyütüp küçültülebilir.
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SAÇ RENKLENDİRME
Texture Set List alanından saç modelni seçelim. Layer sekmesinden dilediğimiz saç rengine ait 

bir Fill Layer ekleyelim. Roughnes kanalından saçın parlaklığını ayarlayalım. Fill Layer’ın üstüne 
gelecek şekilde boş bir Layer oluşturalım ve saç tutamlarını belirginleştirip detaylandıracak bir 
Brush seçelim. Fill Layer'daki ana renkten daha açık bir renk seçerek saçın detaylarını her tutama 
çizelim. Ctrl+Sol Mouse Buton basılı tutarak Brush Açısı değiştirilebilir. Brush seçeneklerini Pen 
Preasure ayarına getirerek ilgili yerlere grafik tabletler ile de boyama yapılabilir.

Bu tarz saç modeli oluşturma işlemi stilize karakterler ya da bilgisayar oyunları için oluşturulan 
karakterlerde kullanılabilir. Daha gerçekçi karakter modellerinde oluşturmak istenen saç, sakal 
kaş kirpik gibi bölümleri ya da oluşturulacak kürklü hayvan modellerini Maya’nın kendi içinde 
bulunan XGEN Plugini sayesinde oluşturulabilir. XGen, poligonların yüzeyini rastgele veya düzgün 
yerleştirilmiş çeşitli sayıda model ile doldurulmasına izin veren bir geometri klonlayıcısıdır. XGen, 
karakterler için prosedürel olarak saç, kürk ve tüyler oluşturulmasına ve şekillendirilmesine ola-
nak tanır. Aşağıda XGEN kullanılarak yapılmış bir karakter tasarımı bulunmaktadır.
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Saç modellerine Alfa Kanalı ile Transparanlık sağlamak için: Öncelikle Texture Set Settıngs 
alanına giderek (+) artı simgesine basarak açılan listeden Opacity kanalı ekleyelim. Artık Layer 
sekmesindeki Material kanalları alanında OP yazılı opacity kanalı da bulunmaktadır. Farklı kanal-
lar eklemek için bu yöntem kullanılabilir. 

İkinci olarak alfa kanalının materyal üzerinde aktive olabilmesi için materyal türünü PBR Metal 
Rough With Alpha Blending olarak değiştirelim. Eğer bu materyal tipini seçmezsek Alfa kanalı 
aktive olmayacak ve transparanlık özelliği göstermeyecektir.

Daha sonra Layer alanına gelerek saçları boyadığımız katmanlar alanının en üst kısmına bir 
adet Fıll Layer oluşturalım. Bu katmanı transparanlık kanalı için kullanacağız. Bu sebepten dolayı 
Layer Properties alanındaki OP kanalı hariç tüm kanallarını kapatalım. Fill Layer olarak oluştur-
duğumuz Layer'a sağ tıklayarak Add Paint özelliği ekleyelim.

Bu sayede Fıll Layer özelliğinde olan bir katmana Brush ile boyama yapılabilir. Siyah Renk 
seçili yeni Brush ile boyandığında boyanan yerlerin transparan olduğunu Render Ön İzlemesi ya-
parak görülebilir.
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Saç tutamlarının uç kısımlarına saç dokusu vererek bu işlemi tamamlayalım.

Tırnaklar, ufak tüyler, vs gibi son detay dokunuşları da yaparak Substance Painter içerisinde 
render alarak bu programdaki çalışmayı bitirelim. Substance Painter içerisinde alınan Render gör-
seli, kaplamalar Maya programında oluşturulurken referans olarak kullanılabilir. Bu sayede hatasız 
bir şekilde karakterin materyalleri Maya'da oluşturulabilir.

Render Butonuna  basıldığında model render alanında görünmeye başlar. Bu alan gerçek 
zamanlı render alanıdır. Model farklı açılardan görecek şekilde bakış açısı bu alanda da değiştirile-
bilir. IRAY render biz hareket ettiğimiz sürede render almaya devam edeceğinden modelin render 
açısını Painting modundayken ayarlayıp daha sonra render butonuna basmak çalışma hızı açısın-
dan faydalı olacaktır.

Render alanı seçenekleri şu şekildedir;

1) Render imaj bilgileri ve render işleminin devamı ya da bitişi ile ilgili bilgilerin bulunduğu 
bilgilendirme alanı. Pause render seçeneği ile render işlemi durdurabilir ya da devam ettirilebilir.

2) Min ve Max samples alanından render alınacak görselin kalite ayarı yapılabilir. Bu alandaki 
rakamları artırdıkça daha fazla sayıda işlem yapılacağından render süresinin de uzayacağını unut-
mamak gerekir. Max samples alanındaki tüm işlemlerin yapılmasını istiyorsak, Time sekmesini sı-
fır “0”’a getirmemiz gerekir. Bu sayede program, samples alanına girdiğimiz tüm sample değerleri 
bitene kadar Render'a devam eder.
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3) Override Viewport Resolution butonuna basarak istenen çıktı ölçüleri girilebilir. Bu alandan 
render işlemi bittikten sonra Status sekmesinde Done yazısı belirir. Save butonu yardımı ile dosya 
istenen formatta kaydedilebilir.

4) Display Settings alanından Environment settings ile fon görselini ve ışıklandırması değişti-
rilebilir. Aynı alanda bulunan Camera Settings bölümünden yakınlık uzaklık örtücü ayarları gibi 
kamera ayarları yapılabilir. Ayrıca parlama yansıma Lens Flare gibi lens efektler de bu alandan 
açıp ayarlanabilir.

5) Clear Color alanı aktif hale getirildiğinde arka fondaki HDRI görseli gizlenir ve yerine belir-
leyeceğimiz renkte arka fon rengi atanır.  HDRI Map gizlense bile hala sahnedeki objeyi aydınlat-
maya devam edecektir. HDRI map’in yönünü değiştirmek için Shift+Sağ Mouse Buton’una basılı 
tutarak Mouse’u hareket ettirmek yeterli olacaktır. Ayrıca Environment Map alanındaki Panora-
ma butonuna basarak farklı HDRI görselleri arasında seçim yapılabilir.

Bu ayarlamalar ile alınan render görselleri;

KAPLAMALARI EXPORT ALMA
File Mensüne giderek > Export Textures seçeneği ile kaplamaları çıktı almaya yarayan, Export 

ve Configuratıon seçenekleri bulunan pencereyi açalım.

Export alanında en üstte bulunan adres çubuğuna, çıktıları göndermek istenen adresi girilebilir.

Config sekmesinden modeli aktaracağımız farklı programlar için oluşturulmuş hazır ayarları se-
çerek Export alınabilir. Unıty, Unreal Engine Vray render motoru gibi hazır ayarlar bu alanda bu-
lunmaktadır. Bu çalışmada transparan ALPHA kanalı kullanıldığından dolayı transparan kanalını da 
Export'a dahil etmek için; Document Channels + Normal + AO (With Alpha) seçeneği seçilebilir.

1) Export alanı.

2) Export adresi seçme alanı.

3) Dosya formatı seçme alanı. Bu çalışmamızda alfa kanalı olduğu için transparan özelliği bulu-
nan Png gibi dosya Formatlarını seçmek doğru olacaktır.

4) Hazır ayarların bulunduğu Export kanallarının seçim alanı.
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5) Modeldeki parçalara yapılan kaplamaların hangilerinden Export alınacağının seçildiği model 
parça listesi.

6) Export alınacak kaplama dosyalarının çözünürlüklerinin ayarlandığı alan. Bu kısımda dökü-
man üzerinde çalışırken seçilen görüntü kalitesinden farklı olarak kaplama dosyası çözünürlüğü-
nü yükselterek daha net sonuçlar elde edilebilir. Her bir modelin parçası için farklı çözünürlükler 
seçilebilir.  Detayda kalacak parçaların çözünürlüklerini artırmak gereksiz yere çalışma zorluğu 
yaratabilir. Bu yüzden diş, diş eti, dil gibi detay parçalara düşük çözünürlük seçilebilir.

Ayarlar bittikten sonra son olarak sağ altta bulunan EXPORT butonu ile dosyaların çıktıları alı-
nabilir.

Export alınan klasörde bulunan işe yaramayan kanal çıktıları silinebilir. Base Color, Normal 
Map, Roughness ve Alpha Channel dosyaları bu çalışma için yeterli olacaktır. Fakat tabi ki ileride 
yapılacak projeler için elde etmek istenen sonuçlar doğrultusunda kanal görselleri farklılık göste-
rebilir (Udemy, 2023).

KAPLAMALARI MODELE GİYDİRME
Maya programına geçiş yaparak oluşturulan kaplama dosyalarını modele atayacağız. Hyper-

shade alanını açalım. Daha önceden oluşturup modelimize atadığımız materyaller üst kısımda 
Materıals sekmesinde görünecektir. 

Daha önceden model üzerindeki alanları belirlemek için  renklendirerek kullanılan materyaller 
yerine kullanılacak render motoruna uygun materyaller atanacağı için modelin tamamına şimdilik 
bir Lambert materyal atayalım. Karakter modeli tamamı gri olacaktır.

Material alanında kullanılmayan materyalleri silmek için Hypershade ekranında > Edit > Dele-
te Unused Nodes seçerek sahnede kullanılmayan eski kaplamalar listeden silinebilir.

Bu çalışmada Arnold Render Motoru üzerinden çalışılacağı için Materyal alanında Arnold sek-
mesi altında bulunan AI Standart Surface materyali ile model kaplanabilir.
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Sahnede materyal atamak istenen modelin parçasını seçelim. Hypershade alanından mater-
yale sağ tıklayalım ve Assign Material to Selection diyerek materyali modele atayalım. 

Oluşturduğumuz materyale çift tıklayarak Hypershade alanında materyal Editleme alanını aça-
lım. Bu alan hem Hypershade çalışma alanının sağ tarafında hem de Attribute Editor alanında 
görünmeye başlayacaktır. Materyal Editor'un Color sekmesinde bulunan kare ikona basalım. 

Açılan listeden File seçeneğini seçelim. Tekrar açılan penceredeki sarı dosya ikonuna basarak 
modele kaplamak istenen, Substance Painterda oluşturulan kaplama dosyasını seçelim.

Örnekte gövde modeli kaplanacağı için Gövde Base Color kaplaması seçilmiştir. Hangi model 
parçası kaplanacaksa Color kısmına o modelin Base Color haritası seçilmelidir.

Kaplama dosyası materyale eklendikten sonra çalışma alanında görünmeyebilir. Kaplamanın 
Maya çalışma alanında görünür olması için klavyeden “6” kısa yoluna basarak ya da çalışma alnı-

nın üstünde bulunan textured  butonuna basarak aktive etmemiz yeterli olacaktır.

Diğer tüm parçalara da materyal atayarak kaplamalarını tanıtalım. Bu işlemleri yaparken Ma-
teryalleri isimlendirmeyi unutmayalım.
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DENEME RENDERI ALMA

Materyalleri atama işlemi bittikten sonra Display Render Settings  ayarlarından Render 
Motorunu Arnold  olarak seçelim. Render Settings butonunun yanında bulunan render butonuna 

 basıldığında sonucun siyah bir ekran olduğun görülebilir. Bunun nedeni ise Arnold’un obje-
leri göstermek için bir ışık kaynağına ihtiyaç duyuyor olmasıdır. Çalışma alanının hemen üstünde 
bulunan Shelf alanındaki menü seçeneklerinden Arnold sekmesini açalım. Bu kısımda bulunan 
Area Light seçeneği ile sahneye bir ışık kaynağı ekleyelim.

Sahneye eklenen ışık kaynağı ile ilgili ayarlamaları yapmak için ışık seçiliyken sağ tarafta bulu-
nan Attribute Editor sekmesi kullanılabilir. Işığın simgesinin büyüklüğü yeterli değilse Scale aracı 
ile ışık kaynağını büyütülebilir. Sağdaki Arnold Light Area Lıght Attributes sekmesinden Intensıty 
seçeneğine girilecek değerler ışığın parlaklığını belirleyecektir. 100 / 500 / 1000 / 5000 gibi değer-
ler girerek ışığın modeli aydınlatması sağlanabilir. Işığın parlaklık ayarını yaparken her değer girişte 
render alarak sonuçları incelenebilir.

Aşağıdaki örnekte Intensity alanına 90.000 değeri girilerek sahnedeki obje aydınlatılmıştır. 

Render sonucuna bakıldığında karakterin kaplamalarını oluşturan materyalin fazla parlak bir 
materyal olduğunu görülmektedir. Materyallerdeki cilalanmış görüntüsü veren parlaklık ayarları-
nı yapmak için Specular kanalının Weight seçeneğini kullanılabilir. Weight değeri düştükçe obje 
parlaklığını kaybedecektir.
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YÜKSEK SPECULAR DEĞERİ DÜŞÜK SPECULAR DEĞERİ

AI STANDART SURFACE MATERYALİ
Arnold Aistandard Surface Material ayarlarına bakılacak olursa Base, Specular, Transmıssıon 

Ve Subsurface bölümleri görülebilir. Bu bölümler materyal üzerinde en etkili ayarların yapılmasını 
sağlayan bölümlerdir.

Base Kanalı:

Yeni bir materyal oluşturalım. Küre bir obje oluşturup materyali küreye atayalım. Specular ka-
nalının Weight kısmını “0” yaparak materyalin özelliklerini incelemeye başlayalım.

Base kısmındaki Weight alanı materyalin renginin ne kadarının görüneceğinin belirlendiği 
alandır. Örneğin beyaz bir materyal var ve bu sahnede fazla aydınlatmadan dolayı aşırı beyaz 
görünmekte ise o zaman Base kısmının weight ayarını kısarak görmek istenen beyaz renge ulaşı-
labilir ve fazla parlamadan dolayı oluşacak detay kaybını en aza indirgenebilir.

Base sekmesindeki Color kısmından ise materyalin ana rengi seçilebilir. Diffuse Roughnes kıs-
mından ise materyale daha mat ve kadifemsi bir etki verilebilir. 

Metalness kısmını artırdıkça materyale metal etkisi verilmiş olur. “1” değeri verildiğinde krom 
benzeri bir parlama elde edilmiş olur.

Specular Kanalı:

Yeni bir materyal oluşturalım ve yuvarlak bir objeye atayalım. Base sekmesindeki Weight ka-
nalını “0” ve renk sekmesini de siyah yaparak Specular kanalının etkileri daha iyi görülebilir. Spe-
cular kanalının Weight sekmesindeki değeri artırdıkça materyalin ne kadar yansıtıcı olduğunu 
ayarlanır. Color kısmındaki beyaz rengi değiştirerek materyal üzerindeki çevreden yansıyan ışık 
parlamalarının rengi değiştirilebilir.



117

Roughnes kalanındaki değeri artırarak matlık kazandırılabilir.

IOR (index of refraction) kanalı Fresnel diye de bilinen yansıma ayarının yapıldığı sekmedir. 
Işığın yansıma yüzeylerinin açısını belirler. Buradaki değerleri artırarak ışığın geliş yönüne göre 
parlaklığın objenin tamamına ya da belirli bir kısmına yayılması ayarlanır. (deniz yüzeyi cam yüzeyi 
vs.)

Anısotropy kanalı ise yüzeye çizgiler halinde fırçalanmış metal yüzey etkisi katar. yüzeye doku 
kazandırmak için kullanılır. Hemen altındaki Rotatıon kanalından da bu çizgilerin materyal üzerin-
deki yönü ayarlanır.

Transmision Kanalı:

Işığın materyalin içinden geçmesi ile ilgili ayarların yapıldığı bölümdür. Weight kanalını artıra-
rak transparan görüntü elde etmeye başlanır. Fakat sadece Transmision kanalından transparanlık 
sağlanamaz. Obje seçiliyken Attribute Editor alanından Arnold sekmesinden Opaque seçeneğin-
deki işaretin kaldırılarak bu objenin transparan olduğu tanımlanmalıdır. Bu tanımlama her trans-
paran olmasını istenen obje için yapılmalıdır.

 OPAQUE KAPALI OPAQUE AÇIK

Transmision alanındaki Color sekmesinden ise oluşturulan saydam objeye renk eklenebilir. 
Depth kanalından ise saydamlığın derinliğini ve materyalin iç kısmına alacağı gölge - ışık yüzdesi 
ayarlanabilir.

DEPTH KAPALI DEPTH AÇIK  



118

EXTRA ROUGH DISPERSION AÇIK

Scatter Anisotropy ve Extra Roughnes bölümünden ise saydam objeye buzlu cam etkisi ka-
zandırılabilir. Dispersion Abbe kanalında ise materyale Noise eklenebilir. 

Materyale her yeni eklenen özelliğin render süresini uzatacağını unutmayalım.

Subsurface Kanalı:

Weight kanalını artırarak ışığın materyal içerisindeki saçılma yüzdesi artırılabilir. Fakat bu ayar 
materyali saydam yapmaz. Işık belirli bir derinliğe kadar materyalin içine girer ve orada dağılır. 
Mum, plastik, insan teni gibi materyaller oluştururken kullanılabilir. 

Subsurface Color kısmından ise Subsurface’in rengi ayarlanabilir. Bu renk ekleme işlemi ma-
teryal rengini değiştirmez. Sadece SS kanalına eklenen renktir. Materyal rengi ile SS rengini ka-
rıştırarak zengin bir materyal oluşumu yapılabilir. Örneğin ten rengine ışıklı bir alana gelindiğinde 
cildin kulak vs gibi ince bölümlerine  biraz pembelik eklemek gibi.

Radius kısmındaki renk alanını açarak Scatter değerindeki gölge koyuluk açıklık dengesi ayar-
lanabilir. Siyah, daha koyu Scatter alanı gölgesi-  beyaz daha açık Scatter alanı gölgesi oluşturur. 

Scale kanalından ise SS özelliğinin ne kadar artacağını belirlenir. Ten rengindeki ışık geçiren 
alanın genişliği ne kadar alanın pembe olacağı ve yarı saydam olacağı bu kısımdan ayarlanır.

Hazır Ayarlar:

Arnold materyalin içinde hazır materyal ayarları bulunmaktadır. Bu hazır materyaller sayesin-
de modelde ulaşmak istenen sonuca daha hızlı şekilde varılabilir. Materyal ayarları yapılan Att-
ribute Editor ayar alanından materyalin seçeneklerinin bulunduğu alanın üst kısmında bulunan 
Preset butonuna basarak hazır materyaller listesine ulaşılabilir.
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Krom, cam, araba boyası, altın, kil gibi materyallere bu sekmeden ulaşılabilir. Bu hazır ma-
teryallerin ayarlarını Subsurface, Transmision kanalları gibi kanal ayarları ile oynayarak ulaşmak 
istenen sonuca kısa sürede ulaşılabilir.

Oluşturulacak modellerde Arnold Render kullanırken bu esaslara dikkat ederek daha güzel so-
nuçlar elde edilebilir.

Karakterin materyallerini eklemeye deva edecek olursak;

 Saç kısmı için oluşturulan Alfa kanallarını eklerken. Attribute Editor alanındaki Materyal seçe-
neklerini alanından Geometry kısmı kullanılabilir. Bu alanda Opacity kanalına File görsel ekleme 
seçeneği ile alfa kanalını eklenebilir.

Alpha kanalı görseli eklendikten sonra mutlaka Attribute Editor alanından Shape node seçe-
neklerinden Arnold sekmesinden Opaque seçeneğinini kaldırılması gerekmektedir.  Saç tutam-
larının her biri ayrı obje durumundaysa hepsini seçerek Mesh > Combine ile birleştirip tek obje 
yapıp daha sonra Opaque seçeneğini kapatalım.

 

Saç modelini Combine yaptıktan sonra Edit > Delete By Type > History ile temizleyelim. Artık 
render alındığında Alfa kanalının aktif olduğunu ve Alfa kanalı dosyası sayesinde gerekli yerlerin 
geçirgen olduğu görülebilir.

Özetlenecek olursa; belirli alanlarının transparan olmasını istediğimiz objeye Materyal alanın-
dan Geometry Opacity sekmesinden alfa kanalı dosyası ekleyelim. Sonra da shape node alanın-
dan Arnold sekmesinden Opaque seçeneğini kapatalım.

Aynı işlemi Göz modelinin dış kısmını oluşturan saydam kısmı için de tekrarlanmalıdır. Saydam 
kısımları seçip yeni bir Arnold A.i. Standart Surface Materyali ekleyelim. Materyal seçeneklerin-
den Transmission > Weight seçeneğini “1” yapalım. Daha sonra da mutlaka Substance seçenekle-
rinden Arnold sekmesinden Opaque seçeneğini kaldıralım (ilk görsel). Aksi taktirde gözün saydam 
olan kısmı siyah parlak ve içini göstermeyen bir model olarak Renderda görünür. İşlemin sağlıklı 
olduğunu teyit etmek için render alarak sonuca ulaşılabilir.
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OPAQUE KAPALI İÇ GÖZ SPECULAR  KAPALIOPAQUE AÇIK

Gözün iç kısımlarında da gereksiz parlamalar bulunuyrsa (orta görsel), iç göz modelinin mater-
yalindeki Specular kanalının değerini düşürerek gereksiz parlaklıkları iptal edilebilir (sağ görsel).

Normal Map Ekleme;

Modelin diğer parçalarındaki kaplamalarda bulunan NORMAL MAP’ler de yine materyal kana-
lındaki Geometry kanalından Bump Mapping sekmesinden File seçeneği ile eklenebilir.

Eklenen dosyanın seçeneğini 2D Bump Attributes seçeneklerinden Use As alanından Bump se-
çeneğine tıklayarak Tangent Space Normals'ı seçelim. Bu sayede Substance’da oluşturulan mavi 
renkte olan Normal Map haritası kullanılabilir.  Daha sonra File seçeneklerinden İmport diyerek 
Normal Map dosyasını ekleyelim.

Specular kanalına da Roughness kaplamasını ekleyelim. Aynı işlemi vücut modeli için de uygu-
layalım.

Bu şekilde kaplama işlemlerini de tamamlanmış olur.
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ÜNİTE 5 - RİGLEME
RİGLEMEYE HAZIRLIK 
Oluşturulan modele uygun bir iskelet sistemi oluşturup bu sistemi model ile birleştirme işle-

mine Rigleme adı verilir. Bu sayede tasarımını yapılan karaktere istenen hareketler yaptırılabilir, 
animasyon film çalışmalarında kullanılabilir (Graft ve arkadaşları, 2002).

Bunun için öncelikle modellenen ve kaplamaları oluşturulan karakteri Riglemeye hazır hale 
getirip, sahneyi temizlemek ve sadeleştirmek gerekmektedir. Bu işleme başlamadan önce karak-
ter dosyasını farklı kaydederek yeni bir kopya üzerinde bu işlemleri yapmak hataları telafi etmek 
açısından faydalı olacaktır.

Gövde grubunun içinde bulunan; Gövde ve Kaşlar > Mesh > Combine ile birleştirilip tek bir 
obje haline getirelim. Saç, Gömlek, Pantolon, Dil modellerini bulundukları gruplardan ayırıp tek 
bir Polygon obje olacak şekilde Outline liste kısmından düzenleyelim.

Diğer parçaları; gözler; göz küresi ve saydam kısım olacak şekilde bir grup, dişler; üst dişler ve 
üst diş eti Combine ile birleştirilip tek bir Polygon obje, alt dişler ve alt diş eti ayrı bir Polygon obje 
olacak şekilde Combine ile birleştirelim.

Önceden oluşturulan Layer'ları silelim. Layer'ları silmek için Layer'a Sağ Mouse Buton ile tıkla-
yıp Delete Layer seçeneğini seçelim.

Gövde için  yeni bir Layer oluşturalım. Layer seçili  haldeyken Create a New Layer and Assign 
Selected Object seçeneğini seçelim. Aynı işlemi Kıyafetler, Gözler, Saç ve Ağız İçi modelleri için 
de yapalım.

 

Layer'ların çalışıp çalışmadığını denemek için Layer isimlerinin başında bununan “V” harfine 
basarak görünürlüklerini açıp kapatalım.



122

Son olarak da modellerin tamamını seçip Edit > Delete By Type > Delete History diyerek gerek-
siz bağlantı ve History bilgisinden kurtulalım.

Üst menüden Modify > Freeze Transformation diyerek de tüm koordinatlarını sıfırlayalım.

Böylelikle karakteri ve sahneyi Rigleme işlemi için hazırlamış olduk.

İSKELET SİSTEMİ OLUŞTURMA
Bacak iskelet sistemini oluşturma:

Öncelikle modelleme için kullandığımız Modelling menu set menüsünü Rigging olarak değişti-
relim. Bu sayede Rigleme ile ilgili üst menüleri aktive edilmiş olur.

Hazırlıklardan sonra üst menüden > Skeleton > Create Joınts seçeneği ile iskelet oluşturmaya 
başlanabilir.

İskelet sistemlerini oluştururken hangi 3D uygulama olursa olsun, front view, side view gibi 
tam profilden ya da tam karşıdan görünümlerde sistemi oluşturmak her zaman sağlıklı sonuçlar 
verecektir. Sadece perspektif çalışma alanı kullanılarak oluşturulan iskelet sistemleri animasyon 
sırasında sorunlara neden olabilir.

Yandan görünüm (side view) çalışma alanımızı tam ekran yapalım. İskelet sistemin oluşturma-
ya başlamadan önce çalıma alanının hemen üzerinde bulunan Shadıng  menüden X Ray Joints 
seçeneğini aktif hale getirelim. 

Bu sayede kemik sistemi oluşturulurken kemikler daha net görünebilir. İstenirse çalışma ala-

nının hemen üstünde bulunan simgelerden  simgesine basarak Gövde modeli Xray model 
yaparak da kolay çalışma imkanı oluşturabilirsiniz.

En üst menüden > Skeleton > Create Joınts seçeneği ile kemikleri oluşturmaya başlayalım. 
Kıyafetlerin bulunduğu Layer'ı “V” tuşuna basarak gizleyelim. Bu sayede daha hatasız çalışılabilir.

Kemikleri oluşturma sırası önemlidir. İlerleme sırası kalçadan başlayacak ve ayaklara doğru 
gidecek şekilde olmalıdır. Önce kalçada ekleminin olması gereken yere tıklayarak bacak üst kemi-
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ğini oluşturalım.  Diz kısmına doğru giderken düz bir çizgi üzerinde kemiği oluşturmamak önem-
lidir. IK sistemi oluşturduğumuzda bacağın diz kısmından doğru kıvrılması için kalçadan dize doğru 
hafif bir eğimle üst bacak kemiğini oluşturalım.

Önden görünüm ekranına geçerek oluşturulan bacak kemiğini sağ bacağın içine yerleşecek şe-
kilde Move Tool ile yerleştirelim. En üstteki kemikten tutulduğunda diğer kemikler de senkron 
şekilde yerinden oynamadan hareket edecektir. Önden görünüm panelinde de X Ray Joints seçe-
neğinin aktif hale getirilmesi gerekmektedir. 

Kemikleri bacağa orantılamak için döndürme işlemi yapılacaksa mutlaka Attribute Editor ala-
nındaki Joint alanındaki Joint Orient seçeneği kullanılmalıdır. Standart Rotation Tool ile döndür-
me işlemi Skin işlemi ve de animasyonda sorunlara yol açabilir. Bu kısımdaki değer girilecek ala-
na Sol Mouse Butonu ile tıkladıktan sonra Ctrl+Sol Mouse Buton basılı tutup sürükleyerek gerçek 
zamanlı olarak değerler değiştirilebilir.

Yeni bir kemik oluşturup bu kemiği de ayak kemiği olarak yerleştirelim. Yine yandan görünüm 
ekranını açalım. Dışarıda bir alana tıklayıp iki kemik parçasından oluşan bir ayak iskeleti oluştura-
lım.

Daha sonra ayak kemiğinin ilk oluşturduğumuz eklemini Move Tool ile tutarak bacak kemiği 

bilek eklemine Snap To Poınts  aktifken ile taşıyalım ve tam ekleme denk getirelim.
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Üstten görünüme geçerek ayağın açısına göre oluşturulan ayak kemiğini bu sefer Standart 
Rotate ile döndürerek ayak modelinin açısına uygun hale getirelim.

 

Kemikleri İsimlendirme işlemi Skinning bölümü için oldukça önemlidir. Bu yüzden kemikleri 
teker teker isimlendirmemiz gerekmektedir. Kemiğin yeri ve hangi kemik olduğunu isim kısmında 
belirtmek önemlidir.

Oluşturulanz Bacak Kemiklerine IK (Inverse Kinematics) eklemek:

IK sistemini bacaklarımızda bulunan Tendonlar gibi düşünebiliriz. Bu sistemler Rigleme özelliği 
bulunduran tüm modelleme programlarında bulunmaktadır. IK sistemleri sayesinde bacak kol gibi 
eklem alanları katlanma yönleri dışına dönerek katlanmaz ve animasyon çalışmalarında büyük 
kolaylık sağlarlar.

Bacak modeline IK oluşturmak için üst menülerden Skeleton > Create IK Handle seçeneğini 
seçelim.
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IK menüsü açıkken öncelikle üst bacak kemiğini sonra da bacak kemiğinin en altında bulunan 
bilek eklem kemiğini (tek yuvarlak parça) seçerek IK sistemini oluşturalım. Dikkat etmemiz gere-
ken konu kemiklerin seçim sıralamasıdır. Sıralamanın ters olması durumunda sistem yukarıdan 
aşağı yerine aşağıdan yukarı hazırlanacaktır ki bu da animasyon yapılmasını engeller.

Bilek eklemi sadece ufak bir top kemikten oluştuğu için seçim yaparken oldukça yaklaşmak 
gerekebilir. Doğru şekilde kemikleri seçerek oluşturulan IK sisteminden sonra Bacak kemiklerinin 
MOR renge dönüştüğü görülebilir.

IK sistemini oluşturduktan sonra ayak bileği ekleminden tutarak hareket ettirerek sistemin olu-
şup oluşmadığı kontrol edilebilir. Hareket halinde bilek ve kalça arasında yeşil bir çizgi halinde 
oluşan tendon görünüyorsa sistem başarılı bir şekilde oluşturulmuş demektir. Ayrıca IK Handle 
ismi ile Outliner menüsünden de seçme ve kontrol işlemini gerçekleştirilebilir.

Ayak kemikleri ile bacak kemiklerini Parent ile birleştirilmelidir. IK Handle ile bacak kemikleri 
hareket ettirildiğinde ayak kemiklerinin de takip etmesi için bu işlem gereklidir. 

Yine Seçim Sırası Parent işleminde de önemlidir. Önce ayak kemiklerini ilk ayak kemiğinden 
tutarak seçelim daha sonra bacak eklem kemiğini (top şeklinde olan) seçip üst menüden Edit > 
Parent diyerek Parent işlemini yapalım. IK Handle’ı Outliner listesinden seçerek bacağı hareket 
ettirdiğimizde ayak kemiklerinin de bacak kemikleri ile birlikte hareket ettiği görülebilir.

Karakterin sol bacağı ile ilgili işlemleri tamamladıktan sonra aynı işlemleri sağ bacak için de 
tekrarlanmasına gerek bulunmamaktadır. Simetrik iskelet sistemine sahip modelleri oluştururken 
Mirror seçeneği ile kemiklerin aynısı modelin diğer yanına kopyalanabilmektedir.
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İlk oluşturulan kalça kısmındaki üst bacak kemiğini seçelim. Seçim yapılınca kemiklerin tamam-
nını otomatik olarak seçildiğini görebiliriz. Üst menüden > Skeleton > Mirror Joints> seçenekler 
kutucuğuna tıklayalım. Açılan menüden  uygun koordinatları seçelim. 

Menüde ayrıca Search For ve Replace Wıth seçenekleri bulunmaktadır. Bu seçenekler sayesin-
de oluşturulan kopya kemikler isimlendirilebilir. Search For yerine kemiklerin eski ismini, Replace 
With kısmına da kemiklerin yeni ismi girilebilir. Örnek çalışmada Sol_ yerine Sağ_ seçeneklerinin 
kullanıldığı görülebilir.

 

Bu adımları izleyerek bacak kemiklerinin tamamının kopyasını simetrik olarak oluşturalım.

OMURGA KEMİKLERİNİ OLUŞTURMA
Omurga kemikleri, kalça kemiklerinin başlangıç noktası ile aynı hizada olmalıdır. Bunu be-

lirlemek için Mayada Locator kullanılabilir. Locator’lar Render'da görünmeyen genelde objeler 
ve kemikleri hareket ettirmeye ve yerlerini göstermeye yardımcı olan elemanlar olarak tanım-
lanabilir. After Effects programındaki  Null Object ya da 3Ds Max programındaki Helper ile aynı  
mantıkta çalışan objelerdir. 

Üst menü > Create > Locator diyerek objeyi sahnede oluşturalım.  Bacak kemiklerinin her ikisi-
ni ve Locator’u tutarak üste menüden > Constraint > Point Constraint diyerek kalça kemikleri ile 
Locator’u aynı hizaya getirelim.

Artık Locator’a yeni eklenecek kemiği yapıştırarak ortalı bir şekilde omurga oluşturulabilir.

Önden görünüm ekranına geçelim. Snap To Points seçeneğini aktif hale getirelim.  Üst 
menüden > Skeleton > Create Joınts seçerek oluşturduğumuz Locator’ın tam üstüne tıklayarak ilk 
omur eklemini oluşturalım ve hemen ardından Snap to Points seçeneğini kapatalım ki yanlışlıkla 
başka yerlere yapışarak omurgayı eğri oluşturmayalım. Daha sonra Shift tuşuna basılı tutarak dik 
bir şekilde yukarı doğru omurga kemiklerini oluşturalım.
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Göğüs kafesine kadar belden yukarı doğru iki adet omurga kemiği oluşturalım. Daha sonra 
göğüs kafesi olması  için de bir adet kemik yani toplam olarak 3 adet omurga kemiği oluşturalım. 
Kemik oluşturma işlemini sonlandırmak için seçme okunu seçerek işlemi tamamlayalım. 

Oluşturulan kemik sayısı tamamen modellenen karakterin şekline ve yapısına bağlı olarak 
değişiklik göstermektedir. Daha detaylı gerçekçi ya da farklı anatomilere sahip 3D karakterleri 
Riglemek için farklı sayıda ve uzunlukta kemikler oluşturulabilir.

Modele bakıldığı zaman bacak kemiklerinin yönlerinin aşağıya doğru, omurga kemiklerinin 
yönünün ise yukarı doğru oluğu görülebilir. Kemiklerin yönleri oldukça önemlidir.

Kalça kemiği ana kemik olduğu için ölçülerini büyütmek için Sağ menülerden Channel Box 
menüsündeki Radius sekmesi kullanılabilir.

Kalça kemiği olarak kullanılacak bir kemik daha ouşturalım. Bu Bacakları kontrol etme ve bir-
leştirme amaçlı kullanılacak olan kemiktir. Önden görünüm kısmında gövdenin dışında bir alanda 
omurga kemiğinin başlangıç kısmından aşağıya doğru uzanacak uzunlukta bir kemik oluşturalım.
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SNAP TO POINTS seçeneğini aktive edip omurga kemikleri başlangıç noktasına hizalayalım.

Hizalama işleminden sonra Bacak Kemikleri ve Kalça Kemiği’ni Parent ile birleştirilmesi gerek-
mektedir. Bunun için; Önce en üstteki Bacak kemiğini sonra da Kalça kemiğini seçip > Üst menü 
> Edit> Parent ile birleştirelim.

Otomatik olarak bir bağlantı kemiği oluşacak ve kalça kemiği ile bacak kemiği birleşmiş olacak-
tır. Ayni işlemi diğer bacak kemiği için de yapalım. Önce bacak kemiği sonra kalça kemiği seçip 
Parent yapalım.

Kalça kemiği tutup hareket ettirildiğinde tüm bacak kemikleri de aynı anda hareket ediyorsa 
işlem doğru yapılmış anlamına gelir.

Şimdi de bacaklarla birleşen Kalça kemiğini Omurgaya bağlanması gerekmektedir. Önce Kalça 
kemiğini daha sonra en alttaki kalça kemiğine yakın omurga kemiğini seçip Parent işlemini ya-
palım (Kısa yolu P)

Ana omurga kemiğini seçip hareket ettirdiğimizde bacak kemikleri de onunla beraber hareket 
edecektir.

Bel_kemigi’ni tutup rotate ile döndürdüğümüz zaman tüm kemikler aynı anda hareket edip 
dönüyorsa, Parenting işlemi başarılı olmuş demektir.
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Kemikleri isimlendirerek devam edelim. En üstteki Gögüs_kemigi hemen altındaki ikinci kemik 
Bel_kemigi, ana kemiği de Ana_kemik olarak Türkçe karakter kullanmadan isimlendirelim. Kalça 
kemiğini Kalca_kemigi diye isimlendirelim.

KAFA EKLEMİNİ OLUŞTURMA 
Yan görünüm ekranı kullanılabilir. Kafa kemiğinin yanında göz ve çene kemikleri oluşturulup 

bu kısımlar da hareket ettirmede kullanılabilir. 

Üst menü> Skeleton > Create Joint ile göğüs_kafesi kemiği noktasından yukarı kafa modeline 
doğru kemik oluşturalım. Göğüs kemiğinin en sonunda bulunan yuvarlak kemik ucu kısmına tıkla-
yarak kalınan yerden kemik oluşturma işlemine devam edilebilir.

Boyun ve kafa kemiklerini oluşturduktan sonra ayrı tek bir kemik olarak çene kemiğini, çene 
hizasında oluşturalım.  Dikkat edilmesi gereken konu başlangıç noktası olarak eklemden ayrı bir 
alana tıklayarak oluşturmak ve daha sonra kulak seviyesindeki ekleme Parent yapmaktır.
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Çene kemiği ve kafa kemiği eklemlerini hizalamak için Snap To Poınts seçeneğini aktif hale 
getirelim ve Move Tool ile hizalama yapalım.

Oluşturulan kemiklerin hepsini isimlendirmeyi unutmayalım. Cene_kemigi yazarak son kemiği 
isimlendirelim.

Önce çene kemiğini sonra kafa kemiğini seçerek Parent işlemini yapalım ve kemikleri birleştire-
lim. Bu sayede Kafa_kemik hareket edince çene kemiği de harekete edecektir.

Aynı işlemi göz hareketini sağlayacak kemikleri oluşturmak için tekrarlayalım. Ama önce göz 
küre gruplarını Outliner alanından seçelim ve odak noktalarını  > Modify > Center Pivot ile göz 
kürelerinin tam ortasına hizalayalım.



131

Üst menüden > Create > Locator oluşturalım. Önce göz küresinin grubunu Outliner kısmından 
sonra locater objesini seçip > üst menüden Constraint > Point seçeneğini seçerek Locator ‘ı tam 
göz kürelerinin ortalarına yerleştirelim.

Locator göz küresinin tam ortasına yerleştirildikten sonra Yan Görünüm’e geçelim.

Ceate Joint seçeneğini ve Snap to Points seçeneklerini aktif hale getirelim. Gözün ortasındaki 
Locator noktasına bir kez tıklayalım ve kemiği oluşturma işlemini başlatalım.  Shift tuşuna basılı 
tutarak göz bebeği hizasına tıklayarak kısa bir göz kemiği oluşturalım. Eğer düz kemik çizme işle-
mini engelliyorsa snap to points özelliğini kapatıp tekrar deneyelim. İşlem bittikten sonra kemiği 
Sol_göz_kemik olarak isimlendirelim.

Göz kemiğini sağlıklı bir şekilde oluşturduktan sonra Parent işlemi için: Önce Göz_kemik sonra 
Kafa_kemik sırası ile seçilerek “P” tuşu ile Parent işlemi yapılır. Parent işlemi yapılır yapılmaz 
otomatik olarak  göz kemiğini kafa kemiğine bağlayan bir bağlantı kemiği oluşacaktır.
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Sadece göz içinde bulunan kemiği seçelim ve üst menü > Skeleton > Mirror Joints seçeneği 
ile kopyasını diğer göz için oluşturalım. Mirror özellikleri kutusunda Search For ve Replace With 
seçenekleri yerine yeniden isimlendirme yapılabilir.

Kafa kemiğini Rotate ile döndürüldüğü zaman hem göz hem de çene kemiklerinin birlikte ha-
reket etmesi gerekir. 

KOL VE PARMAK KEMİKLERİNİ OLUŞTURMA
Kol modelinin tam ortasına denk gelecek şekilde kemikleri oluşturmak için Perspective çalışma 

alanını açalım. Oluşturulan kemikler tam kolun ortasına otomatik olarak hizalanması için gövde 
modelini seçelim. Gövdenin bulunduğu Layerı referans yaptıysak normal hale geri getirelim. Daha 
sonra üst ikon menü alanında bulunan Snap To Projected Center seçeneğini aktif hale getirelim. 
Üst menü Skeleton menüsünden Create Joints seçeneği ile omuzdan ele doğru 3 adet kol kemiği 
oluşturalım. Bunlar sırasıyla Üst kol alt kol ve bilek kemikleridir.

Daha sonra parmak kemiklerini elin avuç kısmından başlayacak şekilde oluşturalım. Oluştu-
rulan karakter insansı bir model ise her parmakta 3 adet kemik olacak şekilde parmak iskeletleri 
oluşturulabilir. Yine Snap to Projected Center özelliğini aktive ederek oluşturalım. Ayrıca bize mo-
deldeki eklem Edge'lerini göstermesi açısından Wireframe görünümü de açabiliriz. Tüm parmak-
lara kemikleri yerleştirelim.
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Parmak kemikleri oluşturulduktan sonra kemiklerin doğru kapanma hareketini yaptıklarından 
emin olmak için test edilebilirler. Bu sayede Skinning adı verilen ve iskelet sistemi ile modelin bir-
birine eklenmesi işlemi düzgün bir iskelet sistemi ile gerçekleştirilmiş olur.

Parmak kemik sistemini denemek için kemiklerin tamamını ilk oluşturduğumuz kemikten tu-
talım ve daha sonra Shift tuşuna basılı tutarak ikinci ve üçüncü kemikleri seçelim. Seçim işlemini 
doğru yaparsak ilk ve ikinci kemik beyaz son kemik ise yeşil olacaktır. Daha sonra Rotate Tool’u 
seçip kemiği avuç içine doğru döndürelim. 

 

Kısacası parmağın yumruk şeklinde kapanmasını test edelim. Kapanan parmak kemiklerini eski 
haline getirmek için Ctrl+Z geri alma işlemini kullanılabilir. Her parmağı tek tek test edelim. Eğer 
parmak kemik sistemini düzgün oluşturulduysa parmakların tamamı içeri doğru kıvrılarak kapa-
nacak ve el yumruk şeklini oluşturacaktır. Eğer kemikler elin kapanma yönü dışında farklı yerlere 
doğru kıvırılıyorsa bir sorun var demektir. Böyle durumlarda parmak kemiklerini silip yeni baştan 
yapmamız gerekmektedir.

Tüm parmakları denedikten ve kıvırılma durumlarını onayladıktan sonra bilek eklem kemiğine 
Parent işlemi yapmalıdır. Bu sayede otomatik olarak avuç içi kemikleri de oluşturulmuş olur.

Önce parmak kemiklerini ilk oluşturalım, sonra da el bilek kemiğini seçerek “P” tuşu ile Pa-
rent işlemini yapalım. Otomatik olarak bir kemiğin daha oluştuğu görülebilir. Tüm parmak kemik-
leri için aynı işlemi yaparak bilek ile birleştirelim. 

Kol ve el kemik sistemini oluşturduktan sonra IK sistemini yaparak kol kemiklerini animasyona 
uygun hale getirelim. IK Handle oluşturmak için üst menü> Skeleton > Create IK Handle seçene-
ğine tıkladıktan sonra önce omuz kemiğini sonra da bilek kemiğini seçelim. Bu işlemi sırasıyla 
yaptıktan sonra otomatik olarak kemiklerin mor renge dönüştüğünü ve bilek kısmında "+" şeklin-
de bir yardımcı tutma objesi oluştuğu görülebilir. Bu “+” şeklindeki Handle’ı tutup kolu hareket 
ettirerek dirsek kısmından kıvırılıp kıvırılmadığı test edilebilir.
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Kol kemiklerini isimlendirme işlemini yapalım. sol_ust_kol_kemik şeklinde isimlendirerek han-
gi tarafın  hangi kol kemiği olduğunu belirtelim ve devamında gelen kemiklere de aynı isimlendir-
me tekniği ile isimlendirelim, sol_alt_kol_kemik, sol_bilek_kemik gibi. Parmak kemiklerini ise 
sol_basparmak_kemik_1 sol_basparmak_kemik_2 diye sıralı şekilde isimlendirelim.

Köprücük kemiği oluşturarak kol kemiğini gövdeye bağlanması gerekmektedir. Bu sebeple gö-
ğüs kemiğinin orta kısmından başlayıp yukarı omuz kemiğine doğru 45 derecelik bir açıyla uzanan 
köprücük kemiğini oluşturalım. Snap To Poınts seçeneğini aktif duruma getirip ve karşıdan görü-
nüm ekranında oluşturalım.

Köprücük kemiğini oluşturup omuz kemiğine Snap To Point ile hizaladıktan sonra göğüs kemi-
ğine Parent işlemi yapılmalıdır. Bunun için önce köprücük kemiğini sonra göğüs kemiğini seçerek 
“P” tuşu kısa yolu ile Parent işlemini gerçekleştirelim. Bu işlemden sonra arada bir bağlantı kemiği 
oluşacaktır. 

Köprücük kemiğini ayrıca Üst_Kol_Kemik ile de Parentlayarak bağlanması gerekmektedir.

Bunun için önce üst kol kemiğini daha sonra da Köprücük kemiğinin kendisini değil omuza en 
yakın yerdeki yuvarlak uç kısmını seçerek “P” Parent işleminin yapılması gerekmektedir.

Şimdi oluşturduğumuz köprücük ve kol kemiklerini Mirror ile diğer kol için kopyalayalım.

Köprücük kemiği seçildiği zaman tüm kol kemiklerinin seçildiğini görebilirsiniz. Fakat önce kol 
ve köprücük kemiklerinin tamamını “sol_” başlangıcı ile isimlendirelim. Örneğin Sol_üst_kol_ke-
mik. Bu şekilde isimlendirilmiş kemiklerin tamamı seçiliyken üst menü > Skeleton > Mırror Joınts 
seçenekler kutucuğuna tıklayarak seçenekler penceresini açalım. 
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Bu alandan isim kutucuğuna üste Search For alanına “Sol” alt kısma da Replace With alanına 
yeni kemikler sağ tarafa oluşturulacağı için “Sağ” yazalım ve Mirror seçeneğini seçelim.  

Kopyalanan kol kemiklerinde IK Handle kopyalanmaz. Bu yüzden tekrar yeni oluşturduğumuz 
kemiklerin IK Handle’larını oluşturmamız gerekmektedir. Üst menüden > Skeleton > Create IK 
Handle’a tıkladıktan sonra omuz eklemi yuvarlağına sonra da bilek eklemi yuvarlağına tıklayarak 
IK Handle’ı oluşturalım. Doğru oluşturduğumuz taktirde kemikler mor rengi alacaktır.

Bununla birlikte "4" adet IK Handle oluşturmuş oluyoruz. 2 kolda 2 de bacak kısmına bulun-
maktalar. Bunları da sağ ve sol olarak isimlendirelim.

Bu şekilde iskelet sistemini oluşturulmuş bulunmaktadır. Modeli iskelet sistemi ile birleştirmek 
ve iskeletin hareketleri ile modelin belirli alanlarının hareket edebilmesi için Skinnıng işlemi yapıl-
ması gerekmektedir.

SKINNING (Modeli iskelet sistemine giydirme)
Ana kemik diye tabir ettiğimiz tüm kemiklerin birleştiği kemik seçildiğinde oluşturduğumuz 

kemiklerin tamamı otomatik olarak seçili hale gelir. Bu şekilde ana kemiğe tıklayarak kemiklerin 
tamamı seçiliyken Shift tuşuna baslı tutarak Karakter Model’i seçelim.

 

Üst menülerden Skin> Bind Skin seçeneğini kutucuğuna tıklayalım. Bu kısımdaki seçenekler-
den Max Influences kısmından her kemikteki kapsama alanı ayarlanabilir. Modele ve kemiğe göre 
değişkenlik gösterebilen bu ayar için şimdilik “2” değeri girelim. Girilen değerin fazla olup olma-
dığını kontrol etmek için Binding işleminden sonra kol ve bacakları hareket ettirerek kemiklerin 
kapsama alanı test edilebilir. Eğer bir kolu IK Handle kullanarak hareket ettirirken kafa ya da bacak-
larda sünme ve esneme modelde bozulmalar oluyorsa girdiğimiz değer fazla demektir.
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Kafa kemiği hareket ettirildiğinde saçların ve gözlerin hareket etmediği görülebilir. Saç modeli-
nin kafa ile hareket etmesini sağlamak için önce kafa kemiğini daha sonra da saç modelini seçe-
lim. Üst menülerden > Skin > Bind seçenekler kutusunu açalım. Bu sefer en üstte bulunan Bınd To 
seçeneğini Selected Joınts olarak seçelim. Kafa kemiği hareket ettirildiği zaman saç modelinin de 
kafa ile birlikte hareket ettiği görülebilir.

Aynı işlemi gözler için yapalım ama kafa kemiği yerine göz içinde bulunan kemikleri seçelim. 
Önce Göz içi kemikleri sonra göz küresi grubunu Outliner alanından seçelim ve aynı Bınd To > Se-
lected Joınts seçeneğini tekrarlayalım. Kafa kemiğini hareket ettirdiğimizde gözler ve saç modeli 
de kafa ile birlikte hareket etmelidir.

Alt damak ve üst damak modellerini de aynı şekilde Bind To Selected Joints seçeneği ile bir-
leştirelim. Fakat üst damak modelini > Kafa Kemiğine, alt damak modelini ise > Çene Kemiğine 
Bind Selected Joints  ile birleştirelim.

Böylelikle tüm kemikler karakter modeline gerekli alanlara Skinning ile bağlanmış oldu. El ba-
cak ve kolları hareket ettirildiğinde istenilen alanlar dışında da modelde bozulmalar esnemeler 
olacaktır. Bunlar da Paint Weights işlemi ile düzenlenebilir (Graft ve arkadaşları, 2002).

KEMİKLERİN KAPSAMA ALANLARINI AYARLAMA (Paint WEIGHTS)
Karakterin iskelet sisteminde kol ve bacaklarda oluşan gereksiz alanlara taşan kapsama alanları 

model üzerinde boyayarak ayarlanabilir. Örneğin sol alt bacak kemiğinin etrafını kaplayan modeli 
boyayarak o kemiğin sadece o parçaya müdahale etmesi sağlanabilir. Bu ayarlama işlemine Ma-
ya’da Paint Weight denmektedir.

Ayrıca Humanoid diye tabir ettiğimiz insansı ve Quadruped diye tabir edilen 4 bacaklı hayvan 
modellerinde de simetrik bir yapı varsa sadece sağ ya da sol tarafı Paint Weight ile ayarlanıp daha 
sonra bu ayarlar simetrik olarak diğer yarısına yansıtılabilir. 

İşlemi yapmak için Sol_alt_bacak_IK Handle’ını seçelim ve bacak modelimizi yukarı doğru kal-
dıralım. Dizden kırılan bacak modelinde bozulmaları tespit edelim. CRTL+Z ile geri alarak modeli 
eski haline getirelim.
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Bozukluk tespit edilen modelin parçalarını düzenlerken Keyframe'ler atarak kolay çalışma im-
kanı yaratılabilir. Örneğin Keyframe atmadan kıvırdığımız bacak kemiği üzerinde Paint Weight ile 
çeşitli işlemler yaptıktan sonra bacağı eski yerine getirmek olanaksız olacaktır. Fakat Keyframe 
atıldığı zaman işlemlerden sonra Timeline alanında başlangıç zamanına geri gelindiğinde model 
düzenlenmiş hali ile eski durumunu alacaktır.

Keyframe uygulaması yapmak için öncelikle eğer Tımelıne alanı açık değilse üst menü > Wın-
dows > UI Elements > Tıme Slider seçeneğini aktif hale getirelim.

Time Slider’ın “0.” saniyede olduğundan emin olalım. Ayak bileğindeki IK Handle’ı seçelim ve 
daha sonra Shift+W tuşlarına basarak sıfırıncı saniyeye xyz koordinatlarında ilk Keyframe'i ata-
lım. Ayak IK Handle’ı yukarı doğru hareket ettirerek bacağın diz kısmından kıvrılmasını sağlayacak 
bir hareket yapalım. Daha sonra Time Slider alanında "15". kareye gelelim ve Shift+W kullanarak  
bir Keyframe daha atalım. 

0. ve 15 kareler arası Timeline Slider’ı hareket ettirerek karakterin bacak kaldırma  hareketi 
yaptığından emin olalım. 

Skin Weight yapmak için; ,karakter  modeli seçelim, üst menüden >  Skin > Paint Skın 
Weights seçeneğinin yanındaki seçenekler kutucuğuna tıklayalım. Skin Paint seçenekler pencere-
si açılacak ve karakterimiz siyah beyaz renk alacaktır.

Paint Weights listesinde bulunan kemikler bizim yaptığımız isimlendirmeye göre görünecektir. 
Bu yüzden kemikleri doğru isimlendirmek önemlidir.  Kemik listeden seçildiğinde karakter üzerin-
de o kemiğe bağlı olan alanlar Beyaz renk ile gösterileceklerdir. Siyah alanlar ise kemiğin kapsama 
alanı dışındaki alanlardır. Gri alanlar ise yumuşak geçiş yapılan alanlardır.
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Bir kemiğin kapsama alnını belirlemek için model üzerinde fırça ile boyama işlemi yapılması 
ve kapsamak istenen alanın beyaz renge dönüştürülmesi gerekmektedir. Bunun için açılan Paint 
Weights menüsündeki Paint Operatıon alanından Replace seçeneği seçiliyken model üzerinde  
esneme ve sünme olan kısımlara boyama yaparak kapsama alanı genişletilebilir . Beyaza bo-
yanan alanların bacak kemiğine doğru yapıştığı görülebilir. Eğer bu müdahaleleri kontrol etmek 
zorlaşıyorsa Opacity ve Value alanlarından değerleri düşürerek hassasiyet ayarı yapılabilir.

Hızlı çalışmak için CTRL tuşuna basılı tutarak "ekleme yapma" seçeneğini "çıkarma yapmaya" 
çevirerek eklenen alanları silebiliriz. Klavyeden “B” tuşuna ve Sol Mouse Buton’a basılı tutarak 
fırça ucu kalınlığı ayarlanabilir.

Smooth seçeneği ile Polygon'lardaki köşeli alanları yumuşatarak modelin eklem kısımlarındaki 
kıvırımlarda yumuşama sağlar. Sol menüdeki beyaz seçme okuna basarak Pain Weight işlemini 
sonlandıralım. Modeli kaplamalı ve kaplamasız olarak Timeline alanını ileri geri yaparak ve mode-
lin etrafında gezinerek düzenlemeleri kontrol edelim. 

Daha hızlı bir çalışma için model üzerinden kemikleri seçmek için istediğimiz kemiğin üzerinde 
gelip  Sağ Mouse Buton’a basılı tutarak Select Influence seçeneği ile kemik seçilebilir.

Sırası ile üst bacak alt bacak kısımlarını yaptıktan sonra, bacakta oluşturulan animasyon Key-
frame'lerini silerek yine aynı bacağın altında bulunan ayak kemikleri için de Paint Skin Weight 
ayarlaması yapalım.

Ayak modelinin en cunda bulunan kemik parçasını seçelim ve Rotate ile ayağı yukarı doğru 
kıvırarak 15 karelik bir Keyframe animasyonu verelim.

Üst menü > Skin > Paint Weight seçeneğini seçelim. Ctrl + Sağ Mouse Buton ile Ayak_Ön_Ke-
mik seçelim ve kemiğin kapsayacağı alanı model üzerinde boyayalım. Aynı işlemi Sol_ayak_Arka_
kemik te de yapalım. Eklem kısımlarını da Smooth ile yumuşatarak Polygon'ların kırılmasını en-
gelleyelim.
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SKIN AYARLARINI MIRROR İLE DİĞER BACAĞA YANSITMAK İÇİN 

Karakter modeli seçelim: üst menü > Skın > Mırror Skın Weights seçenekler kurusuna basarak 
seçenekler ekranını açalım. Uygun koordinatlar seçiliyken Mirror butonuna basalım. Diğer bacağı 
IK Handle dan tutarak hareket ettirelim ayrıca ayak kemiklerini de Rotation ile oynatarak  yaptığı-
mız Paint Weight ayarlarının diğer bacağa aktarılıp aktarılmadığını kontrol edelim.

Kol kısmının Skin ayarlarını yapmak için: Bilek kısmında bulunan IK Handle’ı tutarak kolu geri-
ye ve içeriye doğru kıvıralım. Bu kıvırma işlemin, aynı bacak bölgesinde yapıldığı gibi Keyframe'ler 
vererek kaydedelim. Üst menü > Skın> Paint Skın Weights seçenekler kutusundan paneli açalım. 
Listeden üst kol kemiğini seçerek modelde ilgili alanı boyayarak deformasyonları giderelim.  

Çalışma kolaylığı olması açısından; Paint Menu’de Paint Opertions alanında Replace  seçeneği 
aktifken modelde boyama yapabilir, beyaz boyanan alanları silmek ve siyaha döndürmek için 
Ctrl tuşuna basılı tutularak boyama yapabilir ve geçiş alanlarını yumuşatmak için Shift tuşuna 
basılı tutarak geçiş sağlanabilir. Ayrıca Opacıty ve Value alanından fırça basınç ayarları azaltarak 
hassas çalışma imkanı oluşturulabilir. Koldaki düzenlemeler bittikten sonra animasyonları Delete 
Keyframes ile silelim

PARMAKLAR İÇİN: Avuç kısmına en yakın olan ilk parmak kemiğini seçip ikinci kemiği Shift tu-
şuna basılı tutarak seçelim. Bu sayede parmaktaki kemikler Rotate ile döndürüldüğünde kıvrılma 
hareketi yapacak şekilde seçilmiş olur. Rotate ile seçili parmağı içeri doğru kıvıralım ve deformas-
yon olup olmadığını her kemiği ayrı ayrı seçerek kontrol edelim. Boyayarak ayarlamaları yapalım.

 

Tüm parmakların Paint Skin Weight işlemleri bittikten sonra parmakların tamamına Rotation 
ile Keyframe animasyonu verip  Mirror işlemi öncesi son kontrolleri yapalım.
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Herhangi deformasyon görüntüsü yoksa parmaklardaki Keyframeleri Silip köprücük kemiğine 
geçilebilir. Birbirine bağlı kemiklerin animasyonlarını silmek için kemik sırasını önce ilk kemiği 
sonra ikinci kemiği Shift’e basılı tutarak seçelim.  Channel Box Layer editor alanındaki Rotate 
satırına sağ tıkla açılan menüden Break Connectıons seçeneğini seçelim. Bu sayede birbirine bağlı 
olan kemiklerdeki animasyonlar silinecektir.

Köprücük kemiğine verdiğimiz Rotatıon animasyonu nedeni ile deforme olan alanları bacak ve 
kol kısımlarında uyguladığımız tekniklerle düzenleyelim.

  

Omuz kemiğinin de ayarlarını yaptıktan sonra model seçili durumdayken tekrar üst menü > 
skin > mirror skin weight ile ayarları karşı tarafa aktaralım. Mirror işleminden sonra aktarılan ta-
raftaki kemikleri hareket ettirerek kontrol etmek gerekmektedir. Hata olan yerler manuel olarak 
sadece o kısımda düzeltilebilir.

BAŞ KISMI İÇİN: Diğer vücut parçalarında yaptığımız gibi boyun kemiğini seçerek Rotate ile baş 
kısmında bir animasyon oluşturalım. Daha sonra Paint Skin Weights seçenekler kutusunu açıp 
listeden boyun kemiğini seçelim. ve kapsadığı alandaki deformasyonları boyayarak düzeltelim.

Boyun kemiğindeki işlemler bittikten sonra kemikteki Keyframe animasyonları silelim. Daha 
sonra kafa kemiğini seçerek > Rotation ile animasyon > Paint Weight > Kafa Kemiği seçiliyken 
oluşan kapsama alanını deformasyonları düzenleme şeklinde işlemimize devam edelim.

Kafa kemiği kafanın tamamına müdahale eden bir kısım olduğu için kafa modelinde grilik ya 
da siyahlık kalmayacak şekilde tamamını beyaza boyayarak Paint Weight uygulayalım. Bunun için 
önceden kafada bulunan saç modelini seçip > üst menü > Display > Hide > Hide Selection diyerek 
seçili saç modelini gizleyelim. Bu sayede kafa kemiğinin kapsadığı alanlar daha rahat görülebilir.
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Burun kısmının altından üst dudak ve damağın üst kısmını alacak şekilde beyazla boyayarak 
kafa kemiğine bağlayalım. Çene de dahil olmak üzere boyuna kadar olan kısmı Paint Weight ile 
beyaza boyamadan siyah bırakılması gerekmektedir. Bu kısım çene için oluşturulan Çene Kemiği 
ile birleştirilecektir.

Ağız modelinin içeri doğru olan ağız içi alnının sadece üst damak kısmını kafa kemiğine bağla-
yacak şekilde Paint Weight ile beyaza boyanması gerekmektedir. Çene kemiği aşağı doğru hareket 
ettirildiğinde ağızın açılması için bu gereklidir. Aksi halde üst damak da çene kemiğiyle aşağı ine-
cek ve ağız kapalı kalacaktır.

Daha sonra kafa kemiği animasyonunu silelim ve oluşturduğumuz alt çene kemiğini ağız açma 
hareketi yaparak keyleyelim. 

Damağın üst kısmını kafa kemiğine Paint Weight ile birleştirdiğimiz için çene kemiği hareketi ile 
modelimizin ağız kısmı açılacaktır. Oluşan deformasyonları ve keskin Polygon esnemelerini Paint 
Weight aktifken Shifte basılı tutarak yumuşatarak giderelim.

Paint Weight yaparken dikkat edilmesi gereken konu Edge’lerin keskin açılarla ilerlememesidir. 
Mümkün olduğunca düz bir çizgide hafif eğrilerle devam eden Edge’ler (Polygon kenarları), model 
üzerinde oluşturulan kaplamaların Pixel'lerinin esnemesini ve bozulmasını engeller. Aynı zamanda 
animasyon halinde modelin bütünlüğünün korunmasını sağlar. 

Aşağıdaki görsellerde Paint Weight Smooth özelliği ile düzlem haline getirilen Polygon görün-
mektedir.
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Kemiklerin kapsama alanlarını diğer kemiklerin kapsama alanları ile kaynaştırmak için Paint 
Weight ayar menüsünden > Paint Operation = Add > Value ayarını düşürerek geçiş yerleri daha 
kusursuz şekilde yumuşatılabilir.

Çene kemiği ile ilgili ayarlamalardan sonra sırası ile sağ göz ve sol gözde de aynı işlemleri tek-
rarlayalım. Göz kemiklerinin gövde modelinde herhangi bir alana etki etmiyor olduğundan emin 
olalım. Yani göz kemiği ve kemik ucundaki yuvarlak eklem seçildiğinde modelin tamamı siyah 
olmalıdır. Bir kemiği model ile bağlantısını kesmek için Value değerini “0” yapıp  Fload Butonuna 
basmamız gerekir. Bu sayede kemiğin modelle bağı her alanda sıfırlanır.

Boyun, kafa, çene ve gözle kemiklerinin kapsama alanlarını ayarladıktan sonra kemikleri rotate 
ile oynatarak son kontrolleri yapalım.

KONTROL ARAÇLARINI OLUŞTURMA 
Yerleştirilen iskeleti daha kolay kontrol etme amaçlı geometrik şekillerden oluşan kontrol ob-

jeleri oluşturulur. Bu sayede karakterin animasyonunu daha kontrollü bir şekilde hazırlanabilir. 
Kontrol araçları sayesinde aynı bir kukla oynatıcının tahta çubukları ile kuklasını oynatması gibi 
modelin belirli yerlerine hareket verilebilir.

Genellikle Nurbs ya da Spline adı verilen şekil araçları kullanılır. Bu modelde ilk kontrol ara-
cını oluşturmak için üste menü > Nurbs Primitives > Circle seçeneğini seçelim. Modelin hemen 
altında sıfır noktasında bir daire oluşacaktır. Bu dairenin Ctrl+D ile bir kopyasını daha oluşturalım 
ve modeli çevreleyecek kadar büyütelim. Büyütülen kontrol objesini isimlendirelim. Ana_kontrol 
olarak isimlendirilen kontrol objesi tüm modelin hareketini sağlayacaktır. Tüm değerlerini sıfır 
olması gerektiği için kontrol dairesini seçip üst menü > Modıfy > Freeze Transformations ile Scale 
değerlerini başlangıç değeri olan 1’e dönüştürelim.
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İskeleti Ana_Kontrol’e linklemek için; Öncelikle kol ve bacak bileklerinde bulunan 4 adet IK_
Handle’ı Outliner alanından seçelim ve Ctrl+G ile grup haline getirelim ve IK_Grup olarak isim-
lendirelim. Daha sonra grup halindeki IK Handle’ları Outlinler alanında orta mouse butona basılı 
tutup sürükleyerek oluşturulan Ana_Kontrol objesinin üstüne bırakalım. Bu sayede sahnede se-
çilen Ana kontrol dairesi Move Tool ile hareket ettirildiğinde kolar ve bacakların IK_Handle’ları da 
hareket edecektir.

 

İskelet sisteminde bulunan kalça kemiğinin üstünde bulunan Ana_kemik’i seçip aynı şekilde 
Outliner alanında Orta Mouse Butonu ile sürükleyerek Ana-Kontrol alanına taşıyalım.

Taşıma işleminden sonra Ana_kontrol objesini Move Tool ile hareket ettirdiğimizde karakteri-
miz iskelet sistemi ile birlikte hareket edecek, Scale tool  ile büyütüp küçülecektir.

Ana kontrol ünitesini bu şekilde oluşturduktan sonra önceden oluşturduğumuz Locator objele-
rini de Outliner alanından seçerek silebiliriz.

GÖĞÜS ALANI KONTROLERİ OLUŞTURMA
Nurbs Prmitives menüsünden yeni bir Circle oluşturalım ve Scale ile büyütelim. Gövde mo-

delini Layer kısmından ya da üst menü Display alanından gizleyelim. Karşıdan görünüm çalışma 
alanındayken Snap To Poınts seçeneğini aktive edelim. Daha sonra yukarı göğüs hizasına çekelim. 
Göğüs kemiği eklemine tam hizalayalım. Kontrol objesi Circle ve Göğüs kemiği odak noktaları 
aynı hizada olacaktır.
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Gövde modelini görünür hale getirelim. Göğüs kafesi kontrol objesini bir önceki kontrollere 
yaptığımız gibi Modıfy alanından Freeze Transform ile sıfırlayalım. Gogus_kontrol olarak isimlen-
direlim.

Kontrol objemizi göğüs kemiğine Constraint ile linkleyeceğiz. Bunun için Önce Kontrol Objesi 
Daire Nurbs daha sonra Shift’e basılı tutarak Göğüs Kemiğini model üzerinden seçelim.

Üst menü > Constraint > Orıent Constraint seçenekler kutucuğuna basarak Orient Constraint 
menüsünü açalım. Açılan menüde > Maintaın Offset kutucuğunu işaretleyelim. Aksi taktirde mo-
del kontrol objesi hizasında eğilecektir.

Kontrol objesini Rotate ile döndürerek Göğüs kemiğine hareket verip vermediği kontrol edile-
bilir.

Kontrol objesinin Rotate kanalında mavi key rengi o objenin Constraint uygulanmış obje oldu-
ğunu gösterir.

Kalça Kemiği Kontrolörü oluşturmak için de Göğüs Kemiği için yaptığımız işlemleri tekrarlaya-
lım.

Üst menü > Create > Nurbs Primitives > Cırcle > Scale ile büyütelim ve ismini Kalca Kontrol 
olarak değiştirelim. > Snap To Poınts aktifken Ana Kemiğin Uç Kısmına hizalayalım. > Modify > 
Freeze Transform >  önce Kontrol Objesi sonra Shift’e basılı tutarak Ana Kemik seçilip > üst menü 
> Constraint > Orient Constraint ile linklenecekler.

Deneme için kontrol objesi ile Rotate yapılarak modelin hareketleri kontrol edilebilir.

Rotate işleminde de görüleceği üzere karakter modelinin kalça kısmı hareket ederken üst kı-
sım bağımsız olarak sabit durmaktadır. Bu durumu düzenlemek için Önce Göğüs Kontrol Objesi, 
Shift tuşuna basılı tutarak Kalça Kontrol Objesini Tutup > Üst Menü > Edit > Parent ile birbirine 
Parentlayarak birleştirme işlemi uygulayalım. Bu sayede sadece Kalça Kontrol objesini döndüre-
rek Göğüs Kontrol objesini de beraberinde hareket ettirmiş oluruz.
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Kalça kontrolü için bir Circle Spilne daha oluşturup kalça kemiğine hizalayalım. Bir kopyasını 
oluşturalım. Bu alanda Ikı Adet Kontrol Objesi olacaktır.

İç kısımdaki kontrol objesi kalçayı Rotate ile döndürüldüğünde kontrol edecek. İç kısımdaki 
halkayı seçelim Freeze Transform uygulayalım. Halka seçiliyken Aşağı Doğru bakan Kalça Kemiği-
ni seçelim bu sayede bacak kemikleri de seçilmiş olacak. Ve birbirine Orient Contraint ile birleş-
tirelim.

Kontrol objesi daireyi rotate ile döndürünce kalça sağa sola doğru dönecektir.

Dış kısımdaki büyük kontrol daire objesini ise kalça kemiğinin üstündeki ilk omurga kemiği Ana 
Kemik ile (seçilince tüm iskeletin seçili hale geldiği kemik) birleştirelim. Bunun için Parent Cons-
traint kullanalım. Önce kontrol objesi sonra Ana Kemik seçelim > Constarint Menu >  Parent 
Constraint.
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Kontrol objesini seçip aşağı doğru Move Tool ile hareket ettirildiğinde karakter dizlerinden 
kıvrılarak yere çökecektir.

 

Ana Kemik Control objesi ile diğer kontrol objelerini de ayrı ayrı Parent'lanması gerekmekte-
dir. Bunun için önce ilk olarak Göğüs ve Orta Omurga kontrol objelerini Ana Kemik Kontrol obje-
sine Parent'layalım. Göğüs kontrol Orta omurga kemiğine zaten Parent'lı olduğu için sadece önce 
Orta Omurga Kontrol Objesini tutup Ana Kemik Kontrol Objesini Shift tuşuna basılı tutarak seçip 
> üste Edit Menu > Parent (P kısa yolu) ile Parent'layalım.

Daha sonra da içte kalan kalça kemiğine bağlı olan kontrol objesini seçip daha sonra da Ana 
Kemık Kontrol Objesini seçip Parent ile birleştirelim.

 

Sonra da önce içte kalan kalça kontrol objesini sonra dışta kalan Ana Kontrol objesini seçip > 
Edit >Parent (P) ile Parentlayalım.

Göğüs ve kalça kontrol objelerini hareket ettirerek model üzerinde oluşan deformasyonları 
Paint Weights kullanarak giderelim.

KAFA VE BOYUN KONTROL OBJESİ OLUŞTURMA
Daire şeklinde kontrol Spline oluşturup boyun kemiğinin olduğu eklem alanına Point Snap ile 

hizalayalım. Freeze Transform ile sıfırlayalım.
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Önce Boyun Kontrol Objesini sonra Boyun Kemiğini sırayla seçip üst menü > Constraint > 
Orıent Constraint ile birleştirelim.

Bir kontrol objesi daha oluşturalım onu da kafa kemiği ile point ile hizalayalım. Freeze Trans-
form ile sıfırlayalım.

Önce kontrol objesi sonra Kafa Kemiği seçip > Constraint > Orient Constraint ile birleştirelim.

Constraint işleminden sonra kontrol objesinin yerini şeklini değiştirmek istersek obje seçi-
liyken Vertex moduna gelip tüm Vertex'leri seçip o şekilde taşıma işlemini yapmamız gerekir. Bu 
sayede odak noktasının yeri değişmez ama objenin yeri değişir.

Çene Kontrol objesi için:

Bir Daire Spline daha oluşturalım çene kemiğine yakın olacak şekilde hizalayalım ve dairenin 
cephesi karaktere bakacak şekilde rotate ile döndürelim. Daha sonra da “D” tuşuna basıp Point 
Snap ile odak noktasını çene kemiğinin eklem noktasına hizalayalım. Kontrol objesi dışarıda kalır-
ken odak noktası kemiğin eklemine hizalanmış olacak.

Freeze transform ile sıfırlayalım. Önce Çene Kontrol objesi sonra çene kemiğini seçelim ve 
ORIENT Constraint ile linkleyelim. 

Önce Çene Kontrol Objesi sonra Kafa Kontrol Objesini seçip > Edit > Parent ile Parentlayalım.

Daha sonra Önce Kafa Kontrol objesini sonra da Boyun Kontrol objesini seçip > Parent işlemi 
yapalım.

Boyun kontrol objesini rotate ile hareket ettirince kafa ve çene kontrol objeleri de hareket et-
melidir.
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Göz Kontrol Objelerini Oluşturmak:
Üst Menü > Create > Nurbs Primitives > Circle ile bir daire oluşturalım. Büyüterek kafa mode-

line ortalayalım ve karakterimizin göz hizasına taşıyalım.

Freeze Selection ile değerlerini sıfırlayalım ve Attribute Editor alanında yeniden isimlendire-
lim. CTRL_Gozler şeklinde isimlendirebiliriz.

Önce Göz kontrol objesi olan daireyi seçelim, daha sonra da sağ göz küresinin içinde bulunan 
göz kemiğini seçelim. Üst menü > Constraint > Aim Constraint seçeneğinin yanındaki kutucuğa 
basalım ve açılan menüden; Mantaın Ofset kutusunu aktive edelim ve Add butonuna basarak 
işlemimizi tamamlayalım.

Aynı işlemi Diğer göz için de yapalım. Önce kontrol objesi sonra göz kemiği seçelim, üst menü 
> > Constraint > Aım Constraint > mantain offset aktifken > Add. Bu sayede kontrol objemizi sağa 
sola move tool ile hareket ettirdiğimizde gözler de hareket ediyor olmalı.
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KÖPRÜCÜK KEMİĞİ VE BİLEK KONTROL OBJELERİNİ OLUŞTURMA
Bir Daire Spline Oluşturalım. Karşıdan görünüm alanına daire bakacak şekilde rotate ile döndü-

relim. Odak noktasını “D” tuşuna basarak köprücük kemiği bitiş eklem noktasına Snap to Points 
ile hizalayalım.

 

Freeze Transform ile sıfırlayalım.  

Bilek Kontolü için bir daire oluşturalım > bilek kemik eklemine snap ile hizalayalım. Bilezik 
şeklinde kol içinden geçecek şekilde rotate ile döndürelim.

Bilek kontrol objesi hem IK Hanlde’ı hareket ettirecek hem de bilek kemiğini rotate ile döndür-
mede bize yardımcı olacak.

Freeze Transform ile bilek kontrol objesini sıfırlayalım. 

Omuz ve Bilek kontrol objelerini grup yapalım. Bu sayede odak noktaları sıfır noktasına gele-
cektir. Daha sonra Duplicate ile diğer  kol için kopyasını oluşturalım. Karşı koordinatta "1" olan 
değeri "-1" yaparak karşı tarafa yansıtalım.

Daha sonra grupları Ungroup yaparak gruptan çıkaralım. Kopyalanan kontrol objelerini tekrar 
Frezze Transform yapalım.
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Önce Omuz Kontrol objesi Sonra omuz kemiğini Seçip > Constraint> Orient Constraint ile 
linkleyelim.

BİLEKLER için: Önce Bilek Kontrol objesini sonra da IK HAndle’ı seçelim > Üst Menü > Const-
raint > Point Constraint. Seçeneklerinde Mantint Ofset kutusunun aktif olmasına dikkat edelim.

Move tool ile hareket ettirdiğimizde kontrol objesi kolu hareket ettirmekte. Şimdi de rotate 
özelliğini bağlamak için:

Önce Kontrol Objesini sonra da Bilek Kemiğini seçelim. > Constraint > Orient Constraint ile 
linkleyelim.

Bu sayede Move ile harekett ettirip Rotate ile eli döndürme işlemi gerçekleştirilebilir.

Dirsek Kontrol Objesi Oluşturmak:
Daire Spline oluşturup Dirsek eklemine Point ile hizalayalım. Dirseğin arka tarafına doğru Move 

Tool ile taşıyalım. Freeze Transform yapalım.

Önce dirsek kontrol objesini sonra Bilek IK Handle’ı seçelim. Üst menü > Constraint > Pole 
Vector.

Bu işlemi yaptıktan sonra dirsekte hafif dönme olabilir. Kabul edilebilir düzeyde olacak kadar 
deneme yanılma ile dirsek kontrol objesinin yeri ayarlanabilir.

Uygun yeri bulduktan sonra Ctrl+Z ile Constraint'i geri alıp Kontrol objesinin Constraint olma-
yan halini grup yapalım. Tek obje olsa bir Ctrl+G yaparak odak noktasını sıfır noktasına alacaktır. 
Daha sonra Duplicate ve scale satırına “-1” yazarak simetriğini oluşturalım. Daha sonra da Free-
ze Transform ile sıfırlayalım. 

IK Handle ile Pole Vector Constraint işlemlerini şimdi her iki kol için de yapalım. 

Diz Kontrol Objesi işlemleri için de bir Daire Control Objesi oluşturalım. Diz eklemine Snap ile 
hizalayalım. "90" derece yere dik olacak şekilde döndürelim ve dizin önüne doğru taşıyalım. Daha 
sonra da Freeze Transform ile koordinatlarını sıfırlayalım.
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Önce Diz Kontrol objesini sonra da ayak bileği IK Handle’ı seçip > Üst Menü > Constraint > 
Pole Vector.

Diz kontrol objesi diz modelini bozmadan uygun oluştuysa;

 CTRL+Z ile geri alıp > CTRL+G gruplayıp > CTRL D ile kopyalayıp Scale koordinatından uygun 
olanına eksi değeri verip > Freeze Transform ile sıfırlayalım.

Son olarak da her iki diz kontrol objesi için > önce kontrol objesi sonra bacak IK Handle ‘ı seçip 
Pole Vector contraint işlemlerini yapalım.

AYAK IK EKLEME
Ayak kemiklerini IK Handle oluşturmak için üst menüden > Skeleton menü > Create IK Handle 

kutucuğuna basarak ayarlar penceresini açalım. Current Solver seçenğini > Sıngle Chaın olarak 
seçelim. Ayarlar penceresi açıkken önce ayağın bilek kemiğini sonra da ayak ortasındaki eklemi 
seçelim.

Böylelikle 2 numaralı ekleme IK Handle eklemiş olduk. IK Handle menüyü kapatalım. Daha 
sonra tekrar menüyü açıp bu sefer de ayağın ortasındaki eklemi ve ucundaki eklem kemiğini seçe-
lim. Bu sayede ayağın uç kısmına da bir IK Handle eklemiş olduk.

Ayak bileğinde bulunan ilk oluşturduğumuz IK Handle’ı seçelim. Sadece o seçiliyken Ctrl+G ile 
grup haline getirelim. 
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Grup haline gelen bilek IK Handle’ın Pivot Noktasını “D” tuşuna basarak ayağın ortasında 
bulunan IK Handle'a Point Snap ile hizalayalım.

Ayak ucu ve Ayak ortası oluşturulan yeni IK Handle'ları seçelim ve Attribute Editor alanından IK 
Handle Attributes sekmesindeki > Stıckiness ayarını Sticky yapalım.

Sticky IK Handle bilekteki ilk IK Handle’ı Rotate ile döndürüldüğünde, ayak tabanının yere 
yapışmasını sağlar.

Gruplama işlemini ayak ucundaki IK Handle için de yapıp odak noktası olan Pivot’u yine ayak 
ortasına getirelim. 

Ayak ucu IK Handle’ı seç > Ctrl+G > “D” ile odak noktasını Point Snap aktifken orta ekleme 
hizala. “D” ile Pivotu kapat.



153

Gruplanan IK Handle gruplarını isimlendirelim. “IK_Grup_Ayak _Ucu” gibi.

Ayak Bilek IK Grup, Ayak Ucu IK Grup ve Ayak Ortası IK’i Outline alanından seçelim. Toplamda 
2 grup bir IK olarak. Bu 3 parçayı Ctrl+G olarak gruplayalım. 

Gruplama işlemi yapılınca odak noktası yine sıfır “0” noktasına kayacaktır. Yine odak noktasını 
“D” tuşuna basarak bu sefer topuk olacak şekilde  topuğa yerleştirelim.

 

 

Grupladığımız grubu tekrar gruplayacağız. Bu gruplandırma işlemindeki amacımız ayak mo-
delinin kıvrılmasını istediğimiz her noktaya grup Pivot'ları eklemek. 

Gruplanan grubun Pivot noktasını da ayağın uç kısmına yerleştirelim. Bu noktadan da ayak öne 
doğru kıvrılacaktır.
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Ayak ucu, Topuk, Bilek olmak üzere toplam 3 adet gruplanmış IK Handle noktası olmuş du-
rumdadır. Ortada da gruplanmamış bir IK Handle bulunmaktadır.

Özetleyecek olursak:

Bilek ve Ayak Ucu IK Handle'ları gruplayarak odak noktalarını orta ayak eklemine hizaladık. 
Bilek IK, Ayak Ucu IK ve Ayak Ortası IK leri seçip onları da ayrı Grup yaptık ve odak noktasını To-
puk ucuna yerleştirdik. Son olarak da Topuktaki grubu yeniden Gruplayıp odak noktasını da ayak 
ucuna yerleştirdik.

Aynı işlemleri diğer ayak için de uygulamamız gerekmektedir.

AYAK KONTROL OBJESİ OLUŞTURMA
Bir Daire Spline çizerek ayak genişliğinde büyütelim. Dilersek Edit Spline modunda oval hale 

de getirebiliriz. Soldan görünümden ayağın tam taban hizasına gelecek şekilde yerleştirelim.

Pivot noktasını da ayak bileği Eklem Noktasına yerleştirelim.

Freeze Transform ile koordinatlarını sıfırlayalım.

Ayak kıvrılma hareketi için oluşturduğumuz IK Gruplarına müdahale edebilmek için bir Att-
rıbute Satırı oluşturmamız gerekmektedir. Bunun için Ayak Kontrol Objesi seçiliyken. Attribute 
Editor alanına gelerek Editor menüsünden > Attrıbutes > Add Attrıbutes seçeneğine tıklayarak 
Edit penceresini açalım.
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Pencerenin Long Name kısmına hangi işlemi yapacaksa onu yazalım. Örneğin “Ayak_ucu_dön-
dürme”.

Keyable seçeneğinin aktif olmasına dikkat edelim. Minimum ve Maximum satırlarına da "-10" 
ve "10" değerleri girelim. Bu sayede "10" ve "-10" değerleri dışına ayak kemiği çıkmayacak ve 
ayak deforme olmayacaktır.

Ayak kontrol objesi seçiliyken Channel Box menüsüne gelecek olursak o alana yeni eklenen 
satırın eklendiğini ve 10-10 değerleri arasında rakamları değiştirebildiği görülebilir.

Bu işlemi tekrarlayarak bir de Ayak Ucu Kıvrılma Attribute Satırı ekleyelim. yine "10" "-10" ve 
"0" değerleri verelim. Bu sayede iki adet Attribute değer girecek satır oluşturmuş oluruz. Henüz 
animasyonlara linklenmediği için girdiğimiz değerlerin karakter üzerinde bir etkisi olmayacaktır.

Ayak kontrol objesini sadece kendisini seçerek gruplayalım. Bu sayede odak noktası sıfır nok-
tasına gelecektir. Daha sonra Ctrl+D ile kopyasını oluşturalım. 

Kopyanın “x” koordinatına “-” eksi değer girelim ve  Freeze Transform ile sıfırlayalım. Bu saye-
de ayak kontrol objesinin klonunu aynı koordinatlarda karşı tarafta da oluşturmuş olduk.
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Gruplu halde bulunan ayak kontrol objelerini grup halinden kurtaralım ve üst menü > Edit > 
Ungroup işlemi uygulayalım. Kopya kontrol objesini “sag_Ayak_Kontrol_Objesi” olarak yeniden 
isimlendirelim.

Şimdi ilk oluşturulan ayak kontrol objesi üzerinden Attribute bağlantıları yapılabilir. Önce Ani-
mation Menüleri aktif hal getirelim sonra da üst menülerden Key menüsünden Set Driven Key  > 
Set seçeneğini seçelim. 

Açılan menüde Driver ve Driven seçenekleri bulunmaktadır. Burada oluşturulan Ayak Kontrol 
Objesi Driver olacaktır.

Sol ayak kontrol objesini seçelim ve Set Key menüsünden Load Driver butonuna basalım.

Daha sonra sırasıyla Outliner alanından Group Olan Ayak Parmak Ucu, Topuk ve Ayak bileği 
IK Yardımcı Objelerini seçelim. Set Driven Key menüsünde sağ üstteki alandan oluşturulan “Aya-
kucu Dondurme” Attribute’u seçelim ve Load Driven butonuna basarak Set Key alanındaki alt 
isteye ekleyelim.
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Oluşan Driven listesindeki 3 yazıyı Shift tuşuna basılı tutarak seçelim. Sağdaki listeden Rotate 
X yazısını ve oluşturulan Attribute satırını seçelim ve Outliner alanından Ayak Kontrol objesini 
sini seçelim. Attribute satırında “0” yazmasına dikkat edelim ve Set Key penceresindeki “KEY” 
butonuna basarak “0” değerini kaydedelim.

Ayak Ucu Döndürme Satırı “0” olarak durmalı. Ayağın sabit ve hareketsiz olduğu anlamına 
gelmektedir. Ayağın bu durumunu Attribute’a kaydetmek için Set Key alanından KEY butonuna 
basalım ve bu pozisyonu kayıt edelim.

Daha sonra Grup bilek IK Handle’ı  seçelim ve 45 derecelik bir açı ile ayağı parmak eklemlerin-
den kıvrılacak şekilde Rotate Tool ile döndürelim. Son olarak da yine Key düğmesine basarak "45" 
derece döndürelim.

Ayak kontrol objesini seçelim ve sağ alandaki Attribute Editor'de oluşturduğumuz az önce “0” 
olan satıra “5” değerini girelim.
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Buraya girilen dereceleri diğer ayak için de tekrar Manuel olarak girilmesi gerektiğinden dolayı 
not edilmesi gerekebilir.

Attribute satırındaki Ayak döndürme satırına "0-5" rakamları değer girerek ayağın kıvrılarak 
hareket ettiğinden emin olalım.

  

İki kere KEY'leme işlemi yaptıktan sonra (0-5), Ayak döndürme Attribute satırını bu sefer “10” 
değeri girelim ve Outliner alanından GRUP bilek IK Handle’ı  seçelim ve 45 derecelik bir açısını 
“0” yapalım.

 Outliner alanından Group IK Ayak Ucu IK'sını seçelim ve "50" derecelik değer girerek ayağı 
parmak ucuna kaldıralım.
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Tekrar ayak kontrol objesini seçelim ve KEY butonuna basarak bu değeri kaydedelim. 

Ayak kontrol objesini seçelim ve Attribute satırındaki ayak ucu döndürme satırını "0-10" arası 
rakamları değiştirerek ayağın kıvrılıp parmak ucuna kalktığından emin olalım.

Bu işlemleri yaparken dikkat edilmesi gereken husus Outliner alanından IK lerin Grouplarının 
seçilmesidir.

Ayak kıvrılma hareketine de animasyon vereceğimiz zaman Attributes alanında oluşturulan sa-
tırın değerlerine Timeline alanında animasyon Key'in verilmesi gerekmektedir.

Ayağın kıvrılma hareketini tekrar “0” değeri girerek ayak yere tam basacak şekilde Default düz 
haline getirelim.

Daha sonra 1- 10 arası değer girdiğimiz Ayak Ucu Döndürme Attribute satırına “-10” değeri 
girelim.
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Outliner alanından Topuk IK Gropu’u seçip ayak ucu yukarı kalkacak şekilde rotate ile “-30” 
derece döndürelim.  Key düğmesine basarak  Attribute’a kaydedelim.

Bu dereceler modelden modele farklılık gösterebilir. Farklı modellere ait ayak hacmine ve 
kemik yapısına göre kıvrılma derecesi değerleri değişkenlik gösterebilir.

Key ile kaydettikten sonra ayak kontrol objesini seçip oluşturulan Ayak Ucu Döndürme Attri-
bute satırına 10  / -10 değerlerini girerek ayağın parmak ucuna kalkıp topuğa doğru kıvrılmasını 
yapıp yapmadığını test edelim.

Attribute : -10 Attribute : 0

Attribute : 5 Attribute : 10
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Keyleme'lere göre bu modelin Attribute değeri ve IK Group rotate derecesi aşağıdaki gibidir:

Ayak ucu döndürme= 5 group_IKHANDLE_SOL_bacak  
(ayağın ortasındaki eklem) = 45

Ayak ucu döndürme= 10 group1_IK_AYAK_UC_SOL = 50

Ayak ucu döndürme= -10 group_IKHANDLE_tum_topuk = -30

Sol ayak için yapılan bu işlemi yine sol Ayağın Parmak Ucu için yapalım. Bunun için ayağı “0” 
değerine düz olacak şekilde geri getirelim ve Key pencere kutusunu kapatalım.

Daha sonra hiçbir obje seçili değilken tekrar üst menüden > Key > Set Driven Key > Set diyerek 
Key penceresini yeniden açalım. Pencere içi boş şekilde açılacaktır.

 

Sol ayak kontrol objesini yeniden seçelim ve Load as Driver butonuna basarak menüde üst 
kısma ekleyelim. Bu sefer oluşturduğumuz diğer  Ayak Ucu Kıvırma Attribute satırını seçelim.  
Outline alanından ayak ucunu yukaru aşağı kıvıran ve diğer Attribute a dahil etmediğimiz IK Gru-
bunu (group_IKhandle_Sol_Ayakucu) seçelim ve Load Driven butonuna basarak alt menü alanı-
na ekleyelim.

Load Driven alanındaki Rotate X satırını seçelim daha sonra ayak kontrol objesini seçelim ve 
Attribute alanında oluşturulan ayak ucu kıvırma satırına “0” değeri girip ayakta herhangi bir Rota-
tion yapmadan, Key alanından KEY butonuna basarak kayıt edelim.
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KEY butonuna basıp “0” değerini kaydettikten sonra “0” yazan yere “10” değeri girelim. Daha 
sonra Outliner alanından IK Grubunu (group_IKHANDLE_SOL_AYAKucu) seçelim ve ayak ucu yu-
karı kalkacak şekilde Rotate ile “X” koordinatında ayak ucunu kaldıralım (-40 derece). Daha sonra 
da KEY butonuna basarak bu değeri kaydedelim.

Kontrol objesini tekrar seçerek “10” değeri girilen satıra “-10” değeri girelim, Tekrar IK Grubu-
nu (group_IKHANDLE_SOL_AYAKucu) seçelim ve ayak ucu aşağı bakacak şekilde rotate ile döndü-
relim (40  derece). Daha sonra KEY butonuna basarak bu değeri de kaydedelim.
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Keyleme işlemleri bittikten sonra ayak kontrol objesini seçip Ayak Ucu Kıvırma Attribute satırı-
nı seçelim ve değerleri 10 / -10 arası değiştirerek ayağın hareket edip etmediğine bakalım.

Sol ayak kıvrılma hareketi için yapacaklarımız bu kadar. Şimdi hızlı bir tekrar yaparak aynı işlem-
leri diğer ayak için de uygulayalım. Dikkat etmemiz gereken husus sol ayak için girdiğimiz rakam-
ların aynısını sağ ayak için de aynı olarak girmektir. Aksi halde Yürüyüş Döngüsü aksak olacaktır.

Sağ Ayak İçin:
Set Driven Key kutusunu kapatalım.

Hiçbir obje seçili değilken animasyon menüleri aktifken > Üst menü > Key > Set Key Driven > 
Set.

Pencere açılınca Sağ Ayak Kontrol Objesini Tutalım > Load Driver butonuna basalım.
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Daha sonra Sağ Ayak Bilek, Ayak Topuk ve  Ayak Ucu IK Handle Group'ları seçelim ve KEY 
Penceresinden Load Driven butonuna basarak Alt listeye bu IK gruplarını ekleyelim. Ekledikten 
sonra üst menüdeki sağ alanda bulunan Oluşturduğumuz Ayak Ucu Döndürme Attribute satırını 
seçelim, Alt sağ alana eklediğimiz IK Gruplarının isimlerini seçelim ve hemen sağ tarafında bulu-
nan Rotate X yazısını seçelim. Bu sayede Key butonu Aktive olacaktır. Sağ tarafta bulunan bizim 
eklediğimiz Attrıbute alanındaki değerlerin hepsinin “0” olmasına dikkat edelim ve Key butonu-
na basalım ve hepsini kaydedelim.

Key Butonu ile kaydettikten sonra Sağ ayak kontrol objesini seçelim. Ayak Ucu Dondurme sa-
tırına diğer ayak için girdiğimiz değerin aynısı olan “5” değerini girelim.

Daha sonra ayak ortasında bulunan Group IK’i seçip (groupsag_ayak_orta_ik_bilek) diğer 
ayakla aynı derecede yani “45” derece döndürelim ve Key butonuna basarak kaydedelim.
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Ayak kontrol objesini seçelim ve “5” olan Ayak Ucu Dondurme satırına diğer ayak için girdiği-
miz değerin aynısı olan “10” değerini girelim.

“45” derece döndürdüğümüz ayak bilek IK Group'u tekrar eski haline yani “0” derecesine ge-
tirelim.

Ayak Ucu IK Group'u seçelim ve Rotate ile “50” derece döndürerek ayağı ayak ucunda durdu-
racak kadar kaldıralım ve Key ile kaydedelim.

Ayak kontrol objesini seçelim ve “5” olan Ayak Ucu Dondurme satırına diğer ayak için girdiği-
miz değerin aynısı olan “-10” (eksi) değerini girelim.

“50” derece döndürdüğümüz ayak bilek IK Group'u tekrar eski haline yani “0” derecesine ge-
tirelim.

Topuk Sağ Ayak IK Group’u (group_topuk_sag_ayak) seçelim ve Rotate ile “-30” derece dön-
dürerek ayağı ayak ucunda durduracak kadar kaldıralım ve Key ile kaydedelim.
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Ayak Kontrol Objesini seçerek Attribute alanından Ayak Ucu Döndürme Satırına sırayla 
"0/5/10/-10" değerleri girerek ayağın adım atmaya hazır kıvrılma hareketleri yapıp yapmadığına 
bakalım.

Ayak kontrol objesini seçelim ve Attribute alanındaki değerleri “0” yapalım ve ayağı düz hale 
getirelim.

Key penceresini kapatalım ve tekrar üst menüden > Key > Set Driven Key > Set seçerek açalım. 

Açılan pencere boş olarak açılacaktır. Sağ ayak kontrol objesini sahneden seçelim.

Load Driver diyerek listeye ekleyelim ve sağ üst menüden Ayak Ucu Kıvrılma Attribute’u se-
çelim.
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Outliner alanından ayak ucunun kıvrılmasını sağlayan IK Group’u seçelim ve Load Driven bu-
tonuna basarak listeye ekleyelim.

Ayak kontrol objesini seçelim ve  Atribute alanındaki oluşturduğumuz kıvrılma alanlarının her 
ikisi de “0” değerindeyken KEY tuşuna basarak kaydedelim.

Attribute satırı ayak ucu kıvrılma değerini “10” olarak verelim.

Outline alaından ayak ucu IK Group’u seçelim ve “-40” derece döndürerek ayağı aşağı doğru 
kıvıralım. ve Key tuşuna basarak kaydedelim.
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“10” olan Attribute değerini “-10” olarak değiştirelim. Daha sonra ayak eklem IK Group’u se-
çerek aşağı doğru “40” derece ile kıvırıp Key ile kaydedelim.

“0” değeri girerek başlangıçtaki haline getirelim.

Bu şekilde ayak kontrol objelerine ayağın kıvrılma hareketleri için temel Attribute satırı atama 
ve animasyon oluşturma işlemini yapmış olduk. Animasyon yapılacağı zaman IK Gruplarına Key 
atamak yerine Attribute satırlarındaki değerleri değiştirerek daha kesin ve kontrollü şekilde de-
taylı ayak  hareketi animasyonları yapılabilir.

EL PARMAKLARINA ATTRIBUTE ATAMA
Sol elin Bilek kısmında oluşturduğumuz çember şeklindeki El Kontrol Objesini seçelim. Attri-

bute Editor penceresini açalım. Attribute sekmesine basarak açılan menüden Add Attrıbute se-
çeneğini seçelim.

Açılan pencereden her parmak için ayrı Attribute satırı oluşturalım. İlk olarak en üst satıra 
“Isaret” yazalım.
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Alt kısımda bulunan Numeric Attribute Properties alanından > Minimum “-10” , Maximum 
“10” değerleri girelim. Default satırı ise “0” olarak kalabilir. Sağ alanda bulunan Channel Box kıs-
mından yeni eklediğimi Attribute satırının oluştuğundan emin olalım.

Orta parmak için Attribute satırı oluşturarak devam edelim. Attribute sekmesine basarak açı-
lan menüden Add Attribute seçeneğini seçelim. Açılan pencereden en üst satıra “Orta” yazalım. 
Min “-10” Max alana “10” Default “0” değerini girelim. 

Pencereyi kapatmadan diğer parmaklar için Attribute satırı oluşturmak için pencerenin alt 
orta kısmında bulunan Add Butonuna basarak devam edelim.

Add butonunu kullanarak diğer “Yüzük, Serçe ve Başparmak” için de Attribute satırı oluştura-
lım.

Tümünü oluşturduktan sonra  Channel Box kısmından yeni eklediğimi Attribute satırlarının 
oluştuğundan emin olalım.
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5 satır da oluştuktan sonra herhangi bir obje seçili değilken üst menü > Key > Set Driven Key > 
Set sekmesinden penceremizi açalım. Bilekteki halka şeklinde El Kontrol Objesini seçelim ve Load 
Drıver butonuna basarak menü listesine ekleyelim.

Listeden İşaret Parmağını seçelim. Çalışma alanından da El İşaret parmaklarının "3" kemiğini 
Shift tuşuna basılı tutarak seçelim ve Load Driven butonuna basarak aşağı listeye 3 adet kemiği 
ekleyelim.

Dikkat edilmesi gereken durum 3 parmak kemiği de seçiliyken Rotate ile döndürülürken hangi 
koordinatta el içine doğru kapanma hareketi yapıyor onun tespit edilmesidir. Bu Örnekte “Z” ko-
ordinatı parmağın kapanma hareketini yaptığı için “ Rotate Z” satırını listeden seçmek uygundur.

Listeye eklediğimiz 3 kemiği de seçelim ve Rotate Z satırını seçelim. Listede seçimlerimiz mavi 
olarak işaretliyken El Kontrol Objesini seçelim ve Attribute alanından İşaret parmağı satırının 
değerinin “0” olmasına dikkat ederek “Key” butonuna basarak parmağın açık halini kaydedelim.

Attribute alanındaki İşaret satırına “-10” değeri girelim. Çalışma alanında işaret parmağı ke-
miklerinin 3 tanesini seçip parmağı dışarı doğru kıvıralım (30 derece olabilir ama modellenen 
karaktere göre değişiklik gösterebilir)  ve Key butonuna basarak kaydedelim.
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El kontrol objesini seçelim, “-10” olarak girdiğimiz işaret parmağı satırını “10” derece olarak 
değiştirelim. İşaret parmağının üç kemiğini de seçelim ve parmağı elin içine doğru kıvıralım. Kı-
vırma işlemi parmak kemiklerini tek tek seçerek de yapılabilir. Yumruk yapacak şekilde kıvrılması 
da yeterli olacaktır. “-80” derece içeri kıvırdıktan sonra KEY butonuna basarak bu hareketi de 
kaydedelim.

Keyleme işlemleri bittikten sonra İşaret satırına -10/ 0 / 10 değerleri arasında değiştirerek par-
mağın kıvrılma hareketnini düzgün yaptığından emin olalım.

İşaret parmağı için yapılan bu işlemi tüm parmaklar için uygulayalım. Özetle tekrarlamak ge-
rekirse;

• Key menüsündeki listeden Orta parmak yazısını seçelim.

• Orta parmak kemiklerinin 3 tanesini model kemiklerinden Shift’e basılı tutarak seçelim.
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• Set Driven Key menüsünden Load Driven butonuna basarak alt listeye kemikleri ekleyelim.

• Listeden 3 kemiği seçelim satırların üç de mavi olsun.

• Sağ listeden de Rotatze Z satırını seçelim.

• El Kontrol Objesini seçelim ve Attribute Orta Parmak değeri “0” değerindeyken Key butonu 
ile kaydedelim.

• Orta parmak değerini “-10” yapalım.

• Parmağı 3 kemikten tutarak dışarı doğru Rotate ile kıvıralım ve Kontrol Objesini tutup Key 
ile kaydedelim.

• Orta parmak değerini “10” yapalım.

• Parmağın 3 kemiğini tutarak yumruk yapacak şekilde içeri doğru kıvıralım.

• Kontrol objesini tutalım ve Key ile kaydedelim.

• Kontrol amaçlı Attribute alanında oluşturduğumuz Orta Parmak satırına değer girerek kıvı-
rılmayı kontrol edelim.

Bu işlem sıralamasını baş parmak hariç tüm parmaklara yaparak kıvrılma özelliği kazandıralım.

Baş Parmak için; aynı yöntemi kullanabiliriz ancak rotate işlemi baş parmağın avuç içine tam 
oturması için tek koordinat yerine x,y,z koordinatlarında yapılması gerekebilir. Bu sebeple Key 
ekranında sadece Rotate X satırı yerine Rotate x, Rotate y ve Rotate z satırlarının üçünü de seçip 
Keyleme işlemi yapalım.

Tüm parmakların Attribute satırı değeri “10” olduğunda el tamamen yumruk şeklinde kapan-
malı, “-10” olduğunda ise el tamamen dışa doğru hafif kıvrılarak açılmalıdır.
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 El parmaklarının tamamı için uyguladığımız bu işlemlerin aynısını diğer el için de uygulamamız 
gerekmektedir. Dikkat etmemiz gereken husus ayak kıvrılma işlemi gibi sağ el ve sol elin kıvrılma 
değerlerinin ve açılarının her iki elde de eşit olmasıdır.

BLEND SHAPES ile ÇALIŞMA ve MİMİK OLUŞTURMA
Blend Shape ile çalışmak bir nesnenin şeklini diğer nesnelerin şekillerine dönüştürmenize ola-

nak tanır. Blend şekil deforme ediciler, bir modeli diğer bir modele dönüştürmeyi sağlar.  Oluştu-
rulan karakterin farklı yüz hareketleri yapması için modeli kopyalayarak dönüşmesini istediğimiz 
modele çevirmemiz gerekir. Bunun için dikkat edilmesi gereken konu Orijinal model ve deforme 
edilen modelin aynı Vertex ve Poligon sayısına sahip olmasıdır.

Göz kapama, gülümseme ve şaşırma şeklinde üç temel mimik oluşturalım.   Bunun için ilk 
olarak gövde modelini kopyalanması gerekmektedir. Aynı anda gözler dişler ve dil modellerini 
de kopyalamak deforme ederken istenmeyen model çakışmaları ve modellerin birbirlerine geç-
melerini engelleyecektir.  Göz diş ve dil modellerinin kopyaları daha sonra silinebilir çünkü işe 
yarayacak olan model sadece gövde modelidir.

Kopyalanacak modelleri seçip CTRL+D ile Duplicate işlemi yapalım.

Gövde modeli Rigli kopya gövde olduğu için kilitli durumdadır ve hareket etmeyebilir. Hareket 
ettirmek için sadece gövde modeli seçiliyken Transform penceresinden tüm Rotate Scale Move 
satırlarını seçerek Unlock Selected seçeneği ile kilitlerini kaldıralım. 
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Unlock işleminden sonra gövde gözler dişler ve dil modeli seçiliyken Move Tool ile kopya mo-
delleri orijinal Rigli modelin yanına doğru çekelim. Bu sayede üzerinde rahatça deformasyon 
çalışması yapılabilir.

Orijinal modelin Lock özelliğinin gitmediğinden emin olalım aksi taktirde iskelet sistemi hare-
ket ettiğinde karakter modeli sabit olarak kalacaktır.

Bu çalışmada karakter 3 farklı mimik yapacağı için kopyaları da 3 adet olarak oluşturalım. 
Daha fazla mimik yapması istenen karakterlerde bu kopyaları oluşturulacak mimikler kadar çoğal-
tılması gerekmektedir.

Blend Shape olacak modelin Transform değerlerini asla Freeze Transform ile sıfırlamamamız 
gerekmektedir. Sıfırlanırsa Blend  Shape işlemi çalışmaz. 

Bir diğer dikkat edilmesi gereken önemli konu ise Vertex sırasını ya da sayısını değiştirecek 
modelleme işlemleri yapmamamız gerektiğidir. Extrude, Bridge vs gibi işlemler ile Vertex ve Pol-
ygon sayısını çoğaltıp azaltılmamalıdır.

Model üzerinde deformasyon yaparken Symetry > Object X olarak seçilebilir. Bu sayede bir 
tarafta yapılan işlem otomatik olarak model ile hizalı şekilde simetriğinde de oluşacaktır.
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Göz kapaklarının üst kısmına denk gelecek alanı seçelim ve gözün yarısından fazlası kapanacak 
şekilde Move Tool ile aşağı doru indirelim. Bunu yaparken Soft Selection özelliğini açarak daha 
düzgün ve bozulmamış şekilde model deforme edilebilir.

Oluşturulan kapalı göz kapaklarında sündürmeden dolayı bozulan Edge ya da Vertex'ler olabi-
lir. Bunları yumuşatmak ve düzeltmek için Sculpting modundan Relax aracı kullanılabilir.

Üst göz kapaklarını indirdikten sonra Alt Göz Kapaklarını da yukarı doğru aynı şekilde kaldıra-
rak gözün tamamen kapanmasını sağlayalım.

Göz kapama işlemi bittikten sonra modelimizi “Goz_Kapali” şeklinde isimlendirelim. Bu saye-
de diğer gövde modelleri ile karışması engellenmiş olur.

Önce Göz_Kapalı modelini daha sonra da iskelet sistemi giydirilmiş olan ilk gövde modelini 
seçelim. Üst menü > Deform > Blend Shape menüsünü açalım.  Default ayarlarla herhangi bir 
ekleme yapmadan Create butonuna basalım.
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Riglenmiş gövde modelini seçelim. Sağ taraftaki alanda bulunan Channel Box alanını açıldığın-
da Inputs alanında Blenshape 1 seçeneği görülebilir. Blendshape yazısına basarak alt sekmeler 
görülebilir.

Bu alanda yeniden isimlendirilen gözleri kapalı gövde modeli bir satır olarak görülebilir.

Bu satırdaki rakam değerlerini değiştirerek göz açma kapama hareketi karaktere yaptırılabilir. 
Daha verimli şekilde kullanmak için buradaki değer satırını kontrol objesine taşınması animatö-
rün işlerini kolaylaştıracaktır.

BLENSHAPE İLE GÜLÜMSEME HAREKETİ
Kopyalanan ikinci gövde modelini “Gulumseme” olarak isimlendirelim. Daha sonra Object 

X Symetry seçeneğini ve Soft Selection açarak Vertex'leri seçerek ağız kenarlarını yukarı doğru 
Move Tool ile kaldıralım.

Soft Selection aktifken hem alt hem üst dudak alanına aynı anda müdahale edebilir. Sadece 
Üst ya da Alt dudağa müdahale etmesi için Sol tarafta bulunan Move Tool simgesine çift tık-
layarak seçenekler kutucuğunu açalım. Burada bulunan Soft Selection alanından Falloff Mode 
sekmesinden Surface ve Volume seçenekleri arasından bize yardımcı olacak seçenek seçilebilir.
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Gülümseme hareketini yaptıktan sonra oluşan Polygon deformasyonlarını düzenlemek için 
Sculpt > Relax aracı kullanılabilir.

Ağız kısmını düzenledikten sonra gülme hareketinin daha gerçekçi olması açısından yanakları 
ve göz çevresini de deforme ederek gülüş modellemesi taamlanabilir.

 

Gülümseme modellemesi bittikten sonra Obje Modundayken sırayla önce Gülümseme Gövde 
Modelini sonra Rigli Gövde Modelni seçelim. 

Bu sefer üst menüden Deform sekmesinden en üstteki Blend Shape’i değil Orta Kısımda Bulu-
nan Blend Shape sekmesinden Add butonunun yanındaki kutucuğa basalım ve menüyü açalım. 
Açılan Kutucukta en üstteki Specify kutusunu aktive edelim. Açılan menüde zaten daha önceden 
oluşturduğumuz bir adet Blend Shape bulunduğundan onu seçelim ve Apply and Close ile kapa-
talım.
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Bu sayede daha önceden açılan Blend Seçeneğinin altına ekleme yapılmış olur. Ekleme yapa-
rak çalışmak tüm Blend Shapeleri kontrol objelerine bağlamada ve kolay kullanım açısından daha 
uygun bir yöntemdir.

Gülümseme Hareketinin Rigli Karaktere eklenip eklenmediğini kontrol etmek için, Rigli Gövde-
yi seçelim > Channel Box alanını açalım > Inputs alanından Blendshape1 alanını açalım ve Gülüm-
seme satırının eklenip eklenmediğine bakalım.

Şaşırma Blendshape Oluşturmak:
Oluşturulan 3. Gövde modeli kopyası üzerinde şaşırma ifadesi oluşacak şekilde Vertex'leri se-

çerek Soft Selection seçeneği aktifken değişiklikler yapalım.

Örnekteki karakteri modellerken kaşları da gövdeyle birleşik şekilde oluşturulmuştu. Bu yüz-
den kaş model parçalarına Polygon Modundayken çift tıklanarak tamamı seçilip yukarı kaldırılabi-
lir. Daha sonra da kaşın bulunduğu alın kısmı Vertex'lerden tutularak Soft Selection açıkken kaş-
larla aynı hizaya kaldırılabilir. Daha sonra da göz kapaklarını açarak model deformasyon işlemini 
tamamlayalım.

 

Gövde modelini de yeniden isimlendirelim. Bu modelin adı “sasirma” seklinde isimlendirile-
bilir.

Önce şaşıran model sonra rigli modeli seçelim > üst menü > Deform > Açıla listede orta Edit 
alanında bulunan Blendshape sekmesinden > Add seçeneğinin kutusuna tıklayalım. Açılan me-
nüde Specify Node kutucuğunu aktif hale getirelim. Apply and Close tuşuna basarak işlemi  ta-
mamlayalım.
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Channel Box alanına gelerek oradaki Input alanındaki Slider'lardan tüm Blend Shape seçenek-
lerini deneyerek modelin hareketlerini kontrol edelim.

Blend Shape'lerin hepsi eklendikten sonra Rigli karakterimizi hareket ettirmeye çalışıldığında 
yanıt vermediği görülebilir. Böyle durumlarda Rigli Modelin üstüne sağ tıklayıp açılan menüden 
Inputs sekmesinden All Inputs penceresini açalım.

Bu alandaki listede Skın Cluster’ın Blend Shapes’in üstünde olması gerekmektedir. Aksi tak-
tirde Riglenmiş gövde hareketleri işlevsel olmaz. Bu yüzden Açılan listeden Blend Shape satırını 
Mouse orta tekerleğine basılı tutarak Skin Cluster satırının altına alınması gerekmektedir.



180

Bu işlemin başarılı olup olmadığını kontrol etme amaçlı Çene Kontrol Objesini tutarak Rotate 
ile ağız açma kapama hareketi test edilebilir.

Ağız kontrol objesi ile ağız açma hareketini yaptıktan sonra Blend Shape Attributelerin de ça-
lışıp çalışmadığını kontrol edelim. Yani model ağızı açıkken gözlerini kapatıp gülümseyebilmelidir.

YÜZ İÇİN KONTROL OBJESİ OLUŞTURMA
Üst menü > Create > Nurbs Primitives > Cırcle ile bir Daire Line oluşturalım ve Rigli karakter 

modelimizin kafa hizasına doğru yerleştirelim. Dairenin “90 derece” döndürerek yüzeyinin ka-
raktere paralel olmasını sağlayalım. Dairenin şeklini Vertex moduna gelerek biraz değiştirelim. 
Bu sayede diğer kontrol objelerinden ilk bakışta ayrılabilir duruma gelecektir. Bu kontrol objesini 
göz açılması ve kapanmasını yapmak için kullanacağız. Son olarak da Freeze Transform ile yerini 
sıfırlayalım ve isimlendirelim. Ctrl_goz_kapama şeklinde isimlendirilebilir.

Kontrol objesi çalışma alanında yukarı aşağı Move Tool ile hareket ettirildiğinde sınırsız bir 
şekilde hareket edebilmektedir. Bu sebeple kaybolmaması ve yerinde belli miktar hareket ede-
bilmesi ve sabit kalması için sınırlandırılması gerekmektedir. Bunun için göz açma kapama objesi 
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seçiliyken   sağ tarafta bulunan Attribute Editor paneline gelelim. O alanda Limit Information 
sekmesini bulalım ve menüyü açalım. Bu alandaki Translate sekmesinden limitlemeler yapılabilir.

Kontrol objesinin yukarı aşağı hareketleri Y koordinatında olduğu için Translate sekmesinde 
“Y” koordinatını aktive edelim ve üçlü satıra “0-0-1” değerini girelim

Kontrol objesini Move Tool ile yukarı aşağı yaparak sınırlı derecede hareket ettiğini kontrol 
edelim.

Kontrol objesini karakterin Morph hareketleri ile linklemek için;

Üst menüden > Windows > General Editors > Connection Editor sekmesini seçelim ve pence-
renin açılmasını sağlayalım. 

Kontrol objesi seçiliyken Reload Left butonuna basarak sol alana seçeneklerin gelmesini sağ-
layalım. 
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Sağ alanda bulunan Inputs alanı ise oluşturulan Morph Targeti'n ekleneceği alandır. Bunun 
için; Rigli modeli seçelim, sağ alandaki Channel Box sekmesinden göz açma kapama işlemini ya-
pan Morph Target’ın bulunduğu Inputs  alanından Blend Shape1 sekmesini seçelim. Son olarak 
da Reload Right butonuna basarak listenin dolmasını sağlayalım.

Kontrol objesini sola ve bu objenin yapması istenen hareketi de sağ listeye eklendiğine göre 
şimdi bunların birbirine linklenmesi gerekir. Öncelikle sol Outputs listeden objenin kontrol ettiği 
işlemi ve koordinatı seçelim. Bunun için Translate  > Y seçeneğini seçelim.

Daha sonra sağ tarafta bulunan Inputs alanından da Weights sekmesinden Gözler Kapalı Blend 
Shape’ini seçelim.

Listedeki yazının italik olması linklenmiş olduğunu göstermektedir. Connectin Editor’ü kapa-
talım. Göz açma kapama kontrol objesini seçelim ve Move Tool ile yukarı aşağı hareket ettirerek 
göz kapaklarının açılıp kapandığında emin olalım.
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Bu işlemin aynısı farklı kontrol objeleri oluşturarak her Blend Shape için uygulanabilir.

Üst menü > Create > Nurbs Primitives ile yeni bir kontrol objesi oluşturalım ve 90 derece Ro-
tate ile döndürüp yüz kısmına paralel olacak şekilde ağız kenarına yaklaştıralım. İsimlendirelim > 
“CTRL_Gulme”. Daha sonra da Freeze Selection ile Transform değerlerini sıfırlayalım.

Transform değerlerini limitlemek için Attribute editor alanını açalım. Lımıt Informatıon sekme-
sinden > Translate sekmesinden Trans Lımıt Y sekmesini kutucukların ikisini aktive ederek “0-0-1” 
değeri  girelim.

Ağız kontrol objesini seçip yukarı doğru kaldıralım ve sınırlı derecede yukarı hareket ettiğinden 
emin olalım ve eski yerine geri getirerek işlemimize devam edelim.

Birleştirme işlemi için > üst menü > Window > General Editor > Connection Editor menüsünü 
açalım. Ağız kontrol objesi olan yuvarlak daireyi sahneden seçelim ve menüdeki Reload Left bu-
tonuna basarak listeye ekleyelim.
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Daha sonra da Rigli karakter modelimizin gövdesini seçelim ve sağ taraftaki Channel Box ala-
nından Blend Shape sekmesi seçiliyken menüde Reload Right butonuna basarak sağ listenin dol-
masını sağlayalım.

Connection Editor alanından linklemek için Sol listeden Translate > Translate Y satırını seçelim. 
Sağ liste olan Reload Right listesinden de Weight satırının alt sekmesi olan Gulumseme blend 
shape satırını seçelim. Seçer seçmez yazıların italik olması bize linkleme işleminin yapıldığını gös-
termektedir.

Kontrol amaçlı Ağız Kontrol Objesini tutarak yukarı doğru kaldıralım. Karakterimizin gülümse-
me hareketini yapması gerekmektedir. 

Şaşırma hareketi için de aynı işlemi tekrarlayalım;

Üst menü > create > nurbs primitives > Circle ile daire kontrol objesi oluşturalım. Karakterin 
kafa hizasına yüzün yanına yerleştirelim.  90 derece döndürerek karaktere paralel hale getirelim. 
Freeze Transform ile sıfırlayalım. CTRL_Sasırma şeklinde isimlendirelim. Attribute editor > Lımıt 
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Informatıon alanından Translate satırından Trans Lımıt Y satırından kutucukları aktive edelim ve 
değeri “0-0-1” olarak yazalım.

Birleştirme işlemi için > üst menü > Window > General Editor > Connectıon Editor menüsünü 
açalım. Şaşırma kontrol objesi olan yuvarlak daireyi sahneden seçelim ve menüdeki Reload Left 
butonuna basarak listeye ekleyelim.

Daha sonra da Rigli karakter modelimizin gövdesini seçelim ve sağ taraftaki Channel Box ala-
nından Blend Shape sekmesi seçiliyken menüde Reload Rıght butonuna basarak sağ listenin dol-
masını sağlayalım.

Connection Editor alanından linklemek için Sol listeden Translate > Translate Y satırını seçelim. 
Sağ liste olan Reload Right listesinden de Weight satırının alt sekmesi olan Sasırma Blend Shape 
satırını seçelim. Seçer seçmez yazıların italik olması bize linkleme işleminin yapıldığını göstermek-
tedir.

Temel olarak Blend Shape ile çalışma Maya’da bu şekilde olmaktadır. Blend Shape olarak kulla-
nacak gövde modelini dilendiği kadar çoğaltıp farklı mimikler ve hareketler yaptırarak yeni kontrol 
objeleri ekleyerek karakter modeline bağlanır.
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KONTROL OBJELERİNİ KONTROL ETMEK SINIRLANDIRMAK VE  
    SON DOKUNUŞLAR

Oluşturulan tüm kol bacak gövde ve mimik kontrol objelerini deneyerek çalışıp çalışmadıkla-
rından emin olalım. Örneğin Ana_Kontrol objesi sağa ya da sola hareket ettirildiğinde vücudun 
ve diğer kontrol objelerinin de onunla beraber gelmesi gerekmektedir. Henüz o işlem yapılmadığı 
için hareket ettirildiğinde Kontol objesi hareket edecek ve gövde sabit kalacaktır.

Bu durumu düzeltmek için önce Kalça Ana Kontrol Objesi'ni seçelim daha sonra da ayak hiza-
sında tüm vücudu kontrol etmesi için oluşturulan Ana_Kontrol Objesi'ni seçelim. Seçimin sıralaya 
yapılması Parent işlemi için önemli olduğu için dikkat edelim. Üst menü > Edit > Parent (P) ile 
Parent işlemini tamamlayalım.

Daha sonra Boyun Kontrol Objesi'ni Göğüs Kontrol Objesi ile birleştirilmesi gerekmektedir. 
Önce Boyun Kontrol Objesi sonra Göğüs Kontrol Objesi'ni seçelim ve “P” kısa yolu ile Parent 
işlemini tekrarlayalım.

Kontrol etmek için ayak hizasındaki Ana Kontrol Objesi'ni seçtiğimiz zaman boyun ve kalçadaki 
kontrol objeleri de otomatik olarak seçiliyor olmalıdır. Kalça Kontrol Objesi'ni seçtiğimizde ve 
Move Tool ile aşağı doğru indirdiğimizde eğer doğru Parent işlemi yapıldıysa Boyun ve Kafa Kont-
rol Objeleri de onunla beraber aşağı doğru inmelidir.
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Göz Kontrol Objesi'ni de Kafa Kontrol Objesi ile birleştirilmesi gerekmektedir. Bunun için önce 
Göz Kontrol Objesi'ni sonra Kafa kontrol Objesi'ni seçerek “P” tuşu ile Parent işlemi yapılması 
gerekir.

Kafa kontrol objesi seçiliyken Rotate Tool ile kafa modeli döndürüldüğünde Göz Kontrol Obje-
si'nin de döndüğünden emin olalım.

Göz kapama, gülme, şaşırma gibi Blend Shape'leri linklediğimiz Kontrol Obje'lerini Kafa Kont-
rol Objesi'ne linklemek için önce kontrol objelerinin üçünü daha sonra Kafa Kontrol Objesi'ni 
seçerek “P” tuşuna basarak Parent işlemini tamamlayalım. Kontrol amaçlı döndürme işlemini tek-
rarlayalım ve kontrol objelerinin tamamının kafa ile birlikte döndüğünden emin olalım. 

Omuz Kontrol Objeleri tek tek seçilip Göğüs Kontrol Objesine “P” ile linklenmelidir.
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Omuz Kontrol Obje'lerini de Göğüs Kontrol Objesi'ne linklenmesi gerekmektedir. Bunun için 
önce Sağ Omuz Kontrol Objesini seçip sonra Göğüs Kontrol Objesini seçip “P” tuşuna basalım. 
Daha sonra da Sol Omuz Kontrol Objesi'ni seçip Göğüs Kontrol Objesi'ni seçip “P” tuşuna basa-
rak Parent işlemini tamamlayalım.

 

Önce El Bilekleri, Dirsek, ve Diz Kontrol Objelerini de seçerek Yerde Duran Ana Kontol Obje-
sine “P” ile linkleyelim.

Ayak kontrol eklem objelerini ayağın çevresinde bulunan kontrol objesine eklemek için. IK 
Kontrol Grupları Outliner alanında seçiliyken Mouse Orta Tekerleğine basılı tutarak kontrol ob-
jesinin isminin üzerine bırakılması yeterli olacaktır.

Bu sayede sahnede ayak model etrafında bulunan yuvarlak kontrol objesini hareket ettirdiği-
mizde ayağın da yukarı doğru hareket etmesi gerekmektedir.
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Aynı işlemin diğer ayak için de tekrarlanması gerekmektedir. Ayak modeli kenarında duran 
Kontrol Objesini seçip hemen yanında dış alanda bulunan Ana Kontrol Objesini seçip “P” tuşuna 
basarak Parent işlemi yapalım. Aynı işlemi diğer ayak kontrol objesi için de aynı sıralamayla yapa-
lım. Önce ayak kontrol objesi sonra Ana Kontrol Objesi seçilerek “P” tuşuna basılmalıdır.

Ayak Kontrol Objeleri de IK Grupları Parent ile linklendikten sonra Ana Kontrol Obje'sine “P” 
ile tek tek linklenmelidir. İki Ayak Kontrol Objesi aynı anda seçilip linklenmemelidir.

Dirsek ve el bileği kontrol objelerini önce seçip en son da yerde duran Ana Kontrol Objesi'ni 
seçerek “P” tuşuna basarak Parent işlemini yapalım. Yine seçim sırası aynı sıralama le olacak şe-
kilde yapalım.

Eğer tüm kontrol objelerinin Parent işlemleri doğru yapıldıysa ana kontrol objesi hareket ettiril-
diğinde tüm modelin hareket etmesi gerekir. Aynı şekilde Scale ile büyütüp küçültüldüğünde tüm 
model büyüyüp küçülmelidir.

KONTROL OBJELERİNİ LİMİTLEME
Kontrol objelerin istenmeyen koordinatları Channel Box alanında seçilerek Hide and Freeze 

seçeneği ile gizlenebilir. Bu sayede animasyoncu yanlışlıkla o alanlara Key atmaz ve karakter de 
istenmeyen hareketler uygulamamış olur.

Kontrol objelerini limitlemek istenmeyen hareketlerin yapılmasını engeller. Örneğin bu ör-
nekte limitlenmemiş çene kontrol objesinin rotate ile fazla döndürülmesinin sonucunu görülmek-
tedir:
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Önce kontrol objesi seçilir. Attribute Editor alanı açılıp en soldaki liste olan Çene Kemiği liste-
sinden > Limit Informatıon sekmesinden > Rotate menüsü açılır ve bu alanda bulunan “Min” ve 
“Max” alanlara gerekli rotate değerleri girilerek kısıtlama yapılır.

Kaç derece değer girileceği ise Transform Attributes alanındaki Rotate değerlerine göre ayar-
lanabilir. Bu örnek çalışmada Min:70 Max:90 derece sonuca ulaşmak için yeterli değereler olmuş-
tur. Her farklı modele göre değerler değişkenlik oluşturabilmektedir.

Herhangi bir kontrol objesinin sadece amacına uygun olarak kullanılması için Rotate, Move ya 
da Scale seçeneklerinden istenen özellik gizlenebilir. Bunun için Channel Box alanına gelerek bu 
alandaki Translate, Rotate ya da Scale kanallarından istenen seçilerek Sağ Mouse Buton ile tıkla-
nıp açılan listeden “Lock And Hide Selected” seçeneğinin seçilmesi yeterli olacaktır.
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Bu sayede gizlenen Move ya da Scale seçenekleri çalışma alanında da araç seçilse de görüntü-
lenemezler.

Her kontrol objesinde amacı dışında bulunan yön seçeneklerini gizlemek ya da kilitlemek en 
doğru çalışma yöntemi olacaktır. Örneğin göğüs kemiğini kontrol eden kontrol objesinde Scale ve 
Translate seçeneklerini gizlemek karakteri hareketlendirecek diğer kişiler için de kullanıma dair ip 
uçları olacaktır.

Kemik, Kontrol Objeleri ve Modeli ayrı Layer'lar oluşturup ayrılabilir. Bu sayede karakter hare-
ketlendirilirken belirli yerler daha detaylı görülebilir ve çalışılabilir.

Örneğin kemiklerin tamamı kalça kemiğinden seçilerek Layer sekmesinde en sağda bulunan 
seçili objelerle Layer oluştur (Create A New Layer And Assign) seçeneği ile oluşturulabilir. Layer 
yeniden isimlendirilip düzenli çalışma ortamı oluşturulabilir. Aynı zamanda IK objeler de kemik-
lerin olduğu Layer'a eklenebilir.
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ÜNİTE 6 - ANİMASYON
ANİMASYON 
Modellenen karakter çalışmasını iskelet sistemi sayesinde hareketlendirmek için Maya’nın 

animasyon özelliği kullanılabilir. Animasyon çalışmaları için kullanılan Time Line alanını tanımak 
gerekirse;

1) Zaman çizelgesi, üzerinde rakamlar bulunan  oluşturulan sahnedeki animasyon ayalarına 
bağlı olarak 24 karesi 1 saniyeye eşit olan çizelgedir. Bu alanı kullanarak yapılan animasyonların 
süreleri ayarlanabilir. Bu alan ayrıca yapılan animasyonun ön izleme süresini belirlemede de kul-
lanılabilir.

2) Zaman çizelgesi yakınlaşma  ve kaydırma çubuğu. Bu çubuğu kullanarak zaman çizelgesin-
de yakınlaşıp uzaklaşma yapabilir ya da dilenen animasyon karesine ulaşılabilir.

3) Zaman çizelgesinde ön izleme zaman aralığı ilk rakam alanına girerek belirlenebilir. İkinci 
rakam alanına ise zaman çizelgesinin olması istenen süresi girilebilir. 240 kare girilen değer 24 fps 
ayarlarında 10 saniyelik bir animasyon süresi oluşturacaktır.

4) Playback komut alanı. Bu bölgedeki seçenekler ile animasyon ileri ya da geri oynatılır. Di-
lenirse detaylı çalışmalarda kare kare ilerlemek için de bu alan kullanılabilir. Yine aynı alandan 
animasyon zaman çizelgesinin en başına ya da en sonuna kızlı bir şekilde ilerlenebilir.

5) 1 saniyede oluşturulacak olan kare sayısı sinematik bir animasyon çalılması için 24 saniye  
şeklinde ayarlanırsa yeterli olacaktır. Yapılacak animasyon çalışmasının amacına göre kare sayısı 
artırılabilir. 

6) Animation Preferences Butonu ile animasyon tercihlerinin girileceği animasyon ayarları 
menüsüne ulaşılabilir.

TEMEL ANİMASYON ÇALIŞMASI
Basit bir animasyon çalışması yaparak Maya’daki animasyon mantığını kavrayalım; Sahneye bir 

adet Cube oluşturalım. Timeline alanındaki zaman çizelgesi çubuğumuzu 1. kareye getirelim. Ob-
jemiz seçili iken Move Tool’u seçelim. Attribute editor alanında objeyi hareket ettirmek istenen 
X doğrultusunun olduğu satıra Sağ Mouse Buton ile tıklayıp Key Selected diyerek ilk Key Frame 
ekleyelim. 
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Timeline alanında kırmızı bir işaret oluştuğu görülebilir. Bu o saniye içerisinde seçili olan obje 
üzerinde bir animasyon hareketi bulunduğunu bildirmektedir.

Objeyi, animasyon sonunda bulunmasını istenen koordinata Move Tool ile Key eklenen isti-
kamette ilerletelim. Zaman çizelgesi çubuğunu da objenin bulunması istenen süreye götürelim. 
Örneğin 24. kare.  Tekrar X doğrultusunun olduğu satıra Sağ Mouse Buton ile tıklayıp Key Selected 
diyerek ikinci hareketini kaydedelim. Bu sayede zaman çizelgesi üzerinde 1. kare ve 24. kareler 
üzerinde 2 adet kırmızı nokta bulunacaktır. Bu noktalar arasında zaman çizelgesi çubuğunu ileri 

geri oynatarak animasyonun ön izlemesini yapılabilir. 

Animasyon oynatma hızı eğer fazla hızlı ise, zaman çizelgesinin üzerine Sağ Mouse Buton ile 
tıklayıp Playback Speed > Real Time seçilirse animasyon kendi hızında oynar.

Maya’da animasyonun en temel çalışma prensibi bu şekildedir. Eğer bu basit animasyon biraz 
daha detaylandırılmak istenirse, objeyi farklı koordinatlara taşıyıp Rotate ile döndürüp ya da SCA-
LE ile büyütüp küçülterek Key Frame vererek hareketleri çeşitlendirilebilir. 

Keyframe eklerken kısa yol olarak “S” tuşu kullanılabilir. Ayrıca W,E,R, tuşlarına basarken Shift 
tuşuna basılı tutulması da seçili araçla ilgili Key oluşturulması için yeterli olacaktır. Örneğin Move 
Tool kullanarak yapılacak animasyonlarda obje seçiliyken Shift+W tuşuna basarak objenin bulun-
duğu noktaya Keyframe atılabilir.

Oluşturulan Tool ile ilgili Keyframe'leri silmek için ise animasyon verilen satıra tekrar Sağ Mou-
se Buton ile tıklayarak Break Connectıon’ı seçilmesi yeterli olacaktır. Bu sayede tüm Keyframeler 
silinecektir.

Manuel olarak Keyframe silmek için ise, zaman çizelgesi üzerinde ilgili Keyframe bulunan alanı 
Shift+Sol Mouse Buton ile seçili hale getirip zaman çizelgesine Sağ Mouse Buton tıklayıp Delete 
seçilmesi yeterli olacaktır.

Shift ile seçerek ve sürükleyerek, Timeline’daki Keyframe'lerin yerleri de değiştirilebilir.
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GRAPH EDITOR İLE ÇALIŞMA
Üst menüden Windows > Animatıon Editors > Graph Editor ile grafik editör penceresi açılabilir.

Animasyon bulunduran obje seçildikten sonra grafik olarak yapılan animasyonlar görülebilir. 
Tam olarak görmek için “F” tuşuna basarak tam zum yapılabilir.

1- Move, Scale,Rotate gibi komutların kontrol listesi olarak gösterildiği alan.

2- Objenin kaç değer animasyonda bulunduğunu gösteren alan.

3- Animasyon karelerinin gösterildiği alan.

Graph Editor alanında da çalışma boşluğunda hareket eder gibi hareket edilebilir. ALT + Orta 
Mouse Butonuna basılı tutarak alan içerisinde sağa sola yukarı aşağı gidilebilir. ALT+ Sağ Mouse 
Buton ile zum yapılabilir.

1 numaralı kontrol listesi alanından koordinatlar tek tek seçilerek 3 numaralı editörde koordi-
natlar üzerinde izole şekilde çalışılabilir.

Graph Editor üzerinde Key eklemek istenirse Sağ Mouse Buton ile Insert Key komutu ile ya da 
“S” tuşuna basarak Key eklenebilir.

Seçilen Key Frame’i  hareket ettirmek için Orta Mouse Butonuna basılı tutup hareket ettirile-
bilir. Kaydırmadan hareket ettirmek için > Shift + Orta Mosue Buton’una basılı tutup sürüklemek 
yeterli olacaktır. Keyframe üzerinde yapılan değişiklikler çalışma alanında obje üzerinde de aynı 
anda görülebilir.

Keyframe'leri kopyalayıp yapıştırmak için Ctrl+C / Ctrl+V tuşları kullanılabilir. Dikkat edilmesi 
gereken husus, Copy Paste işlemi birden fazla kanalda yapılıyorsa kanalların 1 numaralı alanda 
seçme sırasının doğru yapılması gerektiğidir. Yanlış sıralamayla seçerek copy paste yapılırsa ya-
pıştırılan Keyframeler ters olarak görünebilir.

Seçilen Keyframe'lerde yapılan animasyonlara çeşitlilik katmak için Tangent adı verilen ayarlar-
dan yararlanılabilir. 

Toplamda 7 çeşit Tangent bulunmaktadır. Bunlar sayesinde yapılan animasyona hız keskinlik 
ve esneklik kazandırılabilir.

Tangentler’e birbirinden bağımsız olarak müdahale etmek için Break Tangent seçeneği kullanı-
labilir. Bu sayede bir Keyframe’de bulunan her tutamaça ayrı ayrı müdahale edebiliriz.
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KARAKTER İLE YÜRÜYÜŞ DÖNGÜSÜ OLUŞTURMA
Karakter hareketleri için aynı modellemede olduğu gibi bir referans kullanmak hareketlerin 

daha kolayca oluşturulmasını sağlayacaktır.

Ref: endlessreference.com

Referans görseli iki ekran ile çalışılıyorsa yan ekrana tam ekran olarak yerleştirip çalışmak daha 
kolay bir çalışma imkanı sağlayacaktır.

Oluşturduğumuz karakter model dosyasını açıp Time Line alanını daha kolay çalışma imkanı 
sağlaması açısından 25 kareye indirelim.

Karakteri oluştururken kullanılan tüm katmanları “R” referans moduna alalım. Bu sayede hare-
ketlendirme esnasında istenmeyen kaymalara ya da zor seçim işlemlerinin önüne geçilmiş olunur.

Auto Key seçeneğini  aktif hale getirelim. Buton kırmızı renge dönüşecektir. Bu sayede ya-
pılacak olan tüm değişiklikler otomatik olarak kaydedilecektir.

K Daha sonra karakter kontrol objelerinin tamamı seçilyken ve Time Line Navigasyon çizgisi 
“1” karedeyken ”S” tuşuna basarak tüm kontrol objelerine Key atayarak başlangıç pozisyonunu 
sabitleyelim.

Karakter Kalça Kontrol Objesini tutarak biraz aşağı çekelim ve karakterin üst gövdesini yere 
yakın hale getirelim. Aşağı doğru çekildiği zaman kontrol objesinin Channel Box alanındaki Trans-
late Y koordinatında küsuratlı rakam olmamasına dikkat edelim. Bu sayede başlangıç ve bitiş ha-
reketlerini daha kolay denk hale getirebiliriz. Bu örnekte Translate Y değeri “-7” olarak girilmiştir.
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Daha sonra Sol Ayak Kontrol objesini tutarak Move Tool ile sol bacağı öne, Sağ Ayak Kontrol 
objesini tutarak da sağ ayağı da arkaya doğru Move Tool ile kaydırarak ilk kare yürüme pozisyo-
nunu verilebilir. Eğer Keyframe otomatik olarak verilmiyorsa kontrol objeleri seçiliyken “S” tuşuna 
basılabilir.

 

Oluşturduğumuz Ayak Ucu Döndürme kanalına da değer girerek ayağın yürüme pozisyonuna 
gelmesi ve kıvrılması sağlanabilir. 

Önden görünüm ekranına gelerek ayakların arasındaki fazla açıklık ayak kontrol objelerini tuta-
rak Move Tool ile içe doğru hareket ettirilerek giderilebilir.

Kalça kontrol objesini kullanarak kalçayı bir iki derece döndürerek ve elleri de referans görse-
lindeki başlangıç noktalarına ve dirsek kontrol objelerinden yararlanarak karakterimizi yürüme 
başlangıç pozisyonuna getirelim.

 

Son olarak da gövdeyi öne doğru eğerek yürüme pozisyonunu kabaca tamamlayalım. 
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Yürüme animasyonu bir Loop (tekrar eden) animasyon olacağı için başlangıç pozisyonundaki 
tüm Keyframe'lerin tamamı kopyalanarak 25. kareye de yapıştırılması gerekmektedir. Bu sayede 
başlangıç ve bitiş hareketleri aynı olacağından yürüme hareketi kesintisiz olarak dilediğimiz uzun-
lukta devam edecektir.

Orta Yürüme Pozunu ayarlamak:
25 kareden oluşan yürüme animasyonunun tam ortasına denk gelen 13. karede karakter ilk 

karede yaptığı başlangıç hareketinin tam tersini yapmalıdır.

Bu duruma göre karakterimizin sağ ayağı önde sol ayağı arkada, Sağ eli arkada Sol eli önde 
olmalıdır. Kontrol objelerinin değerleri de aksi yönde aynı değerde olması dengeli bir yürüyüş için 
önem arz etmektedir. Yani ayak kontrol objesi sağ ayağı ileri taşımak için “7” değeri aldıysa geriye 
doğru taşımak için “-7” değer verilerek denk bir zıtlık sağlanmalıdır.

Kalça rotate değerini ve kolları da zıt değer olarak girerek aksi istikamette dönemsi sağlanabilir. 

Bu işlemden sonra karakterin yürüme döngüsünde temel 3 keyframe durağı olmuş durumda-
dır:

1. karede başlangıç pozu, 13. karede başlangıç pozunu tam zıttı poz ve 25. karede başlangıç 
pozunun aynısının kopyası.

“Aşağıda” Ara Pozunu Girmek:
Zaman çizelgesinde 4. kareye gelelim. Bu kare başlangıç olan 1. kare ve 13. karenin ortasında-

ki hareketi oluşturacağımız karedir. Referans görseline bakıldığında modelin aşağıya doğru hafif 
çömeldiği görünmektedir. Bunun için kalça kontrol objesini tutarak karakterimizin kalça kısmına 
aşağıya doğru indirebiliriz. 

Sol ayağın Ayak Ucu Döndürme seçeneğini ise “0” olarak girelim ve ayağın tamamen yere bas-
masını sağlayalım.

Arkada kalan sağ ayağın ise kontrol objesinde bulunan Ayak Ucu Döndürme değeri artırılarak 
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ayağın parmak ucunun yere temas etmesi sağlanır. Sağ ayak Move Tool ile geriye doğru taşınır. Sol 
el biraz daha arkaya ve sağ el de biraz daha öne doğru taşınabilir. Sonuç olarak 4. kare pozisyonu 
şu şekilde oluşur:

1 ve 15. karelerde yapılan işlem gibi, 4 ve 16. karede de aynı aksi hareket oluşturma işlemini ya-
palım. Yani 4. karede oluşturulan pozun tam zıt halini 16. karede sağ ayak önde sol ayak arkada ve 
sağ kol arkada sol kol önde olacak şekilde diğer hareket ettirilen parçalar ile birlikte düzenleyelim.

4. karedeki pozun zıt duruşunu 16. karede yaptığımızda ise karakterimizin son hali bu şekilde 
olacaktır.

Geçiş Pozlarını oluşturmak:
7 ve 19. karede bulunan geçiş pozlarını oluşturmak için referans görselini inceleyebiliriz. 

  

Bu pozda sol ve sağ bacak yan yana dururken vücut ise biraz yukarıda duracak şekildedir. Kollar 
ise serbest şekilde yanlarda bulunmaktadır.

Bu pozu oluşturmak için zaman çizelgesinde “7. kareye” gelelim. Kalça kontrol objesini tutarak 
gövdeyi yukarı kaldıralım.
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Sağ ayak kontrol objesini yukarı doğru kaldırarak sağ ayağı havaya kaldıralım. Rotate ile de 
döndürerek ayak ucunun hafif yere doğru dönmesini sağlayalım. Sol ayak kontrol objesini ise ge-
riye doğru çekerek her iki bacağın aynı hizada olmasını sağlayalım.

Sağ ayak havada sol ayak ise yerde vücudu taşıyacak şekilde pozlandırma yapalım. Sol kol biraz 
önde olacak şekilde hizaladıktan sonra zaman çizelgesinde ileri geri  ilerleyerek yürüme animas-
yonunda bozukluk olup olmadığını kontrol edelim. Kontrolü sadece bir açıdan değil önden, sağ 
yandan sol yandan ve perspektif açısından yaparak hatasız olmasını sağlayalım.

7. kare’nin karşıt pozunu oluşturmak için 19. kareye ilerleyelim. 7. karede karakterin pozunun 
aynısını  diğer karelerde de yaptığımız gibi bu sefer   simetrik olarak karşıt pozunu oluşturalım. 
Sağ ayak yerine sol ayak havada ve sağ ayak yerde olacak şekilde düzenleyelim. Sol kolun önde 
olması yerine de sağ kol önde ve sol kol biraz arkada olacak şekilde modele poz verdirelim. Kalça 
kontrol objesinden tutarak yukarı doğru kaldırarak 7. kare ile aynı sevide olması sağlayalım. Eğer 
kalça rotasyonu da verildiyse kalça kontrol objesinin Rotate değerlerine de dikkat ederek hareket 
pozunu verelim.
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Ayak ucu döndürme değerini sağ ayakta “0” sol ayakta ise ayağı kıvıracak değerde 7. karede 
sağ ayak ile aynı olacak şekilde girelim. Tüm ayarlamalardan sonra model şu şekilde görünecektir:

Yüksek Poz Oluşturmak:
Son yürüme pozu olan, 10 ve 22. karelerde bulunan yürüken ayak ucunda yükselme pozunu 

yaparak yürüme döngüsü hareketini tamamlayabiliriz. 10 ve 13. kareler arasında fazla bir fark ol-
mamasından dolayı kolayca düzenleyeceğimiz ince ayarlama pozu olarak da düşünülebilir.

 

Sağ ayak kontrol objesini 10. karede bulunduğu pozisyondan biraz daha öne getirerek ve Ayak 
Ucu Döndürme kanalındaki değeri “0” yaparak ayağın 13. karede tamamen yere tam basması için  
gerekli olan pozun ön hazırlığı yapılmış olunur.

7 ve 13. kareler arasında zaman çizelgesi üzerinde ileri geri giderek, 10. karede bulunacak olan 
ara pozu ayarlanabilir. Sağ sol kol ve sağ sol ayak kontrol objeleri ile kalça kontrol objelerinin 
kullanılması ve ayak kıvrılma satırındaki değerlerin takip edilmesi yumuşak geçişli bir animasyon 
oluşturmada bize yarımcı olacaktır. 

10. karedeki ayarlamaları yaptıktan sonra zaman çizelgesinde 22. kareye giderek 10. karedeki 
pozun simetrik aksi pozunu oluşturalım.
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22. kare pozunu ayarladıktan sonra zaman çizelgesinin sağ tarafında bulunan Play tuşuna basa-
rak yürüme döngüsünün eksiksiz olup olmadığını kontrol edelim.  Özellikle başlangıç ve bitiş Keyf-
rameleri arasında farklılık olup olmadığını kontrol edelim. Eğer farklılık bulunuyorsa animasyonda 
kesintiler oluşacaktır. Bu işlemlerden sonra karakterin hareketlerinin keskin ve robotik olmaması 
için Graph Editor alanında ince ayarlamalar yapılması daha kaliteli ve akışkan bir animasyona sa-
hip olunmasını sağlayacaktır.

Graph Editor ve İnce Ayarlamalar:
Graph editor alanını üst menüde bulunan Windows, Animation Editors, Graph Editor sekme-

sinden açılmaktadır. 

Açılan pencerede animasyon grafiklerinin görünmesi için mutlaka sahneden içerisinde animas-
yon barından bir obje seçilmelidir. Seçilen objenin Translate, Rotate, Scale, Visibility gibi Keyf-
rameleri çizgisel grafik şeklinde görülebilir. Her sarı nokta o koordinatta yapılmış olan değişikliği 
simgelemektedir. Bu noktaları seçerek ileri geri hareket ettirerek ya da silerek animasyona ince 
detaylar katılabilir. Ayrıca her sarı noktayı seçtiğimizde yanlarında beliren tutma kollarından çizgi 
grafiği esneterek o noktada oluşturulan animasyona esneklik ya da farklılık katılabilir. 

Graph Editor’ün sol tarafında bulunan Rotate, Scale ve Translate seçeneklerinden üzerinde 
değişiklik yapılması istenen koordinat satırı seçilerek izole bir biçimde karışıklığa yer vermeden 
değişiklik yapılabilir.

Graph Editor alanının üst kısmında bulunan rakamlar çalışma alanımızda alt kısımda bulunan 
Timeline ile aynıdır. Bu alan da animasyondaki kareleri göstermektedir. Her sarı nokta bulunduğu 
yer itibari ile o zaman aralığındaki yerini gösterir.
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Animasyonda gereksiz olan ve karakterin hareketlerinde kesintilere neden olan Keyframe nok-
talarını temizleyerek daha yumuşak geçişler oluşturulabilir. Aşağıdaki örnekte 2 numaralı Keyf-
rame 1 ve 3 numaralı Keyframeler arasında bulunarak harekette kesintiye ve düzensiz harekete 
neden olmaktadır. Buna benzer noktalar animasyon üzerinden kontrol edilerek silinebilir.

Graph Editor alanının üst bar kısmında bulunan Keyframe kısayollarını kullanarak da Keyframe 
noktalarına çeşitlilik kazandırılabilir. Bu alandaki seçenekler Keyframelere keskin geçiş, yumuşa-
tarak geçiş, yumuşak giriş keskin çıkış ya da keskin giriş- yumuşak çıkış gibi hareket özellikleri 
katmakta kullanılabilir. After Effects programında  bulunan ve Keyframelere verilen Easy Ease ya 
da Smooth seçeneklerine benzeyen bu özellikle animasyon hareketleri daha da detaylandırılabilir. 

Animasyon üzerinde son rotuşları da yaptıktan sonra 25 kareden oluşan kısa yürüme döngüsü 
animasyonunu uzatarak karakterin yürüyüşünde devamlılık sağlamak gerekmektedir.

ANİMASYON DÖNGÜSÜNÜ UZATMA
Karakter animasyonunu çalışma kolaylığı olması açısından 25 karelik bir zaman çizelgesi üze-

rinden oluşturmuştuk. Bu zaman çizelgesini uzattığımız zaman karakterin 25. kareye kadar adım 
attığını ve daha sonraki karelerde durduğu görülebilir. 

Yürüyüş animasyonunu 200, 300 kare kadar uzatmak için Curve Editor alnını açarak tüm kont-
rol objeleri seçiliyken Keyframe'lerin tamamı seçili hale getirilir. Graph Editor alanındaki View 
menüsündeki Infinity sekmesinin yanındaki kutucuğu aktif hale getirmek gerekmektedir.
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Keyframelerdeki animasyonların ise sürekliliğini sağlamak için Yine aynı üst menü alanından 
Curves menüsünden > Post Infinity > Cycle seçeneğini seçmemiz gerekmektedir. Bu sayede 
Graph Editor alanında Keyframe grafiklerinin silik bir şekilde devamlılık gösterdiği görülebilir.

Yapılan bu işlem sayesinde animasyon süreklilik barındırır. Animasyon içeriğine göre bazı du-
rumlarda  animasyonu “Bake” tabir edilen işlem yapmak gerekir. 

Bake işlemi: Animasyonun her karesine Keyframeler ekleme işlemidir. Pişirme kısıtlamaları, 
alan değiştirme veya simülasyonları anahtar karelere dönüştürmek gibi başka amaçlar için de 
kullanılabilir. Bu sayede animasyon dosyası farklı programlar arasında paslaşarak işlenebilir.

Yürüme animasyonumuzu Bake etmek içinse Yine Graph Editor menüsünde bulunan Curves 
> Bake Channel seçeneğini kullanılabilir. Bu işlemi yapmadan önce dosyanızı farklı kaydedilmesi 
geriye dönük düzenlemeler yapılabilmesi açısından gereklidir.

Bake Channel seçeneğinin yanındaki kutucuğa basarsak Bake seçeneklerini gireceğimiz pen-
cere açılacaktır. Bu alanda bulunan Start/End seçeneğini aktif ederek animasyonun Bake edile-
cek kısmının başlangıç ve bitiş süreleri ayarlanabilir. 

Bu çalışma için Start:1 End: 90 olarak seçebiliriz. Bake tuşuna bastığımızda zaman çizelgesin-
deki kırımızı Keyframelerin arttığını ve her kareye yayıldığını görülebilir.

Bake işlemini yaptıktan sonra artık ihtiyacımız kalmadığı için Curves> Post Infinity > Constant 
seçeneği seçilebilir. Bu sayede animasyon sadee Bake edilen kareler boyunca hareket edecektir.
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Son olarak da View menüsünden Infinity seçeneğini kapatalım. Play tuşuna basarak animasyo-
numuzun 90. kareye kadar ilerlediğinden emin olalım.

95. karede karakteri standart başlangıç pozuna geri getirerek “s” kısa yolu ile Keyframe ek-
leyelim. Karakteri 90. kareye kadar yürüyerek 95. karede durma pozuna geçiş yapacak şekilde 
ayarlayalım.

Daha sonra tüm vücudu hareket ettiren ana kontrol objesini 1. ve 95. kareler arasında karakte-
rin yürüme yönünde ilerleterek "s" tuşu ile Keyframe verelim. Bu sayede karakter durduğu yerde 
değil ileriye doğru yürüme hareketi yapacaktır. Ayak hareketlerinin hızını ana kontrol objesinin 
ileriye doğru olan mesafesini ayarlayarak yapabiliriz. Mesafe doğru olarak ayarlanırsa karakterin 
ayaklarında kayma meydana gelmeyecektir. 

Bu örnekte karakterin yürüyüşü “z” koordinatında 380 birim üzerinden oluşturulmuştur.

 

Karakterin adım hızının değerleri, daha iyi ayarlama amaçlı Ana Kontrol Objesi seçiliyken 
Graph Editor alanından animasyon eğrisinin başlangıç ve bitiş noktalarına müdahale ederek ve-
rilebilir.
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Yürüme animasyonu bu şekilde tamamlanmış bulunmaktadır. Fakat önemli olan bir başka kı-
sım ise karakterin kıyafetlerinin karakterle beraber hareket etmemesidir. Kıyafetler karakter ile 
bilikte modellenip Riglenmediği için kıyafet modelleri hareket etmemektedir. Ayrıca karakteri yü-
rüme animasyonu oluşturmak için hareket ettirdiğimiz için kıyafetler karakter gövdesinden farklı 
pozda durmaktadır. Bunu gidermek için;

Animasyon zaman çizelgesine eksi (-) değerlerde zaman dilimi ekleyelim. Timeline alanında 
sağda bulunan iki boşluk kutucuğu “0” karesinden öncesine eksi değerli zaman eklemede kulla-
nılmaktadır.

-30 kare kadar başlangıç pozu oluşturmak için zaman değeri girelim. 

-30. kareye gelip bu zaman diliminde karakteri modellendiği “T” poza geri getirelim. Kontrol 
objelerine “0” değeri girerek Keyframe verelim. Kıyafet Layer'ını görünür yaparak kıyafetin karak-
tere tam olarak oturduğundan emin olalım (Pluralsight, 2023).
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ÜNİTE 7 SİMÜLASYON

	 Modellenen karakterin kıyafetlerini Layer alanından görünür hale getirelim. Pantolon ve 
gömlek kısmının Polygon'larını artırarak ve alınlık vererek Maya’da bulunan NCloth simülasyonu-
na uygun hale getireceğiz.

 

İlk önce pantolon modeli üzerinde detaylı çalışabilmek için gömlek modelini üst menüden > 
Display > Hide > Hide Selection ile gizleyelim. Pantolon modelini Üst menü alanından > Mesh > 
Smooth ile Division değerini 1 girerek yumuşatalım. Bu alandaki Division ayarı modelimize kaç 
kat yumuşatma amaçlı Polygon eklememize yaramaktadır. 

 Yumuşatma verdiğimiz pantolon modelini Ctrl+D ile kopyasını oluşturalım. Bir kopyasının 
isminin sonuna onuna Cloth yazarak simülasyonda kullanılacağını belli edelim. Diğer kopya Pan-
tolon modelinin ise Sonuna Yüksek Polygon'lu olacağını belli eden “Yuksek” yazısı yazılabilir.

İsminin sonunda Cloth yazan pantolon modelini şimdilik Ctrl+H ile gizleyelim. Pantolon_Yuk-
sek isimli modeli seçelim ve üst menüden Edit Mesh > Extrude ile pantolon modeline kalınlık 
verelim. Bu model için Extrude menüsünde Thicknesss alanına “0.2” değerini girmek yeterli oldu 
fakat farklı modeller için farklı değerler uygun olabilir.
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NCLOTH EFEKTİ UYGULAMAK
Extrude ile kalınlık verdiğimiz pantolon modelini Ctrl+H ile saklayalım. Kalınlığı olmayan Cloth 

yazılı pantolon modelni seçelim. Model üzerinde History kanalında bilgiler bulunuyorsa bunları 
da üst menü > Edit > Delete by Type > History seçeneği ile silelim.

Pantolon modelinin karakterin iskeleti ile birleştirilmesi gerekmektedir. Bu sayede aynı anda 
hareket edeceklerdir. Bunun için önce Pantolon modelini daha sonra da kalça kemiğinin üzerinde 
bulunan ana kemiği seçelim. 

Rigging menülerini aktif hale getirelim ve üst menüden Skin > Bind Skin seçeneğinin kutucu-
ğuna basarak menüsünün açılmasını sağlayalım ve açılan seçenekler penceresinden > Bind To 
seçeneğinden Selected Joints seçelim. Max Infuluence seçeneğini”1” olarak girelim ve Bind skin 
butonuna basarak işlemi tamamlayalım.

Bu işlemden sonra play tuşuna bastığımızda karakterimiz yürürken pantolon da onunla bera-
ber hareket edecektir. Bacak kısımları pantolon modelinin içinden geçmesi normaldir.  

Kemik sistemine eklediğimiz pantolon modeline şimdi efekt eklememiz gerekmektedir. Bunun 
için Modelling menüsü yerine FX menüsünü aktif hale getirerek üst bar menüden NCloth sekme-
sinin açılmasını sağlayalım.
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Üst bar NCloth menüsünde alt sekmesinde bulunan Create NCloth seçeneğine pantolon mo-
deli seçiliyken tıklayalım. Sol tarafta bulunan Outliner alanına NCloth ve Nucleus olarak iki yeni 
obje belirecektir. Bunlar pantolon modeline eklenen NCloth özelliğini göstermektedir. 

Nucleus objesi seçiliyken Attribute Editor alanını açacak olursak Ncloth Node ile ilgili ayarların 
yapıldığı pencere görülebilir.

Simülasyonun gerçek zamanlı bir şekilde oynatılması için Timeline’a sağ tıklayarak açılan liste 
menüden Playback Speed > Play Every Frame Free seçeneğini seçelim. Daha sonra Play tuşuna 
basarak animasyonu oynatalım. Pantolon objesinin kemiğe linklenmesine rağmen karakterle bir-
likte hareket etmediği görülebilir.

Ayarlamasını yapmak için önce sol kısımdaki Outliner alanından NCloth objesini seçelim. 
Daha sonra  sağ kısımda bulunan Attribute Editor alanındaki menüden Presets kısmındaki Tshirt 
> Replace seçeneğini seçelim. Bu sayede otomatik olarak giysi kumaşı simülasyon ayarları  objeye  
eklenecektir.
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Yine aynı menü alanında bulunan Dynamic Properties sekmesindeki Input Mesh Attract de-
ğerini “1” olarak girelim. Hemen altında aktif  olan “Input Attract Method” seçeneğini ise “Lock 
values of 1 or Greater” olarak seçelim.

Play tuşuna bastığımızda pantolon modelinin karakterle birlikte hareket ettiğini fakat kumaş 
özelliğini kaybettiği görülebilir. Kumaş özelliğini belirli bölgelere vererek modelin hem karakterle 
beraber hareket etmesini hem de kumaş tepkileri vermesi sağlanabilir. 

Bunun için bel kısmındaki bazı Vertex noktalarını seçerek sabitlemek gerekmektedir. Pantolon 
modeli seçiliyken (NCloth node değil ilk oluşturduğumuz Pantolon_Cloth yazılı 3D modeli seçe-
lim) üst menüden > NCloth > Paint Vertex Properties > Input Atract sekmesinden kutucuğa ba-
sarak özellikler penceresini açalım. 
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Açılan pencerede NCloth Attributes sekmsinden Input Attract seçeneğini seçelim.

Paint Attribute sekmesinde bulunan Value değerini “1” yerine “0” yapalım. Daha sonra da Flo-
od yazılı butona basalım. Bu sayede pantolon modelinin beyazdan siyaha dönüştüğü görülebilir.

"0" yapılan Value değerini tekrar “1” yaparak modelin bel kısmı boyamaya başlanabilir.

Aynı menüde bulunan “Stroke” sekmesindeki Symetry seçeneğini de aktif hale getirerek mo-
delin iki tarafını da aynı anda boyanabilir.

Bel kısmı beyaza boyanan ve sabitlenen pantolon modelinin kapsama alanını Smooth seçeneği 
ile yumuşatılabilir. Bu sayede sabitlenen kısım keskin hatlardan kurtulacak ve karakter hareket 
ederken kumaş daha doğal bir şekilde hareket edecektir.
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Boyama işlemi bittikten sonra üst menüden seçme okuna basarak bu pencereyi kapatalım. 
Play tuşuna basıldığında karakter yürürken şort kısmının beline sabitlenmiş olduğu görülebilir. 
Ancak NCloth simülasyonu kumaş hesaplamalarını yaparken karakterin gövdesini hesaba katma-
maktadır. Gövdeyi de bu hesaplamaya Passive Colider olarak katılması gerekmektedir.

Gövdeyi de simülasyon içerisinde hesaplanabilir bir Colider olarak atanması gerekmektedir. 
Collision objelerini ya da Collider’ları kısaca simülasyon objelerinin etkileşimde bulunduğu nes-
neler olarak tanımlayalım.

Bunun için gövde modeli seçiliyken üst menüden NCloth > Passive Colider seçeneğini seçme-
miz gerekmektedir. Bu işlemi yapar yapmaz yine Outlinler menüsünde NRigid objesinin oluştuğu 
görülebilir.

 

Son olarak da Outlinler alanından Nucleus objesini seçelim ve Attribute Editor alanından 
Time Attribute sekmesinden Start Frame’i -20 olarak girelim. Zman çizelgesini -20 olarak ayar-
ladığımız için animasyon da 1. kare yerine -20. kareden başlamak durumunda. Daha sonra Play 
tuşuna basarak yeniden yürüme animasyonunu başlatalım.
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Karakter modeli yürüdükçe pantolon modeli de onunla beraber hareket ederek gövdenin şek-
line girecektir.

Simülasyon kalitesini artırmak için Outliner alanında bulunan Nucleus objesi seçiliyken sol ta-
rafta bulunan Attribute Editor alanından Solver Attrıbutes kısmından Substeps ve Max Collision 
Iterations alanından değerleri artırarak simülasyon hesaplama ayarlaması yapılabilir. Ancak unu-
tulmamalıdır ki bu değerler arttıkça hesaplama süreleri de artacaktır.

Kumaş simülasyonu eğer yetersiz ya da istenildiği gibi kumaş salınım özelliği vermeden oluşu-
yorsa dikkat edilmesi gereken karakter modelin ölçüsüdür. Eğer karakter fazla küçük modellen-
diyse kumaş simülasyonu da küçük bir kumaş parçasına göre hesaplanacak dolayısıyla herhangi 
bir sallanma kıvrılma kırışma efekti oluşmayacaktır. 

Bir diğer önemli husus ise kumaş özelliği verecek olan modelin Polygon sayısıdır. Çok düşük 
sayıdan oluşan Polygon sayılarına sahip objeler yeterli detaylı kıvrılma kırışma özelliği göstereme-
yebilirler.

Eğer kumaş modeli gereğinden fazla esnek ve yumuşak özellikler oluşturuyorsa ayarlamak 
için Outliner alanından NCloth objesini seçelim ve Attribute editor alanından NCloth Shape1 sek-
mesinden Dynamıc Propertıes kısmından Stech Resıstance ve Cloth Compressıon satırlarından 
ayarlamalar yapabiliriz. Öncelikle Cloth Compression satırındaki değeri “150” olarak girerek de-
neme yapalım. Simülasyon durumuna göre Bend Resıstance değerini de “10” değeri gibi artırarak 
denemeler yapılabilir. Kumaş istenen değerden daha fazla hareket ediyor ve hafif görünüyorsa 
yine aynı alanda bulunan Mass ve Damp satırındaki değeri artırarak kumaşa hacim ve ağırlık özel-
liği eklenerek daha ağır bir kumaş gibi hareket etmesi sağlanabilir. 
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CACHE DOSYASI OLARAK SİMÜLASYON KAYDETMEK:
Ayarlamalardan sonra kumaşın hareketlerinden memnun kalındığı taktirde simülasyon değer-

lerini CACHE dosyası olarak kayıt ederek animasyonu gerçek zamanlı oluşturulabilir. Bu sayede 
zaman çizelgesinde ileri geri hareket edildiğinde kumaş simülasyonunda bozulmalar ya da karak-
terin üzerinden kumaşın ayrılması gibi sorunlar oluşmayacaktır.

Zaman çizelgesi alanında bulunan başlangıç ve bitiş karesi alanına cache alınacak kare değeri 
olan 110 bitiş karesi değerini girerek Cloth yazılı olan pantolon modelini Outliner alanından se-
çelim. Daha sonra üst menüde bulunan Ncache menüsünden Create New Cache > Nobject seçe-
neğinin yanındaki seçenek kutusuna basarak seçenekler penceresini açalım.

Açılan pencereden üst satırda bulunan Cache Dırectory alanından Cache dosyalarının kayıt 
edileceği dosya seçilebilir. Cache Name kısmına hangi objenin Cache bilgisi kayıt edilecekse o ism 
yazılabilir. One File seçeneği ile tek bir Cache dosyasında tüm kare animasyonlar saklanabilir.  Cac-
he Time Range alanından ise animasyonun kaç karesinden Cache kayıt yapılacağı seçilebilir. Start/
End seçeneğini seçerek 1- 100 karelerini seçerek Create butonuna basarak kayıt işlemi yapılabilir.

Bu işlemden sonra time line alanında ileri geri yaptığımız zaman kumaş animasyonunun da 
bozulmadan oynadığını görebiliriz.

Artık simülasyon dosya olarak kayıt edildiğine göre Outliner alanından Nucleus objesini seçe-
rek Attribute Editor alanındaki ayar yerinden Nucleus1 sekmesindeki Enable kutusundaki işareti 
kaldırarak kapatabiliriz. Bu sayede boşuna hesaplama işlemi yapmayacaktır.
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Timeline alnına sağ tıklayarak Playback Speed seçeneğini Real Time olarak seçerek, oynatma 
hızını gerçek zamanlıya çevirerek animasyonun ön izlemesi daha sağlıklı yapılabilir.

Aynı objeyi tekrar simüle etmek gerekir ise barındırdığı Cache verilerini silmek için pantolon 
objesini Outliner alanından seçerek üst menüden NCache > Delete Cache seçeneğini seçerek sil-
me işlemi gerçekleştirilebilir. Simülasyonu tekrar Cache olarak kaydetmeden önce mutlaka Nuc-
leus objesini seçerek Attribute Editor alanından Enable kutusunu aktive etmeyi unutmayalım.

Eğer kumaş modelinde karakterin yürümesi sırasında iç içe geçmeler ve istenmeyen kıvrılma-
lar oluyorsa, Ncloth pantolon modelini Outliner alanından seçelim. Attribute editor alanında Clo-
thN1 alanındaki Collısıons ekmesinden Solver Display seçeneğini açalım. 

Model üzerinde Vertex noktaları sarı toplar şeklinde görüntülenecektir. Bu topların arasındaki 
boşluk açıldıkça model üzerinde katlanma ve iç içe geçme gibi durumlar oluşacaktır. Bu sarı 
alanları büyüterek bozulmalar engellenebilir. Hemen üst kısmında bulunan Self Collıde Wıth Sca-
le satırındaki değeri “3” yerine “4,5” gibi daha yüksek değerler girerek katlanma engellenebilir. 

Solver Display modunu “off” diyerek sarı noktaları kapatalım ve bir deneme simülasyonu için 
play tuşuna basalım. Tabi bunun için önce üst menüden Ncache menüsünden > Delete Cache ile 
önceki simülasyonu silmeli ve sonrasında Outliner alanından kapattığımız Nucleus objesi seçi-
lerek Attribute alanından Enable aktif edilerek yeni simülasyona hazır hale getirilmelidir. Aksi 
taktirde bir önceki Cache olarak klasöre kaydedilen simülasyon oynamaya devam edecek ve bizi 
yanıltacaktır.

Kumaş hareketlerinden memnun kalınırsa tekrar yukarıda anlatılan klasöra Cache olarak kay-
detme işlemleri yapılarak işlem tamamlanır.

Simülasyon verilen düşük Polygon modeli yüksek Polygon modele yansıtmak için;

Hide ile gizlenen yüksek Polygon'a sahip olan modeli Show ile görünür hale getirelim. Her iki 
pantolon modeli de sahnede görünür haldeyken Outliner listesinden önce Yüksek Polygon'lu 
(Extrude ile kalınlık verilen) modeli sonra Düşük Polygonlu (kumaş simülasyonu verilen) modeli 
seçelim. Seçım öncelik sıralaması önemlidir.
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Üst menü alanından Deform > Wrap seçeneğini seçelim. Bu sayede yüksek Poly model düşük 
Poly modele kaplanmış olacaktır. Düşük Polygn pantolon modelini Outliner alanından seçerek 
gizleyelim. Play tuşuna basarak animasyonun yüksek poly pantolon modelinde oluştuğunu kont-
rol edebiliriz. Eğer pantolon modelinde Polygon'ların kıvrılması sorunluysa model seçiliyken “W” 
tulunun üzerinde bulunan “3” rakamına basarak Polygon yumuşatma ön izlemesiyle ayarlama 
yapılabilir.

Yüksek Polygon pantolon modeline Wrap ile verdiğimiz kıvrılma simülasyonunu da Cache dos-
yasını oluşturulması gerekmektedir. Kumaş olmadığı için NCache seçeneğini değil onunla aynı 
hizada üst menüde bulunan Cache menüsünün kullanılması gerekmektedir.

Timeline çizgisine sağ tıklayarak Playback Speed sekmesinden Play Every Frame Free seçene-
ğini aktif edelim. Daha sonra üst menüden Cache seçeneği Geometry Cache > Create New Cache 
seçenek kutusuna basarak Cache bilgilerinin kayıt edileceği klasörleri seçelim. Cache Directory 
seçeneğinde Cache bilgisinin kayıt edilecek klasörünü seçelim. Cache Name alanından dosya ka-
yıt ismini girelim. Create butonuna basarak kayıt işlemini gerçekleştirelim.

Cache işlemi yapıldıktan sonra ihtiyaç halinde yüksek Polygon'lu pantolon modelinin History 
bilgileri timeline alanında ilk kareye (-20) gelinerek silinebilir. Bu sayede animasyon dosyası daha 
az yer kaplayacaktır. Fakat geriye dönük düzenleme işlemleri yapılamayacağı göz önünde bulun-
durulmalıdır.

Play tuşuna basıldığında pantolon modelinin hareket etmediği görülebilir. Bunun nedeni 
Wrap Deformer’ın artık model üzerinde bulunmamasıdır. Bunun için yüksek Polygon pantolon 
modeli seçiliyken üst menüden Cache > Geometry Cache > Import Cache seçeneği ile kayıt edi-
len Cache bilgilerini modele geri yükleyebiliriz.

Timeline alanında sağ tıklayarak Playback Speed’i real time yaparak animasyonu gerçek hızın-
da Cache dosyası ile inceleyebiliriz.
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Yapılan işleler özetlenecek olursa. Tek katmandan oluşan düşük Polygon sayılı modeli kumaş 
simülasyonu NCloth ile hareketlendirildi. Daha sonra düşük Polygon model yüksek Polygon model 
ile kaplanarak Vertex değerleri ona yansıtıldı. Yansıtılan değerler Geometry Cache dosyası olarak 
kaydedildi. Son olarak da kayıt edilen Cache bilgileri yüksek Polygon pantolon modeline İmport 
edilerek animasyon sağlandı.

GÖMLEK MODELİNİ SİMÜLE ETME
Karakter dosyasının kopyasını oluşturarak çalışmaya devam edebiliriz. Öncelikle pantolon si-

mülasyonu için kullanılan NCloth objesini seçerek Attribute Editor alanından Enable kutucuğu-
nun tik imgesini kaldırarak gereksiz yere hesaplama yapmasını engelleyelim. Bu sayede gömlek 
için simülasyon hesaplaması yaparken boş yere pantolon modeli için de sistem zorlanmamış olur.

Aynı şekilde Nucleus objesi seçilip Attribute Editor alanından Enable kutusundaki işaret kaldı-
rılarak boşa hesaplama yapması şu an için engellenebilir. Ncloth objesi seçilen objeye aittir fakat 
Nucleus objesi sahne içindeki tüm objelerin simüle edilmesinden sorumludur. 

Daha önceden rahat çalışma amaçlı gizlediğimiz gömlek modelini “Show” seçeneği ile görünür 
hale getirelim.

Gömlek modelinin karakterin gövdesinin herhangi bir yerine değmediğinden ya da Polygon'la-
rın iç içe geçmediğinden emin olalım.
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Fazla düşük Polygon'dan oluşan gömlek modelimiz var ise gömlek modeli seçiliyken Üst Menü 
> Mesh > Smooth ile Polygon sayılarını artıralım. Üst menü Edit > Delete By Type > Delete His-
tory ile History bilgilerini silelim. Outline alanından gömleğin ismini Gomlek_NCloth olarak de-
ğiştirelim.

Gömlek modelini CTRL+D ile kopyasını oluşturalım ve isim olarak gomlek_Yuksek olarak değiş-
tirelim. Bu modele Extrude ile kalınlık verelim.

gomlek_yuksek isimli model seçiliyken üst menüden > Edit Mesh > Extrude seçeneği ile ka-
lınlık verelim.

Üst menü alanından Edit > Delete by Type > Delete history ile modelin history kanalını silelim.

Yüksek Polygon'a sahip olan Gomlek_Yuksek isimli modeli gizleyelim ve NCloth_gomlek isimli 
simülasyon verilecek modeli görünür hale getirelim. Düşük Polygon'lu modelde input history ala-
nında bir işlem olmadığından emin olalım eğer varsa Delete By Type History seçeneği ile silelim. 

Pantolon modelinde yapılan işlemlere benzer işlemleri tekrarlayalım. Önce iskelet sistemini 
Layer alanından görünür hale getirelim. 

Önce NCloth_gömlek modelini sonra da iskelet sistemindeki göğüs kafesi kemiğini seçelim.

Rigging menüsü açıkken üst menü alanından Skın > Bınd Skın seçenek kutusuna tıklayarak 
seçenekler penceresini açalım. Bind To seçeneğini > Selected Joınts, Max Influence > 1 seçerek 
Bind Skin butonuna basarak işlemi tamamlayalım.
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Play tuşuna bastığımız zaman gömlek modeli karakterle birlikte hareket ediyor olmalıdır.

Gömlek modelini NCloth objesine çevirmemiz gerekmektedir. Bunun için FX menülerini aktif 
edelim.  NCloth_gomlek modeli seçiliyken üst menüden > Ncloth > Create Ncloth seçeneği ile 
gömleği Ncloth objesine çevirelim.

Outliner alanında Ncloth2 ismiyle yeni bir Ncloth objesi belirecektir. Nucleus objesi belirmeye-
cektir daha önce oluşturduğumuz pantolon için kullanılan Nucleus objesi ortak bir objedir.

Ncloth2 objesi seçiliyken sağ tarafta bulunan Attribute Editor alanından NCloth Shape 2 sek-
mesinde Presets alanından Tshırt seçeneğini Replace ile gömlek objesine ekleyelim. Bu sayede 
simülasyonu tshirt şeklinde oluşturacak hazır ayarlar seçilmiş olur. 

Zaman çizelgesine sağ tıkla Playback Speed > Play every Frame Free olarak seçelim.
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Ncloth2 objesi outliner alanında seçiliyken Attribute Editor alanında NCloth Shape2 sekme-
sinde Dynamıc Propertıes sekmesindeki Input Mesh Attract değerini “1” olarak girelim. Hemen 
altında açılan seçenek kutusunu da Lock Values Of1.0 Or Higher olarak seçelim.

Nucleus objesini Outliner menüsünden seçelim ve Enable kutucuğunun aktif olup olmadığını 
kontrol edelim. Play tuşuna basarak animasyonun ön izlemesini yapalım.

 

Play tuşu ile birlikte gömlek modelinin hiç bozulmadan karakter ile birlikte hareket ettiği görü-
lebilir. Kumaş özelliği göstermesi için gömlek modelinin sabit kalacak yerlerini ve kumaş özelliği 
taşıyacak alanlarını belirlenmesi gerekmektedir. Bunun için Outliner alanından NCloth_gomlek 
modeli seçiliyken üst menü alanından Ncloth > Paint Vertex Properties > Input Attract seçenekler 
kutucuğuna basarak  penceresini açalım.

Açılan pencerede NCloth Attributes sekmesinde bulunan Paint Attribute seçeneğini > Input 
Attract olarak seçelim. Paint Attributes alanındaki Paint Operations seçeneğini  Replace olarak 
seçelim. Value  değerini “0” olarak belirleyelim ve Flood butonuna basarak tüm gömlek modelini 
beyazdan siyaha dönüşmesini sağlayalım. Tamamen siyah olması gömlek modelinin karakter ile 
bağlantılı kumaş özelliğinin tamamen silinmesi anlamına gelmektedir. 
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Paint Attribute alanında “0” yapılan Value değerini tekrar “1” yapalım ve gömlek modelinin 
karaktere sabitlenmesi istenen alanları beyaza boyayarak belirtelim. Gerekli görüldüğü durumlar-
da Smooth seçeneği ile beyaz alanın siyah alana geçişi yumuşatılabilir.

İşlemler bittikten sonra seçme okunu seçerek pencereyi kapatalım. Play tuşuna bastığımızda 
gömlek modelinin karakter modeli üzerinde kumaş özelliği göstermesi ve onunla birlikte hareket 
ediyor olması gerekmektedir.

Gömlek modeli ve pantolon modeli hareket halindeyken birbiri ile çakışabilir ya da modeller 
birbirinin içinden geçebilir. Bu durumda pantolon modelini de seçerek üst menüden Ncloth > 
Passive Colider olarak gösterilmesi gerekmektedir.

Gömlek kumaşının kıvrılma ve hacimsel ayarlarını yapmak için NCloth_Gomlek modeli seçi-
liyken Attribute Editor alanından Dynamic Properties sekmesindeki Damp değeri artırılabilir. 
Bu sayede gömlek karakter yürüken fazla zıplamayacaktır. Esneme ayarlarını ise en üst satırda 
bulunan Stretch Resistance ayarlarından yapılabilir. 
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Ayarlamaları yapıp ön izlemesini aldıktan sonra Cache olarak kayıt edebiliriz. Bunun için FX 
menüleri aktifken üst menü alanından Ncache > Create New Cache > Nobject seçenek kutusuna 
tıklayalım ve penceresini açalım.

Cache directory satırından simülasyonun kayıt edileceği klasörü seçelim. Altında bulunan Cac-
he Name satırına kayıt edilecek simülasyonun ismini girelim. Bu örnekte NCache_gomlek olarak 
kayıt edilebilir. File Distrubition seçeneğini one file, cache time range seçeneğini de Start End 
olarak seçerek Create butonuna basarak kayıt yapılabilir. 

Kayıt işlemi bittikten sonra kumaş simülasyonu dosya olarak kaydedildiğinden dolayı zaman 
çizelgesinde ileri geri yaparak kumaş animasyonunu daha iyi incelenebilir. Çalışma alanında daha 
hızlı bir ön izleme alabilmek için Nucleus objesini seçerek Attribute Editor alanından Enable seçe-
neğini kapatarak hesaplama işlemini yapması engellenebilir.

Oluşturulan gömlek kumaşı simülasyonundan menun kalmazsak zaman çizelgesinde ilk kare-
ye giderek üst menüden NCache > Delete Cache seçeneği ile cache dosyası silinerek, damp ve 
stretch ayarlarını değiştirerek, Nucleus objesini Enable ederek yeniden hesaplatarak Cahe olarak 
kaydedilebilir.

NCloth simülasyonlu gömleği yüksek Polygon'lu modele yansıtmak için;
Extrude verdiğimiz yüksek Polygon'lu modeli ve Ncloth özelliği verdiğimiz gömlek modelini 

sahnede görünür hale getirelim. Önce yüksek Polygon'lu modeli sonra düşük Polygon'lu modeli 
seçim sırasına dikkat ederek seçelim. Üst menü alanından > Deform > Wrap ile modelleri birbiri-
ne bağlayalım.
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Wrap işleminden sonra NCloth_gomlek isimli simülasyon eklenen düşük Polygon modeli 
Hide ile gizleyelim. Play tuşuna basarak yüksek Polygon'lu gömlek modelinde animasyon nasıl 
görünüyor inceleyelim.

Yüksek Polygon gömlek modelini de Cache ile kayıt etmemiz gerekmektedir. Bunun için FX 
menüsünü aktif edelim. Üst menü alanından Cache > Geometry Cache > Create New Cache seçe-
neler kutsuna basarak açılan pencereden kayıt edilecek dosya alanını Cache Directory alanından 
seçelim.

Cache Name alanından isimlendirerek File Distributions alanından one file ve Cache Range 
seçeneklerini belirleyerek Create butonu ile kayıt işlemini yapalım. 

Gömlek objesi artık kumaş kıvrılması gibi bilgileri kayıt ettiğimiz dosyadan almakta ve simü-
lasyon hesaplamaları yaparak sistemi zorlamamaktadır. Bu yüzden yüksek Polygon sayısına sahip 
olan gömlek modelini seçerek Delete History işlemi yapılabilir. Zaman çizelgesinde en baştaki 
kareye gelerek silme işleminin yapılması gerekir. Bu sayede Wrap Deformer gibi model üzerindeki  
gereksiz  eklerden kurtulmuş ve dosya daha rahat çalışılabilir duruma getirilmiş olur.
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Delete History seçeneğinden sonra Play tuşuna bastığımızda gömlek modelinin hareket etme-
diğini görebiliriz. Bunun nedeni Cache dosyası ile bağlantısının silinmesidir. Bu sebeple gömlek 
modeline kayıt edilen cache dosyasının yeniden yüklenmesi gerekir. Gömlek modeli seçiliyken 
üst menüden Cache > Geometry Cache > Import Cache seçeneği ile önceden kayıt edilen Cache 
dosyasını seçerek  Cache bilgilerini modele yükleyelim.

Artık Outliner alanında bulunan Ncloth objeleri silinse bile gömlek ve pantolon modelleri 
kumaş simülasyonu yapmaya Cache dosyaları sayesinde devam edecektir. Bu sayede render 
işlemleri ya da sahnede başka simülasyon objeleri bulunsa da sistem zorlanmayacak ve sorunsuz 
renderlar alınacaktır.

Karakter çalışmaları farklılıklar gösterebilir. Modellenen karakterlerde şapka, uzun saç, atkı gibi 
esnek parçalar bulunabilir. Bu parçalar için de pantolon ve gömlek modeli için uyguladığımız yön-
temleri kullanarak karakterin animasyonuna zenginlik katılabilir.

SAHNE TEMİZLİĞİ VE RENDER’A HAZIRLIK
Cache dosyalarını Geometry Cache olarak kaydedilen tüm objelerin simülasyon objelerini si-

lebiliriz.  Riglenmiş ve animasyon haline getirilmiş karakter gövdesini bile gerekli olduğu durumlar-
da Geometry Cache olarak kayıt edebilir ve istenilen Maya sahnesine İmport ederek kullanılabilir. 
Bunun için İmport edilen objenin Cache dosyasını da ardından objeye İmport ederek tanıtılması 
yeterli olacaktır. Dikkat edilmesi gereken durum bir karakter modelinin birden fazla geometrik 
modelden oluşmasıdır. Gözler, dişler, dil, saçlar gibi ayrı parçalardan oluşan ve hareketlendirilen 
modellerde her parça için ayrı Cache dosyası kayıt etmek gerekebilir.

Cache olarak kayıt edilen parçaların NCloth gibi yardımcı objeleri sahneden silinerek sahne 
temizlenebilir. Ancak unutulmamalıdır ki silinen simülasyon kontrol objeleri nedeniyle simülas-
yonda ayar değişikliğine gidilemez. Bu nedenle silme işlemini yapmadan önce çalışma dosyamızı 
farklı kaydederek yedeklemek çalışma güvenliği ve esnekliği açısından faydalı olacaktır.
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ÜNİTE 8 - RENDER
RENDER 
Öncelikle alınacak Render’ın boyutlarının ayarlanması gerekmektedir. Yapılan çalışmayı sunum 

yapılacak platforma alana göre pixel değerleri açsından ayarlamak için üst bar menü alanında bu-
lunan Render Settings menüsüne girelim. 

Bar Menüde Render Setting  butonuna basarak Render ayarlarının yapıldığı   pencereyi 
açalım

Render motoru olarak Arnold render motoru seçelim. Buradan Common sekmesinde bulunan 
> Image Sıze alanından istenilen ölçüleri girelim. TV, Youtube vs. gibi video yayını yapan platform-
larda çalışmanın sunumu yapılacak ise o zaman geçerli HD video seçeneklerini girmemiz gerek-
mektedir. Ya da çalışmanın tek kare Render’ı bir sosyal medya platformunda paylaşılacak ise o 
zaman o platformun imaj paylaşım ölçülerini kullanarak render alınması daha doğru olacaktır. 

Bu çalışmada animasyon çalışması yapıldığı için Render ölçülerini Image Size kısmındaki Pre-
sets alanından HD_1080 hazır ayarını seçerek tanımlayalım.

Render ayarlarını ve sahne aydınlatması ayarlarını yaparken, daha düşük çözünürlüklerde ren-
der İmage ayarı kullanmak zaman kazanma açısından daha yararlı olacaktır. 1080p bir görselin 
render alma süresi ile 360p bir imajın Render alma süresi arasında oldukça fark bulunmaktadır. Bu 
sebeple ilk başlarda ayarlamaları yaparken  360 ya da 480p gibi düşük pixel değerlerini render 
image size olarak kullanalım, çıkan sonuçtan memnun kalındığı zaman ise 1080p ye yükselterek 
final Render'ları alalım.

İstenirse Perspective alanından direkt olarak render alınabilir. Ya da sahneye bir Kamera oluş-
turarak da istenilen açıları sabitleyerek render alınabilir. Üst menü > Create > Cameras > Camera 
seçeneği sahneye bir kamera eklenebilir.

Eklenen kamera üzerinden sahneyi görmek için ise Camera seçili iken, çalışma alanının hemen 
üzerinde bulunan menüden Panels > Look Through Selected seçeneği ile seçili olan kamera üze-
rinden sahne görülmeye başlanabilir.

Çalışma alanına kameranın açısından bakmaya başlandığında, seçilen ekran çözünürlüğüne 
göre hangi alanların kesilip (Crop) hangi alanların Renderda görünür olduğunu anlayamayız. Bu 
yüzden çalışma alanının hemen üzerinde bulunan Fılm Gate butonuna basarak Renderda elde 
edilecek görüntü kompozisyon olarak görülebilir.
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Sahneye render amaçlı eklenen kameranın açısından bakarken render alınacak karakteri göre-
cek şekilde sağa sola Pan ve Zoom yaparak görüş açısı belirlenebilir. Görüş açısı değiştikçe kame-
ranın sahnede olan yeri de değişecektir. Dilenirse kamera hareketlerini aynı bir objeye animasyon 
veriyor gibi animasyon da vererek kayıt işlemi yapılabilir. 

Karakter yürüme animasyonu yaptığı için kamera açısı oluşturulurken zaman çizelgesini kapsa-
yacak şekilde yerleştirilmesi daha uygun olacaktır. -30 ve 110. kareler arasında karakter görüne-
cek şekilde kamera açısını belirleyelim. Çalışmamız için uygun kamera açısını ayarladıktan sonra 
kameranın bir daha hareket etmemesini isteniyorsa Çalışma alanı üstünde bulunan menüden > 
Vıew > Lock Camera seçeneğini aktive edebiliriz. 

Kamera açısını ayarladıktan sonra tekrar sahne üzerinde çalışmak için perspektif mod’a dön-
mek için Panels>Perspectıve>Perspectıve seçerek kameradan çıkılabilir.

Sahnedeki objeleri Renderda görebilmek için bir ışık kaynağına ihtiyaç bulunmaktadır. Aksi 
taktirde render almak istendiğinde render View alanında siyah bir sonuç ile karşılaşılabilir. Kolay 
ve güzel sonuç veren ışık kaynağı olarak sahneye üst menüden Arnold > Lights > Area Light ekle-
nebilir.
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Sahneye eklenen ışığı seçip sağdaki Attribute Editor kısmından ışığın parlaklığını Intensity kıs-
mındaki değerleri artırarak açalım. Deneme Render'ların süresinin kısa olması için çözünürlüğü 
460p ebatlarında tutalım.

Eklenen Area Light ışık kaynaklarını Scale Rotate ve Move Tool yardımı ile istenilen konuma ve 
büyüklüğe getirelim. 

Işık kaynaklarının sahne üzerindeki etkilerini ve nerelerin aydınlık, nerelerin karanlık olduğunu 
görebilmek için çalışma alanı üst simge menüde bulunan Use All Lights seçeneğini aktif hale ge-
tirelim. 

Üst menü> Arnold> Lights > Skydome Light ile çevreden gelen ışık kaynağı oluşturulabilir. Sky-
Dome Light ile özellikle gerçekçi HDRI tabanlı dış aydınlatma gerektiren sahneleri oluşturmak için 
kullanılır.  Temelinde bir küredir ve 360 derece ışık yayan bir kaynaktır.

 

Işık kaynaklarını modeli aydınlatacak şekilde yerleştirdikten sonra karakterin arka alanına bir 
sonsuz fon eklenebilir. Bu sayede siyah zeminden kurtulmuş ve karakteri bir mekana yerleştirmiş 
oluruz. Bunun için üst menüden Create > Curve Tool > CV Curve aracını kullanarak tam yan görü-
nümlerin birinden bir zemin çizelim. Çizim işleminden önce üst bar menüde bulunan Snap to Grid 
seçeneğini aktif ederek ve çizim esnasında düz çizim için Shift tuşuna basılı tutarak daha sağlıklı 
çizim yapalım.
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Çizilen yuvarlak köşeli yatay “L” harfine benzeyen çizginin bir kopyasını ctrl+D ile kopyalayarak 
paraleline arasında mesafe olacak şekilde yerleştirelim. Daha sonra her iki çizgi de seçiliyken üst 
menü alanından Surfaces > Loft seçeneği ile iki çizgiyi birleştirerek bir yüzey oluşturalım. Karakte-
rimiz için arka fonu bu şekilde oluşturmuş oluruz. Eğer render yüzeyi yüzeye ters şekilde gelmişse. 
Yine üst menü alanından Surface > Reverse Dırectıon seçeneği ile yüzey normallerini ters çevi-
relim.

Oluşturulan zemine parlak olmayan bir materyal atayarak render ayarlarını yapmaya devam 
edelim.

Render tuşuna basıldığı zaman    sahnenin beyaz parlak ve homojen bir ışıkla aydınlandığı 
görülebilir. Sahnede bulunan Skydome Light da dahil ışık kaynaklarının ayarlarını yapmak için, ışık 
kaynağı seçili iken sağda bulunan Attribute Editor Kısmı kullanılabilir.

Intensity ayarı üzerinden ışık parlaklığını ayarlayabiliriz. Color kısmından ise ışık kaynağı renkli 
hale getirilebilir.

Renderlarda Noise veya Grain (gren) tabir edilen görüntü kalitesini düşüren noktalanmalar - 
kumlanmalar oluşuyor ise bunu düzeltmek için temelde 2 yöntem bulunmaktadır. Birincisi ışık 
kaynakları ile ilgili, diğeri ise render motorunda yapılan ayarlar ile ilgilidir.

Işık kaynağı ile ilgili Gren gidermek için, ışık kaynağı seçili iken> Attribute menu> Samples sayı-
sını artırabiliriz. Sample sayısını 2 ya da 3 yapmak yeterli olacaktır. Daha fazla rakamlara çıkarmak 
render sürenizi çok uzatacaktır. Sample sayısını artırdığımızda ışık daha fazla ışık rayı oluşturarak 
aydınlanmanın daha kaliteli olmasını sağlar. Fakat unutulmamalıdır ki Sample sayısını artırmak 
render süresini de uzatacaktır.
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Tek bir ışık kaynağının Sample ayarını değiştirerek yeterli sonuç elde edilemiyorsa diğer ışık 
kaynaklarını da seçerek Sample sayılarını artırabiliriz.

Sample ayarlarını artırmanın  etkili olup olmadığını kontrol etmek ve iki Render imajını kıyasla-
mak için, render penceresinde Keep Image butonuna basarak resimler kaydedilebilir. Bu sayede 
render ekranında bulunan görsel kaydedilir.  Bir kere daha render butonuna basıldığında alınan 
render görseli ile kayıt edilen görsel, pencerenin altında bulunan gri bar’ı kaydırarak incelenebilir.

Render ön izleme süresini daha da kısaltmak için Render View alanına mouse ile istenilen yere 
bir dikdörtgen alan çizilerek sadece o alanın içinin Render alınması sağlanabilir. Bu sayede sahne-
nin tamamının Render alınmasını beklemek durumunda kalınmaz. Alan çizildikten sonra Render 
penceresindeki Render alma butonunu hemen yanında bulunan Render Regıon butonu ile seçili 
alan Renderlanır.

Alınan Renderın görüntü kalitesinde hala grenli net olmayan durumlar varsa üst bar menü 
alanından Render Settings > Arnold Renderer sekmesinden Sampling alt menüsünden  Camera 
(AA) ayarlarını artırarak render kalitesi artırabilir.

Tüm ayarlardan memnun kalındığı zaman, Render settings menüsünden Image Size alannını 
istenilen  yüksek çözünürlük olarak seçilir ve son render alınır.

Alınan tek kare görselden oluşan Renderı kaydetmek için, Render View alanındaki File>Save 
IMAGE seçeneğini kullanarak kayıt işlemi alınabilir. 
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Render View’daki Fıle>Save Image seçeneğinin yanındaki seçenekler kutucuğuna basarak açı-
lan özellikler penceresinde > Color Managed Image seçeneğini seçelim ve Apply diyelim. Bu sa-
yede görselimiz render alanında gördüğümüz renk aralığında kaydedilecektir.

Açılan Save penceresinde bulunan format seçeneklerinden amaca uygun olan format Fıles Of 
Type alanından seçilip dosya ismini ise Fıle Name alanından oluşturulup kayıt yapılabilir.

IMAGE SEQUENCE (SEKANS) RENDER ALMAK
Animasyon çalışmalarını render almak için Image Sequence sistemi kullanılarak render alına-

bilir. Animasyon zaman çizgisinde bulunan her bir kare, istenilen resim formatına çevirilir ve bu-
lunduğu kareye ait bir numara verilir. Ardışık rakamlardan oluşan bu renderlar daha sonra Adobe 
After Effects, Premiere gibi bir video düzenleme programlarında gerekli ses, müzik ve efekt dos-
yaları ile birleştirilir ve video formatına dönüştürülür.

Her animasyon karesini resim formatında almanın avantajı, uzun süren Renderları yarıda bı-
rakıp daha sonra devam edebilme olanağı ve Render Pass adı verilen Render kanallarını da ayrı 
görsel dosyaları halinde çıktı alabilme esnekliğidir. Bu detaylı Render Pass konusuna kısaca deği-
necek olursak;

Bir 3D sahnede bulunan objenin, objeler karşısında oluşturduğu Specular, Subsurface Scatte-
rıng, Reflection, Normals, Shadow, Ambient Occlusion, Depth, Mask gibi görüntü özelliklerinin 
her birini ayrı bir resim dosyası olarak kaydedilmesidir. Bu sayede render dosyalarını montajlar-
ken her bir kanala ayrı müdahale edebilme şansı bulunur. Bu özellikle oluşturulan alfa kanallı 3D 
animasyonların gerçek dünyada çekilen videolar üzerine montajlanmasında ışık gölge ve gama 
ayarlarının videoya uyarlanmasında kolaylık sağlamaktadır. 
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Sequence Render almak için ilk önce animasyonu yayınlayacağımız platforma uygun pixel çöü-
nüzlüğünde image size seçmemiz gerekmektedir. 1920x1080 (FULL HD) image size TV Youtube 
gibi 16:9 video formatında sık kullanılan bir ölçü olduğu için tercih edilebilir. Sequence Render 
işlemi sahnenin yoğunluğu ve görüntü kalitesi ayarlarının artırılmasına bağlı olarak zaman alan 
bir işlem olduğu için 1280x720 (HD) de tercih edilebilir. Bu tamamen sizin animasyonu nerede 
sunulacağı ilgili bir durumdur.

Daha sonra Render Settıngs penceresinden Common>Metadata(Nama, Type, Value) kısmın-
dan > Frame / Animation EXT kısmından > name.#.ext seçeneği ile çoklu render isimlendirme 
seçeneğini seçelim. Bu seçenek ile render dosyaları otomatik olarak kaydedilirken önce dosya adı 
sonra frame numarası en son olarak da dosya formatı olacak şekilde isimlendirilecektir.

Render alınacak animasyonun kaç kareden oluşacağını ayarlamak için ise aynı bölümde altta 
bulunan Frame Range > Start Frame / End Frame alanından, başlangıç ve bitiş karelerini girerek 
yapalım.

Örneğin 5 saniyelik bir animasyon çalışması varsa; start frame:1 End Frame: 125 yapılabilir.

Image Format kısmından ise kaydetmek istediğimiz dosya formatı seçilebilir. Alfa kanallı çıktı 
almak için PNG veya TIFF, daha detaylı profesyonel Compositing çalışmalar için ise EXR formatı 
tercih edilebilir.

Üst bar menüde bulunan Modelıng seçeneğine tıklayıp Rendering seçeneğini seçelim. Bu sa-
yede üst menülerde Rendering ile ilgili ayarların yapıldığı menü seçeneği aktif olacaktır.
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Üst menüden > Render >  Sequence Render kısmından kutucuğa basarak Sequence Settings 
alanını açalım.

Current Camera alanından animasyonu hangi kamera açısından render almak istiyor isek onu 
seçelim. Örneğin sahnede aynı animasyon için 5 farklı kamera kullanmış olabilir. Bu kısımdan han-
gi kamera açısının çıktısını almak isteniyorsa onu seçelim.

Alternate Output Fıle Locatıon alanından ise dosyaları kaydetmek istenen alan seçilir.

Render Sequence And Close seçeneği ile bu pencere kapatılıp seçilen her kareyi render almaya 
başlanır.

Alınan Sequence Renderları birleştirmek için farklı bir video Edit ve Compositing programına 
ihtiyacımız bulunmaktadır. Ancak Autodesk Maya programını yüklerken standart olarak aynı anda 
“FCheck isimli program da sistemimize yüklenmiş bulunmaktadır. Sistemimizden bu programı aça-
rak Açılan arayüz alanından File > Open Animation seçeneğiyle aldığımız Sequence Render kare-
lerinin ilk karesini seçerek video şeklinde oynatılabilir. İlk oynatımda hafızaya kayıt işlemi yapacağı 
için yavaş oynatım yapacaktır. Daha sonra gerçek zamanlı oynatıma geçecektir.

Render Pass kanalları ve ses dosyaları ile birleştirmek için ise daha önce bahsedildiği gibi Ado-
be After Effects ya da Premiere gibi montaj programlarında, alınan render çıktıları Import Images 
as Sequence seçeneği ile çağırılarak istenilen video formatına ses ve efektler eklenerek Export 
edilebilir.
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